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Intended Audience
This guide serves a wide audience by providing descriptions and detailed information about all
Net-FM modules with the following exceptions: Administration, Move Management, and Space
Survey. Each of these exceptions is covered in detail in their respective user guides. Any
reference to “You” in this document should be construed as a reference to a Net-FM user.

How this Guide is Organized
The layout of this guide closely follows the sequence found in the Net-FM Navigation Tree. We
begin with an overview of Net-FM and its various modules; we then proceed to cover each
module in detail, replete with practical examples.
This guide is in PDF format and by extension there are a number of PDF controls available to
help navigate and quickly locate the desired information. At any time, use <Ctrl> + F to launch
the “Find” feature in your PDF program. The Find feature allows you to search the document
for specified criteria. Each occurrence will be highlighted and there will be controls that allow
you to navigate easily to the previous or next occurrence.
You may also select the Bookmark tab to view an outline of document content – simply click on
a topic to jump directly to the respective section.

Preface
If you are a new Net-FM user and are otherwise unfamiliar with the system, it is recommended
that you review the first several sections of this document in order to obtain perspective and
become familiar with the application. It is also recommended that new users review the Quick
Start Guide to quickly learn essential concepts and avoid getting bogged down in the details at
first.
For all other users, feel free to skip to the section of interest. Make use of the PDF Find feature
to quickly locate the desired information.
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The INSITE Net-FM System
The core of the INSITE Facilities Management technology is a relational database that stores
facility and asset information. With the release of Net-FM v 4.0, INSITE had added expanded
supported database software to include Microsoft SQL Server in addition to Oracle. The
database and Net-FM application run on servers using Windows® Server 2019, 2016, 2012 R2,
and 2012. Although the application also runs on Windows Server 2008 R2 and 2008, Microsoft
Extended support will end for these products on January 14, 2020 and should not be used for
any new installations.
The Net-FM application runs on any PC, laptop, tablet, or mobile device with a web browser.
The major browsers supported include: Microsoft Edge, Google Chrome, Firefox, and Safari. The
primary Net-FM modules include:
1. Drawings 1
2. Space Management
3. Space Survey Management
4. Asset Management
5. Asset Reconciler
6. Asset Depreciation
7. Indirect Cost Recovery
8. Grant/Project Tracking
9. Move Management
10. Navigator
11. Reports
12. Space Survey 2
Note: Depending upon your institution’s license agreement, some of the modules listed above
may not be available.
In addition to the primary modules listed above, Net-FM provides an Administration module
(accessible only to the designated/responsible individuals for the respective organization), the
SQL Utility, and the Help File Editor.
The Administration module allows the Net-FM Administrator to manage the following:
•
•

User Accounts - create, manage, and / or remove user access to Net-FM along with
tailored access to Net-FM modules
Profiles – a compilation of privileges and customizations that can be granted to users

Previously contained within the Administration Module, the Drawing Query / Conversion functionality is now
contained within its own module.
2
Net-FM users with the help of the Net-FM Administrator are now able to access their individual Space Surveys
from the “Space Survey” module in Net-FM. In order to avoid confusion with the administration aspect of Space
Survey, the previously named “Space Survey” module has been renamed “Space Survey Management”.
1
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•
•
•

Customization – significant abilities to customize Net-FM for your organization without
technical expertise or programming efforts
Validation – manage database integrity via lists of legal values for chosen fields
Settings – set Global preferences and manage choices for various actions in Net-FM

OFMS, Inc designed the INSITE database to track facilities and space-related elements such as
people, equipment, costs and activities. The INSITE database is structured to meet Facilities
Management needs and integrates several applications:
•
•

•
•
•

•
•
•

•
•
•
•
•

Space Management –the physical space inventory of all facilities on a room-by-room
basis
Space Survey – a comprehensive web-based tool that helps to systematically and
routinely track and verify space-related information, including, but not limited to,
Responsible Person, Principal Investigator, Use, Organization, Occupants, Functions,
Grants/Projects, Supported Rooms, and Space Contacts.
Asset Management – tracks fixed and moveable equipment
Asset Reconciler – reconcile the physical asset inventory with the asset records stored
in the database
Asset Depreciation – sophisticated and custom-made depreciation and use allowance
capabilities to respond to regulatory and compliance requirements as well as track asset
costs over time. There are multiple depreciation methods to choose from and trial runs
to compare results by different methodologies.
Indirect Cost Recovery – assign and manage program functions, costs, or charge-backs
to space
Grant/Project Tracking – track grants/projects being performed in spaces over time
Move Management – a web-based tool that allows users to enter, track, update, route,
distribute, and analyze information about institutional moves (including information
about persons/occupants, items associated with each occupant, and standalone items).
The tool has a logical process flow. A reconciliation feature allows the Move
Administrator to easily update occupancy information by deleting occupant data (if
desired) from old spaces and inserting/updating occupant data for new spaces.
Documents – store and view electronic files attached to space, assets, accounting,
grants/projects, Space General 1 through 5, and Space Features.
Reports – an OFMS-provided library of standard reports generated and viewed within
Net-FM
Floor Plan Query – view, query, display and print floor plans within Net-FM using
common PDF format
SQL Utility – This utility provides a way to quickly, easily run read-only SQL queries
against the database.
Help File Editor – This module provides a mechanism for Net-FM Administrators and
Page
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•

privileged users to edit/upload help documentation, and specify help file URLs for NetFM.
Administration – full customization of the Net-FM environment, user account access /
control
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NET-FM Modules Overview
Net-FM is organized into Modules that contain both a
collection of related tables and operations that may be
performed on that data. The Net-FM Navigation Tree (a.k.a.
Net-FM Navigator, shown right) contains each module as an
expandable/collapsible branch (or node). The Navigation
Tree is the primary tool for navigating within Net-FM (other
methods such as Quick Links and Saved Queries will be
discussed later).

SQL Utility

The SQL Utility is a read-only tool that makes it possible for you to issue SQL
queries against the INSITE database. Results may be exported/printed using the
buttons at the bottom-right of the grid. Additionally, you may copy and paste
your results into an Excel file or the spreadsheet program of choice.

Help File Editor

The Help File Editor is a new utility that makes it possible for Net-FM
Administrators and privileged users to edit the help files/links that display in
the Net-FM Help Menu. Users may replace the default help document,
upload new documents, and/or specify URLs for help files. In addition, it is possible to control the order
of the help documents.

Drawings

The Drawings Module (previously contained within the
Administration module) is used to query the database or file system
for drawings, identify drawings in need of reconciliation, and
reconcile drawings. This module also contains the Drawing Log File
which can help pin point issues with drawing conversion, upload, and more.
New with the release of Net-FM v 4.1 is the Markup Drawings Report. This report, generated in dataPage
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grid format, contains descriptions, review/archival information, and more for annotated floor plans that
have been uploaded to the database in .pdf format.

Space Management

The Space Management Module is used to inventory, track, query,
analyze, and report on information about physical facilities. The
inventory starts at a macro-geographic level (REGION) and then
progresses down in a hierarchy with ever increasing details until the
inventory captures data on a space-by-space basis.
At the space level, there are many fields of information available,
and you can choose which collection of these fields will be utilized in
the inventory. These fields are highly customizable/configurable and
allow your organization to effectively capture space-related
information. The Module provides complete freedom to devise, test and apply space utilization
standards via ratio analysis. Space Management also affords the ability to support spaceplanning scenarios and space allocation studies.
The groupings within the Space Management Module are LAND, FACILITY/FLOOR, SPACE,
ORGANIZATION, USE, SIGN, TRANSACTION, and COMMON.
In addition, there is a grouping of NAVIGATORs that provide visualizations of the data
organization in three hierarchical perspectives: Space, Organization, and Use.
This diagram is a schematic of the Space Management module that show each module, table,
supporting table, and the relationships between the Space Management elements.
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Asset Management

The INSITE Asset Management (AM) module inventories, tracks,
analyzes, and reports information about fixed and movable equipment.
The application allows assets to be classified and located in space.
The Asset Management Tables are Asset, Account, Asset Accounting,
Asset Classification (Category, Class and Nomenclature), Vendor,
Transaction, and Common Tables.

Asset Reconciler

The Asset Management Reconciler includes tables and tools
that assist with field audits to find equipment, and
compare/reconcile field findings with the Asset Management
Database. The module is a companion of Asset Management.
The Reconciler module integrates directly with custom
programmed portable scanners for the field audit. Inventory
cycles, batches of audited equipment, and analysis reports
complete the reconciliation components of this module.

Asset Depreciation

This comprehensive and sophisticated module performs depreciation
on equipment in the database, using alternative methods that comply
with government regulations. Trial runs can be accomplished first to
assist in “balancing the books” before actual depreciation is done.

Space Survey Management

This module allows the Net-FM Survey Administrator to create
and customize an online survey form that captures current
space data for the following categories: room information,
uses/subuses, responsible person, station count, PI, functions,
occupants, grants, space contacts, space features, and
supported rooms. Once the form has been configured to suit
the survey effort and the necessary components included, the
Survey Admin selects the intended recipients and distributes
the form/link via email as an automated process. The Space
Surveyors (a.k.a. Survey Recipients) use the provided links 3 to
access their respective surveys, update/save changes, and
ultimately submit their completed surveys to the Survey Admin and/or any Space Survey
Supervisors. The Survey Administrator reviews responses, resolves conflicts, and reconciles the
Beginning with v 4.1, Surveyors, Collaborators, and/or Supervisors who are also Net-FM users may access their
surveys directly from the “Space Survey” module in Net-FM (provided the Administrator has associated the Survey
with the user account).
3
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surveys (in effect updating the Net-FM database).
With v 4.1, the much-anticipated multiple Survey cycles functionality is now available.
Previously, it was only possible to conduct a single Survey effort at-a-time. It is now possible to
conduct multiple, simultaneous efforts that vary in size/scope. In addition, we have introduced
a Collaboration feature that enables Surveyors to coordinate with other members of the
Organization to perform updates and supply required information.

Indirect Cost Recovery (ICR)

The Indirect Cost Recovery Module is used to assign programs,
activities or functions to spaces in a manner that supports
regulations for reporting on how space is used for purposes of
recovering the indirect costs associated with research. ICR can be
used for tracking the recoverable costs incurred to perform research, the reimbursable
amounts from third parties in medical facilities, and the costs attributable to occupying
organizations in space for purposes of budgetary charge-backs.
The Indirect Cost Recovery tables include Functions (Major Function, Function and Function
Assignment) and Costs (Cost Type, Facility Costs, and Space Costs).

Grant / Project Tracking

Another important application in Net-FM is the tracking of Grants or
Projects in space. While not a replacement for comprehensive Grant
Administration programs, you can enter basic information about a
project including its fund source, amount and duration. In addition,
Grants can be assigned to spaces and attributed to Principal Investigators. The benefits include
being able to see how space is utilized to accomplish specific grants and when those spaces
may become available again when the Grant expires.

Move Management

Move Management is a web-based tool that allows users to enter,
track, update, route, distribute, and analyze information about
institutional moves (including information about persons/occupants,
items associated with each occupant, and standalone items). The tool
has a logical process flow. A reconciliation feature allows the Move
Administrator to easily update occupancy information by deleting
occupant data (if desired) from old spaces and inserting/updating
occupant data for new spaces.
Net-FM v 4.1 includes a number of new features pertaining to Move Management, including
the introduction of the Move Calendar, which aids in visualizing past, present, and future
moves.
Page
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Navigator

The Navigator has two sub folders: “Space” and “Documents”.
• Space: Three Navigators visually illustrate the Space, Organization, and Use information
in a hierarchical structure. This makes it easy to conceptualize how each of these
categories and respective data are arranged in the database.
• Documents: Several Navigators visually illustrate the
arrangement of Space, Asset, Accounting, Grant, Space
General 1 through 5, and Space Feature document
information. (The Documents module allows uploading
and storage of documents related to three data
components. While not a replacement for a
comprehensive Document Management System, you
can upload and attach any type of document from the
Document tab of the aforementioned modules.
Navigators allow you to quickly organize and view
documents that have been brought up to Net-FM.)
Space General 3 through 5 are newly added with v 4.1,
and must be enabled/configured before they display.

Reports

INSITE has a number of pre-built reports that are available within Net-FM.
There are two libraries of OFMS-supplied Standard Reports: one set for Space
Management and another set for Asset Management. From the Net-FM
navigator, it is a simple process to choose a report, set the scope, and produce
the results in a browser window. For example, the following is the All Space Summary
Standard Report, and the scope is the entire database.
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Space Survey
As mentioned in the section regarding Space Survey Management,
the Survey, Collaborator (if the user is a Collaborator on one or
more records), and/or Supervisor Link (if the user is a Supervisor) for
Space Survey can be made available from the Space Survey module
with the assistance of the Net-FM Administrator. With this feature,
Net-FM users can now directly access their Survey lists (or
Collaborator lists, if applicable) from within Net-FM. Similarly, those users who are Survey
Supervisors may access their Supervisor Links from within Net-FM. Beginning with v 4.1,
Supervisor Links are now segmented/lableled by Organization.
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Operating and Navigating Net-FM
In order for you to effectively use Net-FM, you must first become familiar with the
environment, how to navigate the various components, become adept at performing targeted
queries, learn how to efficiently maintain/update information, and work with output. Below
are summaries of the components of Net-FM that will be described fully in the remaining
sections of the User Guide.

Login Procedures

Access Net-FM by first navigating to the Login page 4. Your Net-FM Administrator will
provide the link to the Login page. The Login address takes the following form:
[http:// or https://] + [hostname] + [/netfm/login.aspx]
Specify your Net-FM username and password. Depending upon how your Net-FM
Administrator has configured the application, you may be able to retrieve your username
and/or password using the respective links on the Login page.

Net-FM Environment and Navigation

Upon logging in to the application, you are presented with the home screen. From the
home screen, a wealth of information is literally just a click or tap away. From the
Navigation Tree, to the Dashboard (which can include Space & Asset Statistics, Quick
Links, Saved Queries, and Custom URLs), to the Navigation Bar (where you may access
the Help files and various preferences amongst other things), the home screen is an
efficient and logical starting point.

Profiles and Preferences, Performance Tips

Each user has a profile which consists of basic information about the user as well as the
ability to change the password (if permissions are granted). A Preferences component
allows you to review a host of settings that affect your work in Net-FM and the ability to
alter the default preferences to suit your needs. There are several aspects of the
Preferences component that allow you to be a more effective Net-FM user.

Help and Support

Within Net-FM you can access and utilize online Help Files, version information, the
INSITE License Agreement and Error Logs, as well as links to the INSITE Support Website.

Basic Tabs in Net-FM

When accessing any component in Net-FM (i.e. “Space List”), 4 tabs are immediately

If your organization has configured Net-FM to work with Single Sign-on (SSO), your Net-FM Administrator will
provide more information on which link to use and access instructions.
4
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available to query data, see results and add new records.

Performing Queries

Focusing in on specific information you desire to work with in a large database requires
powerful methods to query data and see results. Net-FM has a host of capabilities to find
and show exactly the set of information you desire.

Working with Results

The result of a query is the results list of selected records displayed in the Net-FM Grid.
There is a great deal of flexibility and power in this Grid display. Individual records can be
edited. If the records have associated floor plans, there are links for viewing floor plans
and performing Floor Plan Queries. Drill up and Drill down capabilities allow you to move
up to the Parent record or down to the child records.
The Grid also has many features that allow you to sort records, select / highlight records
for subsequent actions, perform mass updates, and export records to local Excel files.
Finally, column order and display in the Grid can be customized to suit your needs. NetFM will retain these settings for subsequent sessions.

Floor Plan Queries

In addition to querying data in Net-FM, you can also view and query floor plans. This is a
powerful feature in Net-FM as it gives widespread access to graphical representations of
data (floor plans) without the use of any additional programs. Results are presented
dynamically in PDF format, making it available to all in a commonly-used format for
viewing, printing, and distributing to others. New with v 4.1, are optional HTML floor
plans that allow for easy, seamless viewing cross-browser, cross-device.

Common Tables and Lookups

Net-FM provides numerous database tables that contain information commonly used for
multiple purposes. For example, a Person Table is available to store detailed information
about each person in your organization, and that information can be linked and used in a
many other tables such as Space Contacts, Grants, Space Survey, etc.

There is a great deal of integrity built into Net-FM, including the ability to validate
information in selected fields based on a list of valid entries. Those lists, called Lookups,
are stored and maintained, field-by-field, in Lookup tables.

Maintaining Information

The primary activity in Net-FM is the maintenance of information. This includes inserting
new records, updated existing ones, and removing unwanted data. Net-FM has proven,
tested methods for maintaining information that enforce integrity, validate against
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acceptable alternatives, and record when information was entered / updated and by
which account. In addition, a Transaction History feature allows users to track, in great
detail, all changes made to information in Net-FM.

Reports, Printing

There are a host of pre-defined Standard Reports available from within Net-FM. Select a
report, determine the scope of data, and see the results displayed in a separate browser
window. In addition, Net-FM reporting is augmented with a library of Standard Reports
using Crystal Reports which allows more flexibility and customization.

Data Extraction / Export

A powerful feature is the ability to extract (export) information from the central Net-FM
database to Excel files for local use. You can fully customize the scope, order, and
content of the data that will be exported.

Loading Data into Net-FM

On the flip side, information whose source is data in Excel files can be loaded into NetFM database tables. Again, you fully control what is inputted to where. The load activity
includes full validation of each record, and an error log to track specific errors if records
are rejected. The Load data capability allows the input of new records and the updating
of existing records.

Net-FM Views

In addition to database tables, a number of database views have been created with
facilities data. These views go beyond the basic tables to link related information
together that would not otherwise be available.
One use of these extended views is in reporting. Often in our reports, we need to
intelligently link database tables together to provide a richer source of information for
examination.

Administration Module

Net-FM Administration activities are centralized in the Net-FM Administration module.
The Administration module affords the Administrator the opportunity customize the
system, create security groups (security profiles), and perform a number of tasks without
the need of any programming knowledge or DML (database manipulation language).
Capabilities include:
•
•

Create/manage Security Profiles (which determine the scope of data available to
users and the actions they can take with that data).
Create/ edit User Templates (which help simplify and streamline the user
creation process).
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•

•
•

•
•
•

Create/ manage User Accounts that tailor the Net-FM experience for each user
or group of users. This includes not only what data users can view, but also
which modules and features are visible/available.
Set Global Preferences applied to each User. Individual users can then modify
the preference for themselves
View and edit characteristics about every field in every database table, including
Field Name, whether it is required, and default values when a new record is
added.
Utilize a set of basic Utilities that help you to better manage the Net-FM
database
Leverage a host of Settings that are applied to all activities with Net-FM in the
enterprise.
Globally assign color/hatching schemas for highlighting each of the following in
floor plans:
o Use Assignment
o Organization Assignment
o Function Assignment
o Space Feature

The Net-FM Administration Module is a comprehensive and integral tool that is separately
documented for a selected audience comprised of Net-FM Administrators.
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Login Procedures
From a web browser, type in the appropriate URL for the Net-FM web server and press the
Enter key. This will open the Net-FM Login screen.

Username:

Your Username is assigned by your INSITE database administrator.
Usernames are case insensitive (i.e. UPPER, lower, MixedCase – are
equivalent).

Password:

Please consult with your Net-FM Administrator for any special rules
regarding passwords – minimum & maximum characters, special
characters, etc. Passwords are case sensitive (i.e. PASSWORD ≠ password
≠ PassWord).

Profile:

Specify the desired database by selecting the appropriate value from the
dropdown (i.e. netfm, test, etc.). Confirm with your INSITE Administrator
which profile should be used for production, and which one should be
used for test (if applicable).
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Remember
me:

Checkbox to have your web browser remember your Username, Password,
and database Profile for future logins.
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Recover Username functionality: If enabled by your Net-FM Administrator, the “Forgot
Username?” link will be available from the Login screen. In the event you do not remember
your username, use the link to navigate to the “Recover Username” screen. In the Email field,
specify your email address and click or tap the Recover Username button. If the email specified
is valid and associated with your user account, an email will auto-generate and you will receive
your username information.

Reset Password functionality: If enabled by your Net-FM Administrator, the “Forgot
Password?” link will be available from the Login screen. In the event you do not remember
your password, use the link to navigate to the “Reset Password” screen. In the Username field,
specify your username and activate the Security Question field by clicking or tapping in the
blank entry field. If you entered a valid username, this action will cause the appropriate
security question to appear above the blank entry field. Type your response and click or tap the
Reset Password button. A temporary password will be sent via email to the email address
associated with your user account.
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Logging out of the application is simple – there are two options:
1. Click on the “Sign Out” icon:
2. Locate the dropdown on the top right of your screen which displays your username and
database connection information (referenced as the Database Connection dropdown
hereafter). Click on the dropdown and select Sign Out.
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Net-FM Navigation
Although the appearance may vary based upon user account configuration, the basic
appearance of Net-FM upon login consists of three key areas: the Navigation Bar, the
Navigation Tree, and the Dashboard. The screenshot below reflects what a user would see with
the default dashboard selected for his/her user account.

The Navigation Bar
The Net-FM Navigation Bar is designed to provide you quick/efficient access to a number of
features. We will briefly look at each item and review a summary of the respective features.
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In one click, this link returns you to the Net-FM Start Page (the page seen when you first log
into Net-FM). Regardless of where you are in the application, this link helps you quickly return
to the Start Page.

The Quick Links dropdown is designed to provide easy access to your personalized Quick Links
from anywhere within the application. What is a Quick Link? Simply put, it is a bookmark of
sorts that takes you to a specific location/node in Net-FM with one click.

Page
34

The Queries dropdown affords you the opportunity to access both your Saved Queries and
Public Queries from anywhere within Net-FM. When you run a search in Net-FM by specifying
various criteria from the Query or Advanced Query screens, you have the ability to save the
search for future use. The Saved Query allows you to retrieve the results of your previously
specified search in one click.

The Custom Links/URLs dropdown allows you to quickly access helpful/important links
specified by the Net-FM Administrator from anywhere within Net-FM. URL (or Uniform
Resource Locator) is simply the technical term used to refer to a web link.

The Help dropdown contains the following five links:
• Help Files – this link opens the online Net-FM help file that corresponds with the version
of Net-FM you are using. The files open in a separate tab. Beginning with v 4.1, you may
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•
•
•
•

notice additional help files or different naming conventions, depending upon how your
Net-FM Administrator has configured the system.
About Net-FM – this opens a modal dialog that details the Net-FM version, build
number/date, and modules licensed to your institution.
Agreement – links to the standard INSITE Software License Agreement.
INSITE Website – a direct link to the INSITE website (from which you may register for
and access the Support page).
Error Log – opens to a grid displaying user errors encountered with their respective
descriptions.

The Connection dropdown is labeled with the following convention: [your username]
@ [database to which you are connected] The dropdown may contain the following links:
• My Profile – (if available) opens to a page where you can manage basic information
regarding your Net-FM account, including password, email, full name, address, and
telephone number.
• Change Password – (if available) allows you to change your password by specifying your
existing password, typing a new one, and confirming a Security Question & Answer.
• Security Question – (if available) allows you to change your Security Question & Answer
by confirming your password.
• My Preferences – you will find settings to manage general preferences (i.e. records per
page in your results tab, number of total queries in Advanced Query, etc.), control
dropdowns, manage Space & Asset List tabs, as well as hide various tabs in the Space
List Edit page. Additionally, there are tabs taking you directly to “My Drawing
Preferences” and “My Quicklinks”.
• My Drawing Prefs – (a.k.a My Drawing Preferences) contains the settings where you can
control the highlight colors, font, legend, and display of floor plans accessed from NetFM.
• My Quick Links – this is where you control which Quick Links appear on your dashboard
and the order of appearance.
• My Queries – using the grid on this page you may edit, execute, or delete Saved Queries.
The edit icon allows you to see the underlying SQL for each query. Note: You will only be
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•

able to delete Queries of which you are the owner.
Sign Out – use this link to end your session and sign out of Net-FM.

The Navigation Tree

The Net-FM Navigation Tree is an expandable/collapsible user interface that contains the NetFM modules and respective components to which you have access. The screenshots below
illustrate how the Navigation Tree works.

See below for an illustration of how to collapse items in the Tree:
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Note: Clicking on the various links within the Tree (i.e. Space List, Org Assignment, etc.) takes
you to the respective section/page of Net-FM. We will cover each in detail later on in this
document.
Show/Hide Button:

On the Net-FM
Navigation Bar, to the left of “INSITE Net-FM v4.1.0,” there is an icon
with three horizontal lines. Click the button once to hide the Net-FM Navigation Tree and
maximize screen real estate. Click the button again to redisplay the Navigation Tree.

The Dashboard

The Net-FM Dashboard may vary depending upon how the Net-FM Administrator created your
user account. As you navigate within Net-FM, the space reserved for the Dashboard is replaced
with the Query/Add/Edit/Data Grid screens. In order to get back to the Dashboard, simply click
the Net-FM Start Page Link (which was mentioned in the Navigation Bar section). The
screenshot below is representative of the default Dashboard:
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Alternative Dashboard Configurations:
If your Dashboard does not resemble the one pictured above, you do not have the default
configuration. Compare to the layouts featured below to determine which Dashboard you have.
Alternative 1: None

Alternative 2: Space & Asset Statistics
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Alternative 3: Space Statistics

Alternative 4: Space Viewer
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My Profile, Change Password, Security Question, My
Preferences, My Drawing Preferences, My Quicklinks, My
Queries
When you click on the Connection Dropdown on the right-most side of the Navigation Bar, you
may notice some or all of the following menu items: My Profile, Change Password, Security
Question, My Preferences, My Drawing Prefs, My Quicklinks, and My Queries. Initially, the
Net-FM Administrator sets the default values that are propagated to your user account when it
is initially created. For each item that displays in the Connection Dropdown, you have the ability
to further customize the settings.
We will look at each of these in detail.

My Profile

Your Net-FM Administrator may have granted you permission
to edit your Profile, in which case you will see the My Profile
menu item on the Connection Dropdown. Clicking on My
Profile will open the Edit tab, where you can specify/edit the
following information:
• Email Address
• Full Name
• Title
• Department
• Address
• Telephone Number
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Note: Only the Net-FM Administrator can change your username. The required fields Full Name
and Email Address are highlighted in RED.

Change Password

Previously located under “My Profile”, the Change
Password option is now directly available from the
Connection dropdown.
Simply specify your username, current password, new
password, and confirm your new password:

Security Question

An added layer of security is now available with the latest
offering of Net-FM – if enabled by your Net-FM
Administrator, you will be prompted to set a Security
Question & Answer upon initial log in. The Security
Question & Answer makes the previously described
password recovery possible. You may update your Security
Question & Answer at any time by selecting the Security
Question option from the Connection dropdown. As a
security measure, you must provide your existing password
in order for the change to take effect.
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My Preferences

As mentioned previously, there are default preferences that
are set when your user account is first created. If you have
been granted access by your Net-FM Administrator, you
may further customize these settings as you see fit.
The illustration below shows the various settings that are
available on the My Preferences tab. The My Preferences
tab can be further broken down into the following tabs:
General Preferences, Populate Dropdowns, Space & Asset
List Tabs, and Hide Tabs – Space List Edit.
General Preferences
Most of the preferences listed in this tab serve as the default values but can easily be
overridden. Refer to the descriptions below:
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•

•
•

•
•
•
•

Records per Page in Results Tab – this reflects the number of records which will display
per page in the Results Grid / Data Grid. If you find that this value is set too low, you can
change the default value here or override the value by changing the “Page size” on the
Data Grid.
Scanner Model – corresponds with the Pocket-FM Equipment Inventory Solutions
model (used in Asset tracking). “Symbol MC50/MC55” represents the latest model used
with Asset tracking.
Screen behavior after Update – this controls the page content displayed after an
update. “Display Complete Page” will show the edit screen with updated values directly
after an update. “Show Hyperlinks Only” will NOT display the Edit screen; instead the
following hyperlinks will be available following the update: Custom Settings, History,
First/Previous/Next/Last buttons, Updated Record link.
Advanced Query – Total Queries – this controls the total number of queries that may be
specified under the Advanced Query tab. You may specify a minimum of 1 up to and
including a maximum of 10. Each Query is separated by a logical OR.
Advanced Query – Columns Per Query – this represents the total number of fields that
may be specified per query. Each field is joined by a logical AND.
Display History Link (per record) – determines if the History Link is displayed on the
individual record Edit/Results page.
Display Org and Use Percentages in Space List Results tab – controls whether or not
Org and Use Percentages are displayed by default in the Space List Results tab.

Populate Dropdowns
The Populate Dropdowns tab was designed as a tool to control page load performance. By
controlling which fields do NOT populate automatically, you are able to increase page load
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efficiency. The checkboxes below are divided into 2 categories: those pertaining to both the
Space & Asset modules and those pertaining to the Asset module only.
Here is a brief example of how this may be of benefit. Let’s say that you often perform queries
on the Space list, but you do not always need to include Organization as part of the Query
criteria. If your Institution has hundreds/thousands of Organizations, by not populating the
Organization dropdown automatically you can save significant time on page loads and increase
efficiency. If you do need to include Organization as part of your search criteria, simply check
the box next to the Organization dropdown to populate values on-demand.

Space & Asset List Tabs
The preferences under the Space & Asset List Tabs govern the appearance/functionality of the
Space List and the Asset List. We will look at each of these below.

•

Space List Results – this setting controls the display of Space List Records and any
dependencies (i.e. Occupants, Functions, etc.). There are two options:
o Space Record – if this is selected, in order to view any dependencies associated
with the Space Record, it is necessary to click on the subsequent tabs following
the Edit tab.
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o Space Record and Dependents – with this selected you will notice a new column
in your Space List results / Data Grid denoted by the
icon. Clicking on this icon
for a space record will open a new window with a list of dependencies and their
respective values.

•

Asset List – Asset Accounting – although there are two possible values for this
preference, only the “Combo Form” should be selected. “Frame for Accounting” refers
to an older implementation of Net-FM when framesets were widely used throughout
the application. If the Net-FM Administrator has configured the Asset/Accounting
information to display in Combo Form, you will see Asset information on the top portion
of the Edit screen and Accounting information on the bottom portion. We will look at
this in more detail when we discuss Asset Management.

Hide Tabs – Space List Edit
We have already discussed briefly that you may access dependent information related to each
Space Record from the tabs that follow the Edit tab. The preference below allows you to hide
some of these tabs if you so choose. There is no harm in displaying all of the tabs if you desire –
the decision is up to you.
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My Drawing Prefs

My Drawing Preferences (or My Drawing Prefs for short) are
a collection of preferences that control the appearance of
the floor plans you access from Net-FM. The settings are
grouped into the following categories: Color Selection for
Room Highlight, Space Label Fields in Drawing, Space Label
Font, Legend Font, and Upload Date Display in Drawing.
We will take a look at each in detail below.
Color Selection for Room Highlight
As you will see when we discuss Space and Asset
Management, Net-FM affords you the opportunity to query
and display Floor Plans and highlight areas on the plans according to your criteria. The
preference Color Selection for Room Highlight allows you to specify up to 32 different colors
for the purpose of Floor Plan highlights. For example, if you are highlighting Occupants in each
space, and there are 4 Occupants in a given space, the first 4 colors specified in your
preferences will be used for the respective highlights.

Select colors by clicking the color palette icon
you may select the desired color.

. This will open the Color Selection Palette, from which

Color-coding by Use, Organization, Function, and Feature Type: When utilizing Floor Plan
Query (Q) in the Floor List, Uses, Organizations, Functions, and Feature Types (if specified by
the Net-FM Admin) will be highlighted according to a consistent color scheme. For example, if
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the Net-FM Admin sets the color for Biology to Red, when querying by Organization, the spaces
belonging to Biology will be highlighted in Red.
Space Label Fields in Drawing
You are able to control which Space Label fields are displayed by default when you first open a
drawing / Floor Plan from Net-FM. Simply check the desired fields and click the Update Record
button.

Note: Unless your Institution uses the custom “Subuse” implementation, you will not see this
field in your Floor Plans, nor will you be able to select it from the menu above.
Space Label Font
Using the preferences under Space Label Font, you are able to control the Font Color, Font
Style, and Font Size using the respective fields / dropdowns.

Legend Font
Similar to the preferences for Space Labels, you are also able to control the appearance and
position of the Floor Plan Legend.
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The diagram below serves as a visual aid and provides approximate X and Y Origin values to
help you place the Legend in the desired location. The small red box
Legend.

represents the

Dynamic Legend Font
Aside from setting defaults, as mentioned above, you now have the ability to “dynamically”
change the Legend Font Size when displaying a floor plan. Simply specified the desired font
size and click the Redraw Floor Plan button.
Drawing Format
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As mentioned previously, v 4.1 includes a new option for floor plan format: HTML. If your NetFM Administrator has enabled the HTML format, you may choose to set your default Drawing
Format as “PDF” or “HTML”.
Display Multiple Uses and Orgs
Maximum # Rows in Legend

Upload Date Display in Drawing
Additionally, there is an option to display on the Floor Plan the date on which the drawing was
uploaded to the database. There are controls to specify the location as well as orientation of
this information.

Color Hatching
New with the release of 4.1.0 are Global Color Hatching settings which may be controlled
through the Administration module | Global Settings | Color Hatching. A checkbox allows the
Net-FM Administrator to make global color hatching available across the organization. When
enabled, queries by Use, Organization, Function, and/or Feature Type will use the global
universal colors set by the Net-FM Administrator.
The color picker provides the option to select from a color palette or specify a hexadecimal
value for each color. In addition, a hatch pattern may be set as well. Please refer to the
following screenshot:
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My Quicklinks

The My Quicklinks entry on the Connection Dropdown
menu takes you directly to the screen where you edit your
Quick Links (a.k.a Quicklinks) and determine their sequence.
As mentioned briefly in the discussion about the Net-FM
Dashboard, Quick Links are links / hyperlinks that take you
to a specific area/page/module within Net-FM in one click.
Select the fields you wish to include in your Quick Links by
marking the checkbox next to each. Utilizing the Quicklinks
Sequence menu and the Move Up/Move Down buttons, you
can specify the desired order of appearance.

Page
51

Refer to the image below for a view of the Quick Links tab:
Quick Links fall into the following categories:
• Space Management
• Asset Management
• Space/Asset Common
• Indirect Cost Recovery
• Grant Tracking
• Navigators
• Space Reports
• Asset Reports

Note: Any changes you make to My Quicklinks will be reflected in the Quick Links dropdown as
well as the Quick Links displayed in your Dashboard (if you have the default Dashboard). In
order for changes to be saved, you must click the Update Record button.

My Queries

Although we will discuss the concept of Saved Queries in
detail in a separate section, it is important to describe the
My Queries page (link located on the Connection
Dropdown). The My Queries page is where you manage
your Saved Queries and view details for Public Queries
created by other users.
Refer to the illustration below for the My Queries page:
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At the Data Grid level, there are several useful operations that you may perform:

•

Delete – you are able to delete your Queries (Queries where you are listed as the
“Query Owner”) by selecting the respective records and clicking the Delete Selected
button.

•

Edit/View Details – by clicking the Edit
icon, you are able to view the details of the
Query, view the underlying SQL, and edit the Query Name, Description, Scope, and Sort
Order.
Execute – run a Saved Query by clicking the Execute
icon next to the respective
record on the My Queries page.
Sort/Multi-level Sort – perform a single sort on any column by clicking the column
heading. Perform a multi-level sort by using the Sort By controls at the bottom of the
Data Grid.

•
•
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Basic Tabs in Net-FM
The majority of Net-FM modules shares the same format and has the same basic tab structure.
The basic tabs are reflected in the illustration below:

In nearly every case, the following Basic Tabs are at the top of the screen and provide access to
appropriate actions.

Query: used for performing simple queries – simple lookups on data stored in the database.
Advanced Query: used to perform simple or complex queries. One or more query conditions
(logical OR) can be used and there are more robust operators available for criteria.
Results: used to display results, also referred to as a Data Grid. From the Results tab, one or
more data rows or records may be selected for display, editing/updating, global updates, export
and printing.
Floor Plans: links to floor plans resulting from query.
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Add: used to add a new data record to the database.
Load Data: used to load data from source Excel files into the database table.
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Performing Queries
Use the Query Tab to perform a simple query. Queries provide an opportunity to target your
search and limit the result set according to the criteria you specify. If you specify a value in one
field, then only those records that match the value in that field will be displayed on the Results
tab. The Query fields act as a logical “AND” statement. Thus, if you specify values for two fields,
then only the records that match the values in both fields will be displayed on the Results
tab. You can use as many fields as you want for the Simple Query. The image below reflects the
Query tab on the Space List.

Query Basics

Simple queries are performed on the Query tab. To perform a query:
1. Start on the Query Screen
If you are rerunning a query or navigating back to the Query Screen from another tab,
be sure to click the Clear All button in order to clear out any cached information from
the previous query.
2. Enter Criteria
Using the available dropdowns, text fields, text areas, and/or date selectors/fields,
specify your desired criteria.
Note: To retrieve ALL records, you may click the Get Results button. This operation
should be avoided (unless necessary) on modules such as the Space List or Asset List
where the record set can be especially large. Running queries for record sets of tens of
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thousands of records places added strain on the database, and multiple users running
these queries simultaneously can adversely impact database performance. You can
always use the Get Count button to get an idea of how many records will appear in your
result set.
3. Execute Query
Run the query by clicking the Get Results button. The results will display in the Data
Grid.

Query Considerations

There are a number of considerations to make with regard to Queries. Outside of obtaining
your desired results, you may also want to consider certain efficiencies and practices that can
make life easier.
Get Record Count
Prior to actually executing the Query, you may wish to check how many records will be found.
Click on the Get Count button and the number of records in the Result set will be shown on
the upper right of the Query Screen.
Since the Record Count capability is very quick, regardless of the number of records that will be
in the Result Set, it is a useful way to check in advance.

Clearing Query Criteria
To clear out all criteria you entered in the Query Screen prior to producing the results, click the
Clear All button.
Retrieve All Data
To retrieve ALL records, you may click the Get Results button. The amount of information
displayed by default in the Results is controlled by the Records Per Page in Results tab setting
under My Preferences | General Preferences tab.
setting. The available settings are 25, 50, 75, 100, 200, 500, 1000, and 2000 records. For very
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large tables, you are advised to use care when clicking the hyperlink “Display All Records” as
this could slow down the query / retrieval process. On the data grid, itself, you may notice a
new Page size option of “100000”. Again, exercise similar caution using this as you would the
“Display All Records” option.
A Word on Query Cache
You may notice that after you run a Query, view your results, and navigate back to the Query
tab, the fields are still populated with the criteria you specified for your recent Query. This is no
accident – it is by design. You will find that this design feature can save you time as you
formulate new Queries. For example, let’s give a case where we need to run a Space List Query
for a Facility, but we only want to return one floor at a time. Specify the Facility and Floor, and
then run the Simple Query. After viewing your results, return to the Query tab and simply
change the Floor value and run the next Query. If you want to ensure that your new Query
does NOT retain any criteria from the previous one, utilize the Clear All button before
specifying Query criteria.

Simple Queries

Simple Queries are performed by specifying values for one or more fields on the Query tab.
Single Criterion Query
Use these steps to perform a Simple Query based on a single criterion:
1. Select the desired Net-FM module or feature.
2. On the Query Screen, enter a value in the data field of choice or use the appropriate
dropdown to specify the value.
3. Click the Get Results button. A list of all records matching the criterion you specified
display in the Result Data Grid.
4. At the bottom of the Data Grid you will find the Pagination toolbar. The current page,
total number of pages, current set of records, and total number of records will display
(provided there is more than one page in the result set).
The following example shows a Query for which a single field has been specified. The Get
Count button reveals that there are 105 space records found for Facility “OFMS – OFMS
CORPORATE HQ”.
The Results:
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Multiple Criteria in Simple Queries

You can use more than one field for a Simple Query to further limit the result set. When two or
more values in separate fields are entered, they are considered joined by a logical “AND”. In
other words, both conditions must be met for a record to be retrieved from the database into
the results.
In the query below, two conditions are entered: Facility = “OFMS CORPORATE HQ - OFMS” AND
Organization = “BIOLGY - BIOLOGY”. 16 records were found.
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The Results:

Advanced Queries

The Advanced Query Tab is used for performing simple or complex queries, and bears little
resemblance to the Query tab. The diagram below shows the layout of the Advanced Query
screen.
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Refer to the following points for a description of the fields above:
• Total Queries – you may specify a value from 1 to 10 for this field. The number selected
represents the maximum number of Queries for which you may specify criteria.
• Columns Per Query – This represents the total number of fields (joined by a logical
AND) that may be specified per Query.
• OR – this is the logical operator that is used to join all of the Queries. In other words,
your results will include all records for which Query 1 OR Query 2 OR … is TRUE.
Using Expressions and Query Groups
You can specify more than one criterion for a query to further limit the result set. When several
criteria are constructed as expressions, the Results contain records that meet at least one of
the expressions. These expressions are either assembled in a Query Group (connected by
“AND”) or in several Query Groups (each group connected to other groups by “OR”).
An expression consists of:
• A column in the database table
• An operator
• A value or set of values
Together, these elements form an expression to determine results. Some examples of
expressions:
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Column

Operator

Value

A
B

Floor
Area

Equal To
Greater Than

3
120

C

Use

Equal To

Office | Office Service | Conf Rm

D
E

Organization
Category

Contains
Starts With

OFF
TEACH

(multiple values can be selected)

Here are the actual expressions constructed in Net-FM’s Advanced Query Screen:
A. Facility Equal To “OFMS – OFMS CORPORATE HQ” AND Floor Equal To “1”

B. Area Greater Than “120”
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C. Use Equal To <multiple choices> (In this case “CLASS - CLASSROOM” and “OFFICE –
OFFICE”)
Note: Use <Shift> + Click to highlight adjacent records. Use <Ctrl> + Click to highlight
non-adjacent records.

D. Organization Contains “CHEM”

E. Category Starts With “TEACH”

Within each Query Group, a logical AND connects the expressions. Between the different Query
Groups, (i.e., Query 1, Query 2, etc.), a logical OR connects the results of each group. As an
example:
• Two expressions are constructed in Query Group1. The result will be records that meet
both expressions at once.
• Two expressions are constructed in Query Group1. Another single expression is created
in Query Group 2 – the result will contain records that meet both criteria in Query
Group1 OR meet the criteria in Query Group2.
You can create up to 10 Query Groups and have up to 10 expressions (column headings) within
each Group. This is configurable on the Advanced Query tab. Once set, this will remain in
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effect for the remainder of your session or until reset. The number of Expressions and Query
Groups is also configurable in My Net-FM Preferences where the setting will be retained for all
your subsequent Net-FM sessions.
Following is the Advanced Query Screen set up with 2 Query Groups (connected with OR), each
containing 3 expressions (each connected with AND).

Performing an Advanced Query
From the Advanced Query Screen, construct expressions in combinations that will produce the
results you wish. Remember that Expressions within the same Query Group are connected with
AND while Query Groups are connected with OR.
1. Select a Column: From the drop-down list first appearing in an
expression, pick a column or database field that you want to
be searched in the query.
2. Select an Operator: From the drop-down list second
appearing in an expression, pick an operator that will connect
the column to values.
Operators
Operators fall into two categories: comparisons, and text
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Comparison: Equal To, Not Equal To, Greater Than, Greater or Equal To, Less Than, Less
or Equal To are comparison operators. They can be applied to numeric fields (Area
Greater Than 100), Date fields (Construction Date Less Than 01/01/1947), and text fields
(Utilization Not Equal To “Low”). Comparison operators can also determine if a field is
empty (Is Null) or filled (Is Not Null)
Text: Equal To, Not Equal To, Is Null, Is Not Null, Contains, Not Contains, Starts With, Not
Starts With are text operators. They are used with Text and Code fields (which are text).
3. Select one or more values: Based on the column you pick, choose one or more values.
To select multiple values from the list, hold down the <Ctrl> key while clicking on each
value to be included.
A free text box is displayed when the chosen Column in the expression is strictly a text
field with no lookup list of values. You type in the value manually. You can make the values
and resulting search case sensitive by checking the box at the top of the screen.
4. Click Get Count or Get Detailed Results to initiate the query and return the results.
See Section 7 for information about the Data Grid and display of the Query result.
Advanced Query Examples
Refer to the following series of screenshots and descriptions for examples of Advanced Queries:
Example 1: Single Expression in one Query Group
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Results:

Example 2: Multiple expressions in one Query Group (AND)
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Results:

Example 3: Multiple expressions in two Query Groups (OR)
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Results:

Performing Calculations with Queries

Thus far we have seen how Advanced Query incorporates the use of the logical AND and OR
operators. The following section takes things a step further and highlights how you can perform
calculations using certain fields, yielding results based upon these calculations. The examples
that follow will provide you with the foundation needed to make use of this feature with your
data sets.
Building an Expression
The Advanced Query tab also provides an "Expression" option as the last item in the Select
Column drop-down box. Only numeric data fields are available and may be used. The result of
that mathematical operation upon those data fields is compared to the value of the expression
you define which determines the query result.
Here is how an expression works. Let's say that we want to find all spaces (Space List) where
the "Station Count" exceeds the "Occupant Count".
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In essence, this criterion reads as follows: “Find all the records where the Station Count –
(minus) the Occupant Count is greater than 0 (zero)
Results:

The Search Criteria on the Result screen confirms the Expression, and the records retrieved are
those only where the Station Count is greater than the Occupant Count.
Follow these steps to devise this type of an expression:
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1. In the “Select a Column drop-down box, choose Expression
2. Choose an operator and a value you wish to be the result of the expression. In this case,
the result will be Greater Than zero.

3. Now you select the two columns of data on which you would like to perform an arithmetic
operation. In this example, you would select Station Count - (minus) Occupant Count

You have created a query that will display results if the Station Count minus the
Occupant Count is greater than zero.

Saved Queries

Often you will create complex queries that take time and effort to get right. Re-doing that
query manually each time you wish to retrieve desired records can be an avoidable burden.
Instead, save the query by name, provide a description, and execute with one click or tap.
Creating a Saved Query
The action of saving a query is initiated from the Results tab. After specifying the query and
seeing the correct records retrieved in the Results Data Grid, simply save the Query for re-use.
Suppose we wish to be able to repeat the Query above: spaces where the Station Count is
greater than the Occupant Count. When we save the query, it will be called “Under-utilized
spaces.”
1) Enter the criteria and perform the query first. Confirm on the Results Data Grid that the
query has returned the desired record set.
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2) Click the Save Query button on the lower right corner of the Results screen.
3) The Save Query Dialog box opens:
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4) Enter a name and description for the Query
5) Determine if you wish to have this Saved Query be available to all Net-FM Users.
Note: Saved Queries are Private by default. Private Queries are only available to you in
your own User Account. If you check the “Public Query” checkbox, you create a Public
Query which is available to all Net-FM users. Typically this is done by the Net-FM
Administrator or Database Manager.
6) Click the Save This Query button to finish.
Note: The application performs a check to ensure data integrity and prevent multiple users
from entering queries with the same name. Any attempt to save a query with a name already
in use will result in the following error message:

Running Saved Queries
Once a Query is saved, it becomes available on the Query or Advanced Query tabs, the default
Dashboard, and the Query dropdown. There are 3 ways to run Saved Queries:
•

Query/Advanced Query tab – In the following example, we will navigate to the Query
tab for the Space List and select our Query from there.

Once you have selected the Query from the dropdown, click the Get Detailed Results
button to execute the Query.
•

Queries dropdown – simply select the name of the Query you wish to run from the
dropdown and it will execute immediately.
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•

Customize Queries screen – the Customize screen for Queries may be reached from either
the Queries dropdown or My Queries on the Connection dropdown (see below).

OR
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Once you are on the Customize Queries screen, simply click on the Execute
the Query you wish to run – the Query will run immediately.

icon next to

Editing/Viewing Saved Queries

From the Customize Queries screen shown above, you also have the ability to edit individual
queries, both Private and Public, of which you are the owner. By default, the Data Grid on the
Customize / My Queries screen displays all queries you have created as well as any public
queries. You may use the Select box next to each entry in the Grid and click the Delete Selected
button if you wish to delete any of the Queries you have created. You may Edit
and/or View Details of each Query by clicking the Edit
icon.
Public Queries belonging to other users – when you click on the Edit icon next to these records,
you will be able to perform the following operations:
• View (but not update) the following fields: Query Name, Query Description, Query
Category, Query Scope, Query Owner, Query Type, Creation Date, Update Date, Sort
Order, underlying SQL.
• Run the Query by clicking the Execute Query button.
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•

Use the First/Previous/Next/Last buttons to navigate through the Queries one by one.

Public/Private Queries belonging to you – when you click the Edit icon next to these records,
you will be able to perform the following operations:
• View (but not update) the following fields: Query Category, Query Owner, Query Type,
Creation Date, Update Date, underlying SQL.
• Edit/View the following fields: Query Name, Query Description, Query Scope, Sort
Order.
• Run the Query by clicking the Execute Query button.
• Use the First/Previous/Next/Last buttons to navigate through the Queries one by one.
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A word on SQL – by using your cursor to select the text within the box labeled “Search criteria
followed by exact SQL query” (or using copy operations on a mobile device) you are able to
copy the SQL statement and paste it to a SQL tool such as SQL Developer (if you are logged in as
OPS$INSITESYS, you can use the SQL Utility found in the Admin module). This is a great way to
practice your SQL skills and learn more about how data is arranged in the database.
Sort Order – the value for Sort Order must be a unique, non-negative integer. By editing your
Queries, you may assign a respective Sort Order value that controls where the Query appears in
your list. The Query with the lowest Sort Order value will appear at the top of your list, while
higher values will push the item toward the bottom of the list.
Global Icon

– this icon helps you quickly identify Public Queries that belong to other users.

Show My Queries Only – on the Queries dropdown, when you click on Show My Queries Only,
the list of Queries on the dropdown and on the Dashboard (if applicable) will be narrowed
down to only those belonging to you.

Page
77

Show All Queries – on the Queries dropdown, when you click on Show All Queries, the list of
Queries on the dropdown and on the Dashboard (if applicable) will be expanded to include your
Queries as well as any Public Queries belonging to other users.
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The Data Grid / Working with Results
In our discussion of Queries, we covered different ways and methods to obtain a result set. In
this section we will look in detail at the Results Data Grid and how to work with your results.
We will review best practices for working with your record sets, including tips and tricks to
increase efficiency and performance.

Results Data Grid

Do not be concerned if you cannot clearly view all of the buttons, links, tabs, and fields on the
Data Grid. We will break the Grid into three sections and cover each in detail. The following
screenshot shows the links/controls above the Grid in RED, the Grid itself in YELLOW, and the
buttons/controls below the Grid in GREEN.
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Above the Grid

At first glance, it may seem a little overwhelming trying to decipher the purpose/function of
each of the links/controls atop the Data Grid. No worries – we will take a look at each in detail
so that you have a thorough understanding of how everything works. Refer to the diagram
below for a brief description of each link/control.
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Refer to the points below for a more thorough description of each:
•

Wrap Text in Grid when checked will expand row size and wrap text for full display of
data.

•

Custom Settings allow you to customize which fields appear in the Grid and their
respective order. You can hide / show columns and arrange them as desired in left-toright order.

•

Column Summary opens a modal dialog with summations for numeric fields in the Data
Grid. Calculations for ALL numeric fields are performed. Additionally, the dialog may be
resized as desired.
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•

The Hide Percentages check box allows you to hide Organization and Use percentages in
the Grid.

•

View Search Criteria displays the criteria that were used to form the Query.

•

The Freeze Columns dropdown allows you to specify a value of 0 to 5. The value
represents how many of the first 5 columns will remain static while you scroll
horizontally. This is a helpful feature designed to enhance readability of the Data Grid.

•

Restore Saved View restores the column order, sort, column width last saved, and frozen
columns. If you modify the Results Grid using Custom Settings, the Saved View is purged
and you will not be able to restore it (you will need to create a Saved View again).

•

Display All Records replaces the option of ALL in the Page size dropdown. With large
result sets, performance will be impacted by Displaying All Records, and for this reason
we have placed the link appropriately so that you will not select it inadvertently.

Custom Settings: An in-depth look

You can control the appearance of any Data Grid (Results Tab), Edit Record Screen or Add
Record Screen by utilizing the Custom Settings link. The two aspects of custom settings are
•
•

Hide / Show Columns – determine what columns will appear on the Grid or Screen
Column / Field order (left-to-right or top-to-bottom)

Begin by clicking the “Custom Settings” link to the top right of the Data Grid. A new “Custom”
tab opens. Here are a portion of space records in the Results Data Grid:

Refer to the diagram below which details the Custom Settings page.
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Now let’s look at a simple example where we add a field to the list of Displayed Fields and move
it to the second position on the list. The next series of screenshots will take us through the
process.
Image of Column Headings prior to changes:

Initial view of Custom Settings:
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Select “Bldg Name” and click Display Field(s):

Once “Bldg Name ” appears on list of Displayed Field s, use the Move Up button to move the
field up in order:
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After the field has been moved to the desired position, click the Update Data button:

Notice that “Bldg Name ” now appears as the second entry in Column Headings :
To Move multiple fields between the Hidden Field and Displayed Field list boxes
Use the <Ctrl> key and the <Shift >key to select multiple fields at once. Hold the <Ctrl> key
down while clicking on non-contiguously sequenced field names. Hold the <Shift> key down
while clicking on contiguously sequenced field names. After all the desired field names have
been highlighted, click on either the Display Field button or the Hide Field to move the
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highlighted records from one list to the other. Click on the Update Data to save the changes.
To move columns, thus changing their left-to-right order in the Results Data Grid, use the Move
Up and Move Down buttons. You can only move a single field at a time. Simply click to
highlight, then click the desired button repeatedly until the column is in the position you desire.
Important Notes about Custom Settings
•

The Settings changes you make only affect the screen from which you accessed Custom
Settings. Thus, making changes to the Results Data Grid does NOT make changes to the
corresponding Add/Edit Screens! Changes must be done separately.

•

Warning! It is entirely possible to hide "Required" fields. If you do, you will get an error
message when trying to ADD a new item that has a required field, and it is difficult to
discern what the problem is. It is a good technique to put all required fields first in any
screen. Prior to making any changes the required fields will appear in Blue text.

•

The customization performed with the Custom tab is unique to each individual User
Account and changes are captured in the database. An individual User’s customizations
will persist until he/she makes further changes.

•

Productivity Tip: If you “Hide” a field which has validation lists behind it (lookup fields
and code fields), you will improve system response time by eliminating a data post-back.

•

Hide every field you are not using – with fewer fields to display your system
performance will improve greatly.

•

Important! When working with the Facility and Floor fields, make sure that Facility
precedes Floor in the display sequence. The Floor field is dependent on the Facility field
and must be positioned before it for drop-down lists to work. When working with
Facility Feature and Space Feature fields, make sure that the Feature Category precedes
the Feature Type in the display sequence. The Feature Type field is dependent on the
Feature Category field and must be positioned before it for drop-down lists to work.
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The Data Grid

Now we will take a detailed look at the Data Grid, itself, and the links/controls contained within.
Refer to the screenshot below which shows an overview of the Grid replete with descriptions.

Description of Data Grid Elements

Element Name

Description
Check to select record for further actions

Select Record

Edit Record

Note: the Selection Box at the top of the listing on the
same line as the Column Headings is used to select ALL
records.
Click to go to the Edit Screen for managing all
information about the selected record.
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Duplicate Record

Duplicate the selected record and go into edit mode for
that duplicate.

Drill Up / Drill Down

Up Arrow will open a new window displaying the Parent
Record. Down Arrow will open a new window displaying
the Child Record.

Space (or Asset) Details

Space List and Asset List Only. Opens a new window
that displays dependent information that is found in
the tabs following the Space/Asset Edit tab.

Floor Plan

If present, the floor plan can be displayed in PDF format
with the appropriate highlights.

Floor Plan Query

Only displayed on Floor Records, and accesses Floor Plan
Query capability.

Documents

Displayed if there are stored documents for the
selected record.

Drill Up / Drill Down
The Drill Up / Drill Down capability lets you see and understand the hierarchical structure of
facilities information. When present, the Up Arrow or Down Arrow will present information
either “up” one level (parent) or “down” one level (child) from the currently displayed database
component
Drill Up
When you are in this Data
DRILL UP will open this Data Grid in a new window
Grid and focused on a record... and display the “Parent” record:
Site
Facility
Floor

Region
Site
Facility

Drill Down
When you are in this Data
DRILL DOWN will open this Data Grid in a new
Grid and focused on a record... window and display the “Child” records:
Region
Site
Facility

Site
Facility
Floor

Performing a Single Column Sort
Performing a Single Column Sort with the Data Grid is a simple as clicking (or tapping on a
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mobile device) the appropriate Column heading. The first click will order the Column records in
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ascending (ASC) order, a subsequent click will order the records in descending (DESC), and
another click will cancel the Column sort altogether. Refer to the diagram below.

Reordering Columns
In addition to providing sort capabilities, the Data Grid also allows you to reorder columns by
utilizing the “drag and drop” functionality built into the Grid. If using a mouse, hover over the
desired column until the cursor turns into an intersection symbol (on a mobile device simply
press and hold down the empty space surrounding the column heading) and hold the left
mouse click button down. Using your mouse (or finger) drag the column and hover over the
area just before the desired Column heading. A set of inwardly pointing arrows will indicate
where the column will be inserted. Refer to the diagram below.
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Resizing Columns
You also have the ability to improve the readability of the Data Grid by resizing the Columns.
Simply hover on the line that separates two columns until the cursor turns into a bi-directional
arrow. Left click and hold (or tap and hold) while dragging the Column to the desired width.
See below for an example.

Page size
Use this drop-down to select the number of records to display per “page” (groupings of records
retrieved at once). The total number of records retrieved is displayed as well. Choose from the
available increments.

Once selected, Net-FM immediately re-queries and retrieves records based on the page length.
Performance Note: The larger the pages (i.e. Page size = 500), the more time it takes to retrieve
each page. For optimal performance, choose a Page size of 50 records or less. Utilize the
“Display All Records” link at the top right of the Data Grid if it is necessary to display all records
on one page.
Page Navigation

It is fairly easy to navigate from page-to-page using the Pagination Control Bar at the bottom of
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the Data Grid. The first 2 buttons return to the beginning of the result set and the previous
page, respectively. Click on a specific page number to view results for that page. The next two
buttons move forward one page and toward the end of the result set respectively. Change the
page size to 500 if you wish to decrease the number of pages in your result set.

Controls / Elements Below the Data Grid

There are a number of features and controls located just below the Data Grid. Refer to the
following diagram for an overview of said features/controls.

Multi-Column Sort
Utilizing the “Sort By” controls below the Data Grid, you have the ability to perform up to a 3column sort. Specify the first column by selecting a value from the left-most dropdown and
choose either Ascending or Descending order. You may continue by specifying criteria for 1 or 2
additional columns. Click the Sort button to apply the sort criteria to the records in the result
set.

Copy Column Value
There may be occasions when you wish to copy values from one column to another. The Copy
Column feature allows you to easily perform this operation. Provided that the source
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column/field and destination column/field are of the same data type (i.e. number, text, date),
you simply select the source records and click the Copy Column button.
In the series of screenshots that follow, we will illustrate how to copy the values in the Station
Count field to a new column we have added to the Data Grid called “Workstations”.
All 25 records have been selected on this page (if we wanted to select all 65 records in the
result set, we would first click “Display All Records” and then use the selection box found in the
column heading area to select all records):

We have selected “Station Count ” as the source column (FROM Column ) and “Workstations”
as the destination column (TO Column). We click the Copy button to proceed:

A message indicates that 25 records for Workstations will be updated with the values from the
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Station Count column. We click the Update button to proceed:

Message confirming update was successful:

Replace Column Value
In instances where you wish to perform mass updates on a single column and replace the
existing values with a new single value, the Replace Column feature is especially useful. An
added benefit is that you can further limit the replacement to only those records for a given
value. For example, let’s assume that you run a query for all spaces in Facility “ABC”, and you
want to replace the “Use” value of “Animal Quarters” with the new “Use” of “Open
Laboratory”. By specifying the current value of “Animal Quarters”, the Use value will only be
changed for those records with a current Use assignment of “Animal Quarters” in your record
set. If you wanted to replace the Use value for all of the records, you could easily choose to
“Ignore the current value”.
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In the series of screenshots that follow, we will run a query for all spaces on Floors 1 & 2 of
Facility “OFMS”. We will then replace the value for Use in all records that have a current value
of “Animal Facilities Service” with a new value of “Class Laboratory”.
All 25 records have been selected on this page (if we wanted to select all 65 records in the
result set, we would first click “Display All Records” and then use the selection box found in the
column heading area to select all records):

We have selected Use as the column/field where the replacement will occur. A current value of
“AN FAC SVC – ANIMAL FACILITIES SERVICE” and a new value of “CLASS LB – CLASS
LABORATORY” have been specified . We click the Replace button to proceed:
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A message indicates that there are 23 records out of 25 that meet our criteria. We click the
Update button to proceed. This operation cannot be undone:

A confirmation message indicates that the update was successful. If we wish to verify the
changes, simply click on the Results tab.:

Save View
As mentioned briefly in the Data Grid description, the Save View button allows you to save the
column ordering/size and the number of frozen columns specified. If you then reorder/resize or
freeze columns within the Grid, the Restore Saved View link may be used to restore the column
ordering/size and/or frozen column setting to that of the Saved View. Note: If you make any
changes to the Grid via Custom Settings, the Saved View will be purged. Once your desired
changes have been made via Custom Settings, use Save View to save a new view.
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Save Query
In our discussion of My Queries / Customize Queries, we have reviewed the key concepts of
Saved Queries. That said we will briefly look at the Save Query button and the task of saving a
Query.
The first step to saving a query is to specify your search criteria either using the Query or
Advanced Query tab. Once the desired results have been retrieved, you will notice that there is
a button on the right-hand side of the page, just below the Data Grid. The following screenshot
shows the page displayed after clicking the Save Query button:

You can see from the Search Criteria that we have queried for Facility “OFMS – CORPORATE
HQ”, Floors “1” and “2”. In the Query Name box, we have given the name “OFMS 1 & 2” to the
query. The description “OFMS Floors 1 and 2” is meant to explicitly state what the query
returns. In our case, we have not checked the Public Query checkbox, so this query will be
saved as a Private Query by default. Clicking the Save This Query button will save our changes
and create the saved query.
Note: At this point, if you wish to further edit the query, change the scope from Private to
Public, or specify a Sort Order, you must go to the Customize screen for Queries.
Export to Excel
On the bottom right-hand side, just below the Data Grid, you will notice the Export to Excel
button (if the Net-FM Administrator has made it available). This feature allows you to easily
export the records in the Data Grid. With the release of Net-FM v 4.0, there have been some
significant improvements to the export functionality. In previous versions of Net-FM, the
export file was initially created in html format and required that the file type be changed to
“.xls” upon saving – this is no longer the case. Additional enhancements include:

Page
97

1. The ability to specify any of the following export
file types:
a. Excel/XML – an XML / human readable
format that allows for easy editing in nonMicrosoft programs
b. CSV – comma separated values file
c. HTML – as a web page (this was the
default in previous releases)
d. Binary Excel – a binary file that can only
be opened/rendered by Microsoft Excel.
It is not human readable.
2. The option from the Space List Results Grid to export
in one of two formats:
a. Grid Format – You have a choice of one of the
aforementioned file types (Excel/XML, CSV,
HTML, or Binary Excel). The columns and
column ordering in the export file match the
Results Grid.
b. Load Data Format – In this instance the file format is Binary Excel by default.
The columns and column ordering in the export file match your corresponding
column / column ordering setup in the corresponding Load Data module. This
enhancement makes it possible for you to quickly export results, make necessary
changes, and re-import into Net-FM with minimal effort.
For information on how to download and/or save the export file, please refer to the
subsequent material:
With the exception of exporting from the Space List and selecting “Load Data Format” (which
automatically begins the file download in Binary Excel format), all other screens in Net-FM will
follow the same pattern for “Export to Excel”. Upon clicking or tapping the Export to Excel
button, you will be prompted to select the radio button next to the desired export file type
(Excel/XML, CSV, HTML, or Binary Excel). Upon clicking or tapping the Export button, the file
download will begin. Once the download has completed, you will have the option to either
open the file directly or save it.
After clicking the Export to Excel button, the steps you take to access the file in Excel format
will vary depending upon the web browser you are using to access Net-FM as well as whether
or not you have Excel installed locally on your PC. In the examples below, we will review how
the Export is accomplished in Google Chrome, Firefox, Internet Explorer, and Microsoft Edge.
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Export to Excel: Google Chrome
Accessing Net-FM from Google Chrome and clicking the Export to Excel button will launch the
familiar download icon

from Google. You will see a small bar on the bottom left of the
browser that shows the download’s progress. Once
the download is complete, you will have several
options.

In our example we will either click on the main area of the download bar or the down arrow
and Open from the download bar:

If Excel is local to your computer/device, it will launch and open the export file.

Other methods for accessing the file include clicking/tapping the down arrow on the download
bar and selecting one of the following: Open, Always open files of this type, or Show in folder.
If you select “Show in folder”, you can right click (if on a PC) the file and copy to the desired
location. Once opened, you may elect to save the file in a different location if you so choose.
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Export to Excel: Firefox
The process to export results to Excel in Firefox differs slightly from Chrome. After clicking the
Export to Excel button in Firefox and selecting the desired export format, you are presented
with the following one of the following dialogs:
Example when format is: Excel/XML, HTML, or Binary Excel

Example when format is: CSV
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Export to Excel: Microsoft Edge
The Export to Excel controls using Microsoft Edge are similar to those of Google Chrome:
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Floor Plans and Floor Plan Query
One of the most powerful and useful features in Net-FM is the ability to display, query, print,
and distribute floor plans that reflect the facilities information within the database. Net-FM
utilizes an INSITE-built application that renders floor plans in PDF (portable document format)
and supports queries “on-the-fly”. At the most basic level, the floor plans can illustrate space
and area information, but in reality, the query capability offers so much more. When coupled
with the query feature, floor plans become a powerful, visual representation of your result set
(normally represented by plain data in Net-FM). We will take a look at specific examples that
will get you thinking about how best to utilize these features in your organization.
Note regarding tablets / mobile devices: PDF format is widely-used and lends itself well to both
desktop and mobile devices. In order to view Floor Plans on a tablet or mobile device, the
device must have a major web browser (Google Chrome, Firefox, Internet Explorer, Microsoft
Edge or Safari) as well as a PDF reader (i.e. Adobe Reader, Bluebeam Vu, etc.) installed.
The following diagram gives an overview of the typical Net-FM Floor Plan window.
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Floor Plan Availability in Net-FM

Floor plans are available from a number of modules in Net-FM as well as Space Survey.
Depending upon the module, floor plans may be accessed using various icons, links, and tabs.
We will look at examples of each, but before we do, focus your attention on the Venn Diagram
below.

As you can see from the illustration above, some floor plans can be accessed from Space
Management, some from both Space Management and Space Survey, some from both Space
Management and Indirect Cost Recovery, some from the Sign module, and some from Asset
Management. For example, let’s assume that we would like to highlight all rooms in Facility
“OFMS” where “Federally Sponsored Research” is being conducted. Since “Federally Sponsored
Research” is a function, we would know to query the floor plans from either Space
Management | Function Assignment or Indirect Cost Recovery | Function Assignment.
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How to Access Floor Plans
There are several ways to access floor plans; refer to the following for a brief overview:

All of these methods (with the exception of “Floor Plan Query” which is only available from the
Floor List) are common ways to access/produce floor plans. Whether clicking on the standard
floor plan icon or navigating to the Floor Plans tab (where you may use the hyperlinks or
download button), it is apparent that floor plans are easily accessible from within Net-FM. As
we look in detail at each of these methods, the practical applications will become transparent.
For example, this query returns all Floors for Facility OFMS:
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When the “Floor Plans” tab is clicked, the list of floor plans whose spaces are part of the Results
records is displayed:

Note: For floor plans to appear, the floor plan must both meet the search criteria and a drawing
must be available. Click on an individual floor plan link to open the PDF floor plan with spaces
shaded.

The Floor Plan List Box

In this window (example displayed above, there are two actions you can take:
1. Choose a floor plan to open and view – simply click on one of the floor plan links
2. Generate and save a zip file of all floor plans listed. You can provide an optional Title and
/ or description for inclusion with the zip file. Click the Generate Floor Plans for
Download button to create the zip file and choose where to save it on your computer.

Floor Plan Actions

Whenever a floor plan is displayed from Net-FM, you have the option to change many settings
and redraw the floor plan with the settings in place.
Hide Legend
•

•

•

•

A legend is only displayed if one or more spaces (rooms) have been highlighted. To turn
the legend off, click the checkbox for 'Hide Legend', and then click the 'Redraw Floor
Plan' button.
The 'Title / Query Description:' box allows for a customized legend title to display
beneath the legend, if there is a legend. Otherwise, the optional 'Title / Query
Description:' will be displayed at the bottom of the floor plan. Enter a title and then click
the 'Redraw Floor Plan' button.
The ‘Legend Font Size’ option allows you to dynamically change the font size in the
legend. Once you specify a new value, click the ‘Redraw Floor Plan’ button to have your
changes reflected in the drawing. In addition to this setting, improvements have been
made to the default scaling of the legend font size with this release.
The ‘Legend Origin X’ and ‘Legend Origin Y’ controls allow you to dynamically change the
position of the floor plan legend.
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Hide Space Label
Space labels, if displayed, can be turned off. To turn the space labels off, click the checkbox for
'Hide Space Label', and then click the 'Redraw Floor Plan' button.
• The ‘Space Label Font Size’ is a recent improvement to floor plan display. By specifying
the desired value in this field and clicking the ‘Redraw Floor Plan’ button, the font size of
the Space Labels will be resized dynamically. This saves you the extra steps of having to
edit “My Drawing Preferences” in situations when you wish to adjust the Space Label
Font Size for ad hoc queries.
Space Label Field Selection
Click the checkbox for: 'Space Label Field Selection' to expand the available:
• Standard Fields – Facility, Floor, Room, Use, Org, FICM Area, BOMA Area, and Doortag.
Only checked fields are displayed. Check or un-check the appropriate fields. Then, click
the 'Redraw Floor Plan' button. When viewing dynamically generated floor plans, each
user has control over the default space label parameters that are displayed by the My
Drawing Preferences tab.
• Additional Field (available from Space List and Asset List queries) – One additional field
can be selected to be displayed beneath the space label when viewing floor plans
resulting from Space List and Asset List queries. The additional field can be selected
among several fields available for the context of module being queried.
Layer Selection
By default, a floor plan displays the layers that were turned on when the drawing was last
saved. These layers are checked and highlighted in the 'Layer' list. Individual layers can be
turned on and off in the layers list that appears in the frame next to the floor plan. After
selecting the appropriate layers by checking on or off, click the 'Redraw Floor Plan' button.
From the browser PDF plug-in, you also have the ability to use standard PDF functions:
•
•
•
•
•

Print to a printer
Save the PDF to a file
Zoom in and out
Pan around the drawing
Search for words

Floor Plan Queries
Net-FM has an added query capability with floor plans. It is available only from the Floor List
and only on Floor Records where a floor plan exists and you have the Floor Plan Query license
for Net-FM. Look for the Query Symbol and click to open the Floor Plan Query screen. The
diagram below shows the Floor Plan Query screen, and each menu/selection area is labeled
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with a corresponding letter. The diagram is followed by an ordered list (alphabetic order) with
matching headings/descriptions.
Before diving directly into the details, it is important to grasp the concept behind the Floor Plan
Query. In essence, this feature allows you to formulate a query of space-related information for
a given floor, and show the results of the query visually using multi-colored highlights and a
corresponding legend. How can this feature be of benefit? What if you wanted to show all
Office spaces where the room area is less than 100 square feet? What if you wanted to see all
lab spaces belonging to the Biology department on a given floor? Floor Plan Query helps you
accomplish this task visually by highlighting the respective spaces on the floor plan. You can be
a valuable resource to decision makers at your organization by using Floor Plan Query to aid in
the Facilities Planning process.

A. Area Split By – click one radio button to specify the prominent group for highlighting:
Organization, Use, Block, Text, or Additional Field.
The resulting floor plan query will highlight each different item with distinct colors. The
exception is for queries on Room, Door Tag, and Area. These queries will highlight all
rooms with the same color. Highlighting spaces with distinct colors for Room and Door
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Tag queries is available by selecting the "Group By" checkbox in the corresponding
query.
Note: If a room contains more than one query item, the room will be highlighted using
multiple colors. The amount of each color displayed in one room, or 'Area Split By:' is
determined as follows:
•

Organization and Use both use Percentage as the split multiplier

•

The Functions and Space PIs categories in Additional Field use Percentage as the
split multiplier

•

Block, Text, and rest of the categories in Additional Field use total count as the
split multiplier.

•

Organization and Use: If either Organization or Use is selected as a query item,
then the corresponding 'Area Split By:' radio button is automatically selected. If
both Organization and Use are selected as query items, then 'Area Split By:' radio
buttons for both Organization and Use will be available for selection. Only one
radio button can be selected. The selection is made automatically for the last
query item selected.

•

Block, Text, and Additional Field: If either Block, Text, or Additional Field is
selected as a query item, then the corresponding 'Area Split By:' radio button is
automatically selected. If multiple items are selected as query items, then 'Area
Split By:' radio buttons for all selected items, Block, Text, and Additional Field,
will be available for selection. Only one radio button can be selected. The
selection is made automatically for the last query item selected. Note: While Org
and Use may be conditions of a query, Org and Use will not be used for the 'Area
Split By:' calculation to highlight spaces if Block, Text, or Additional Field is
selected.

B. Room / Group By Room – this menu allows you to select one or more rooms for
highlight. If you do not select the Group By Room checkbox, all selected rooms will be
highlighted in the same color (provided you have not specified additional query criteria).
If you select the Group By Room checkbox, each room will display with a distinct
highlight and be listed separately on the drawing legend.
C. Organization – this menu allows you to select one or more Organizations for the
purpose of the room highlight. By default, the radio button for Organization in the Area
Split By menu is selected (this will prorate the shaded area according to Organization for
rooms with multiple Organization assignments). If you have specified additional query
criteria such as Use, for example, you may elect to prorate the highlights according to
the additional field (in this case Use).
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By default, all values in the chosen list box are highlighted for inclusion in the query.

D. Use – this menu allows you to select one or more Uses for the purpose of the room
highlight. By default the radio button for Use in the Area Split By menu is selected (this
will prorate the shaded area according to Use assignment for rooms with multiple use
assignments). If you have specified additional query criteria such as Organization, for
example, you may elect to prorate the highlights according to the additional field (in this
case Organization).

E. Door Tag / Group By Door Tag – this menu allows you to select one or more Door Tags
for the purpose of room highlights. If you do not select the Group By Door Tag
checkbox, all rooms where the selected Door Tags are present will be highlighted in the
same color. If you select the Group By Door Tag checkbox, each room where the
selected Door Tags are present will be highlighted with a distinct color and listed
separately in the drawing legend.
F. Block – this menu allows you to highlight rooms on the floor plan based upon blocks or
symbols contained within. If you are unfamiliar with the concept of blocks/symbols,
refer to the following screenshots:

Page
111

G. Text – this menu allows you to highlight rooms on the floor plan based upon text
contained within a room. A good example of practical use is if you have a layer on the
floor plan that displays the type of floor covering in a text field (i.e. carpet, tile, etc.).
Conceivably you could use this functionality to highlight all Offices on a given floor that
have carpeting as the floor covering type.
H. Area – this menu allows you to highlight rooms based upon criteria you specify related
to the area. This makes for a great analysis tool for space utilization and renovation
planning. You may select the following values from the Area menu and specify a
corresponding Area value:
• Equal To
• Not Equal To
• Greater Than
• Greater Than or Equal To
• Less Than
• Less Than or Equal To
One example is if you wanted to find all Office space on a given floor for which the room
area is Less Than 100 square feet. The Floor Plan Query is the perfect way to obtain a
visual representation.
I. Additional Field – this menu allows you to select an Additional Field (Feature Category,
Functions, Grants, Occupants, Space Contact, Space PIs). Once you select the Additional
Field, the respective values (if any) will populate the Values menu. See next.
J. Values – as indicated, the Values menu will populate with available values once you
have selected the Additional Field. In the example below, we have chosen to highlight
the floor plan according to spaces that contain the Function “RSH-FD – SPONS RSCH –
FED” or Sponsored Federal Research.
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How can this be used practically? Let’s assume that we want to show all of the offices
belonging to the Biology department on Floor 2 of Facility “OFMS”. The Floor Plan Query
enables us to do this. We simply query the Floor List for Floor 2 of OFMS, click the “Q” (Floor
Plan Query icon), check the Organization box and highlight “Biology”, check the Use box and
highlight “Office”, and click the Generate Floor Plan button. When the Floor Plan is ready, we
click the View Floor Plan button and the PDF, replete with highlights displayed.

Results:
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Perform the following actions for powerful queries and displays:
Click one or more checkboxes to select the group(s) of interest: Room, Organization, Use, Door
Tag, Block, Text, Area, and Additional Field
•

Click on one or more items of interest within each selected list box. Use the 'Ctrl' key
and 'Shift' key to select multiple items within the list box.
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•

Accomplish numeric queries on area

•

Additional fields from the database (if they exist) can be added to the query result as an
extra field in the space label. For a category of Additional Field, all values for the floor
plan are displayed. They can all be included, or highlight a subset.

Click the Get Results button
A new window will open to display a PDF floor plan with highlights and legend based on the
elements selected in the Query Floor Plan Screen.
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Common Tables and Lookups
Data validation is an integral part of Net-FM and the underlying INSITE database. You may have
noticed that there are a number of locations in Net-FM where fields appear as dropdowns
instead of free text. This is all by design to ensure that the Net-FM user group enters data in an
efficient, consistent manner.
Three basic table types store the corresponding values for dropdown lists in Net-FM:
1) Data tables whose values are used in other tables. For example, the Site table comprises
the list of valid values for entry into the Site field in the Facility Table.
2) Common tables validate fields that occur in tables in more than one module. They
include: Address, Cost Type, Feature Type, Person, and Person Address, Person Skills,
and Skills.
3) The Lookup Tables store valid values for the remaining drop-down fields in all database
tables in all modules. There are two separate Lookup tables – one for Space
Management and another for Asset Management.
Data Table example
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Common Table example
The screenshot below demonstrates how the values in the Person table are used to populate
the Responsible Person dropdown:

Lookup Table example
The following screenshot illustrates how the “Asset Condition” Lookup Type is used to populate
the “Condition” field in Asset Management.
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Net-FM Lookups
Available Lookup Types
Lookup Types fall into one of two categories: those pertaining to Space Management and those
pertaining to Asset Management. See below for a full list of the Lookup Types for each module:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Space Management
Address Purpose
Contact Type
Cost Category
Country
County
Domain
Facility Category
Facility Code 1 - 5
Facility Condition
Facility Cost Code 1 - 2
Facility Feature Code 1 - 10
Facility Occupancy Class
Facility Ownership
Facility Primary Use
Facility Status
Facility Type
Feature Category
Floor Code 1 - 2
Function Code 1 - 2
Grant Code 1 - 5
Occupancy Code 1 - 2
Organization Code 1 - 5
Person Code 1 - 5
Person Rank
Region Code 1 - 2
Sign Code 1 – 2
Site Code 1 – 2
Space Category
Space Code 1 - 10
Space Cost Code 1 - 2
Space Feature Code1 - 10
Space General Code 1 -30
Space General2 Code 1 - 30
Space PI Code 1 - 2
Space Sign Code 1 - 2
State
Sub Use Code 1 - 2
Use Code 1 - 10

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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Asset Management
Account Code 1 - 2
Account Segment1 Code 1 - 2
Account Segmnt2 Code 1 - 2
Account Segment3 Code 1 - 2
Account Segment4 Code 1 - 2
Account Segment5 Code 1 - 2
Account Segment6 Code 1 - 2
Account Segment7 Code 1 - 2
Account Segment8 Code1 - 2
Asset Accounting Code 1 - 2
Asset Acquisition Method
Asset Category Code 1 - 2
Asset Class Code 1 - 2
Asset Code 1 - 5
Asset Condition
Asset Disposition Status
Asset Ownership
Asset Tag Type
Depreciation Method
Depreciation Status
Estimation Method
Fund Source Code 1 - 2
Funding Type
Major Account Code 1 - 2
Nomenclature Code 1 - 2
Object Code
Subcode Code 1 - 2
Vendor Code 1 - 2

Managing Lookups
The Space and Asset Management Lookup tables store values that
serve as source data for drop-down lists. You can manage Lookups
related to Space by navigating to Space Management | Common |
Lookup. Conversely, if you want to manage Lookups related to Assets,
navigate to Asset Management | Common | Lookup.
Refer to the screenshot below which provides a cross-section of
various space-related Lookup Types and their associated values. For
example, focus your attention on the bottom-most records that
correspond to “Facility Primary Use”. As you can see, valid values
include: Administration, Residential, Teaching, Research, Mixed Use,
and so on.

Editing Lookups
In order to edit values for a particular Lookup, you must first query for it. Using Query or
Advanced Query, you can search for the Lookup by Lookup Type, Name, Code, or Memo
(available through Advanced Query only).
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In the example above we successfully edited the “TEST” Contact Type and changed it to “LSO”
(Lab Safety Officer).
Adding Lookups
In order to add values for a particular Lookup, you must first query for it. Using Query or
Advanced Query, you can search for the Lookup by Lookup Type, Name, Code, or Memo
(available through Advanced Query only). If the Lookup is related to Asset Management,
navigate to the Common | Lookup from Asset Management; conversely if the Lookup pertains
to Space Management, navigate to Common | Lookup from Space Management.
In the example below, we navigated to Space Management | Common | Lookup, selected the
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Add tab, selected “CONTACT TYPE” from the Lookup Type dropdown, and specified values for
Code and Name.
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Maintaining Facilities Information
With Net-FM, updates can be performed on a continual basis. Any inserts, updates, or deletes
performed on tables in the INSITE database occur in real-time, thus you can be confident NetFM users are accessing the latest information.
When you are updating the INSITE database, you use Net-FM to:
•
•

Insert new records into any table
Duplicate an existing record, then change some of the duplicate data to produce a new
record

•

Update the values of any field in a table, including removing them

•

Delete existing records from a table

•

Perform a Global Delete to remove many records at once

In addition, Net-FM provides a wealth of capabilities to assist you in maintaining information:
•

Powerful search/replace feature to perform global updates and replacing

•

Maintain lists that supply valid entries for lookup fields

•

Use external sources to load data for new records, or update existing records

A Word on the Add and Edit tabs
When a record is edited, the Edit tab displays a series of fields with existing values for all
columns used in the Database table. This Edit screen can be customized to only include fields
you are using, and you can also re-order the sequence of fields on the screen. The settings you
specify for the Edit tab are also applied to the Add tab.
Remember three recommendations when applying Custom Settings to the Add and Edit tabs.
•

Hide all the fields you are not using in the record to increase performance.

•

Ensure that all mandatory fields are displayed. If you try to save a record that has a
hidden required field with no data entered, you will get an error message.

•

Try to maintain consistency between the columns / column order on the Data Grid and
the fields / field order on the Add and Edit tabs (this will make life easier if you utilize
the Load Data feature in Net-FM).

Additional Tabs
When editing individual records (or directly after adding a record), you may notice additional
tabs appear to the right of the Edit tab. Each of these additional tabs provides further
information related to the current record and in some cases allows you to insert/update/delete
additional information pertaining to the record. The tabs that display will depend upon your
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preferences (you may have some hidden by default) as well as the module you are accessing.
To verify that you do not have any tabs inadvertently hidden in Space List Edit, navigate to My
Preferences | Hide Tabs – Space List Edit and verify if any of the boxes are checked (this will
hide a given tab).
In the Space Management Module, the major components have these tabs to access
information related to the individual record you are examining, editing, or have added.
Land: Region

Land: Site

Facility/Floor: Facility

Facility/Floor: Floor List

Space: Space List

Refer to the Space – Facility (Edit) and the Space – Space (Edit) screenshots above. As you can see from
both, there are a number of additional tabs following the edit tab where you may update Facility
information and Space information respectively.
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Data Maintenance
Perform these activities in Net-FM to maintain the INSITE Database. Data maintenance is
performed on the Results, Edit, and Add Screens for all modules.
Add
The Add tab is used to insert a new data record to the database.
The Add Screen becomes active by directly clicking on the Add tab when it is displayed. The
fields displayed will reflect your Custom Settings – if you do not see a desired field, check
Custom Settings and make sure it is not hidden.
The Add Screen also becomes active after the Duplicate Record button on one of the rows in
the Results Screen is clicked. In such a case, the data values from this active record will be
duplicated on a new Add Screen. Since the database can not contain duplicate records, at least
one of the field values needs to be changed in order to make the record unique and successfully
insert it into the database.
The Add Screen also becomes active after the Duplicate Record button on the Edit Screen is
clicked. In such a case, the data values from this record will be duplicated on the Add Screen.
Since the database can not contain duplicate records, at least one of the field values needs to
be changed in order to make the record unique and successfully insert it into the database.
The Add screen works the same way in all areas of the system. All field names that are
highlighted in blue are required fields and cannot be omitted – you must add values in required
fields.
All changes performed on the Add Screen will be saved to the database when the Add Record
button is clicked. A confirmation is displayed in the upper right-hand side of the screen. This
area will also display error messages as appropriate if there are issues with adding the new
record.
Inserting New Records
Insert a new record by clicking on the Add tab for each respective module. Enter the data in this
blank record. At a minimum, all required fields (indicated with Red labels on the page or blue
headings in Custom Settings) must have values entered. Any additional fields can optionally
contain data.
The Add Screen may contain fields of various data types. You input data into most fields by
typing or by selecting from a drop-down list. There are different considerations for the available
field data types.
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Text Field Data Type
Text fields are free-form. You can enter anything into text fields, subject only to the length limit
of the field in characters.
Note: Text can be entered as all CAPS or as case-sensitive upper/lower case. Be careful
to maintain case consistency throughout the entire database. Included with Net-FM is
the ability to perform Case Sensitive searches and queries.
Numeric Field Data Type
When you enter numeric data, such as area, it is important to only enter the numbers. Do not
enter the dollar sign or commas. If adding an area of say 10,000 sq. ft., enter as 10000 with no
comma or units. You can enter fractions of a number using a decimal point.
Date Field Data Type
Net-FM stores all years as four digits and displays the year in accordance with the settings on
the Windows Control Panel Regional Properties date tab. To avoid date confusion set the date
to display a four-digit year.
Net-FM also has an Administrative setting to display dates as either MM/DD/YY or DD/MM/YY.
HINT: You can enter a two-digit year regardless of the Windows date setting.
Two-digit years between 0 and 49 default to the year
20## Two-digit years between 50 and 99 default to the
year19##
For example when you enter 1/1/99, INSITE interprets this date and stores the year 1999.
When you enter 1/1/47, INSITE interprets this date and stores the year 2047. It is highly
recommended that you enter dates with 4-digit years to avoid confusion.
Logic Field Data Type
There are a number of fields that are a logical “Yes/No” data type. This essentially allows you to
flag records in a database that meet a certain condition, and you want to be able to search for
that condition easily. When entering a value, use the drop-down with two choices: YES and NO.
Dropdown Lists
A drop-down list is present when you see a box with a drop- down arrow to the right side.
Some drop-downs may have a checkbox to the right. These drop-down boxes are not
initially populated when the screen is opened, unless you click the checkbox. Because there
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can be multiple fields on the screen with drop-down lists behind them, and because these
lists may be very large, restricting automatic loading of all these lists will improve the
performance of your system. Only when you click the checkbox is the individual field’s dropdown list populated.
The default state of the drop-down list checkbox for each module controlled with the My NetFM Preferences feature:

Drop-down lists reduce data entry mistakes by requiring entries to match values on a predefined list. You can use any of these techniques to enter data from a drop-down list:
•
•

•

Click the drop-down list box and then use the scroll bar to move down the list of values.
Click on the desired value to enter it into the field.
Click the drop-down list box (or, use the <Tab> key to highlight the drop-down list box)
and then use the <Up> and <Down> keyboard arrows to move down the list of values.
Press the <Enter> key to select the desired value to enter it into the field.
Click the drop-down list box and type in the value directly. Net-FM will validate the
typed entry against the pre-defined list. The validation process will stop at the last valid
typed entry. The <Backspace> key may be used to move back one space at a time.

A note on using the type-ahead capability within drop-down list boxes:
In non-dependent lists, such as any 'Code' field drop-down list, you can slowly type
character-by-character and watch as the system validates against the list. With
dependent lists, such as 'Facility' and 'Floor', as soon as you stop typing, the system will
populate the sequential drop-down list – so you need to type extremely quickly. Once
the 'Facility' is selected, the 'Floor' list is then automatically populated. After the Floor is
selected, the 'Room' list is then automatically populated. To preclude the system from
automatically populating the Floor and Room drop-down lists before you have had the
time to correctly type the desired value in the drop-down list box, you can check the
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checkbox in My Net-FM Preferences (this is the default) to turn-off automatic
population of the Floor and Room drop-down list.
Productivity Tips: When a drop-down list with database values is present, you can hold down
the <Ctrl> key while clicking to select multiple database values. Whenever Net-FM has to
display a dependent drop-down list, a new web page must be retrieved and displayed – this will
slow system response. You can use the "Custom Settings" Hide feature to hide dependent dropdown fields if you don't use them on certain tabs. (An example of a dependent drop-down list
is the Floor field list. First you have to specify a facility, once chosen, the system will generate
the appropriate floor list for display.)
Duplicating Existing Records
To duplicate a record, click the Duplicate Record button on the left side of the row on the
Results tab. This action will open an Add Screen and the data values from this record will be
duplicated. Since the database can not contain duplicate records, change at least one required
field and any others you wish to make the record unique. When you are finished making
changes, click the Add Record button.
Editing / Updating Records
The Edit Screen displays one record at a time (the focus record). In cases where the Edit
window is not large enough to display the entire record, you will need to scroll down to see the
remaining entry fields. Make the changes as described in the earlier section on Adding Records.
Click the Update Record button when you are finished to commit the changes to the database.
Deleting Records
The Delete Selected button on the Results Data Grid is used to permanently delete records
from the INSITE database.
There will be times when data related to the record you are trying to delete exists in other
tables. The record may be a Parent of another one, or contain information that is linked to
other records. In such cases, an error message will so indicate and you will not be able to delete
the record until you have first addressed the records or information associated with it. A record
that is a Parent to another record cannot be deleted without first removing or reassigning the
Child record.
IMPORTANT! Deleted records cannot be undone. There is no Oops! button. When you delete a
record, its removal is committed to the database and the data is lost.
In support of data integrity, if there are records out for Space Survey you will not be able to
delete an Organization or change an Organization Assignment for associated records. If you
attempt to change the Organization Assignment for one of the spaces in question, you will
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receive the following message: “Cannot change Organization Assignment. Space is out for
Survey.” If you attempt to delete the space from Net-FM or using one of the graphics products
(ACADLink or Visual-FM) you will receive the following message: “Error deleting data: Spaces
are out for survey”.
Storing Documents with Database Records
While not a full-fledged Document Management System, Net-FM does have a feature to store /
link documents to database records. On a number of modules in Net-FM you will notice the
presence of the Documents tab. This tab allows you to:
•

specify documents for upload to the Net-FM application web server,

•

view documents that are on the Net-FM application web server.

Documents can be linked and stored in any record for the following in Net-FM: Region, Site,
Facility, Floor, Space, Asset, Grant (Project), and Move Management.
With the current release it is now possible to attach documents in the following modules:
Space Feature, Space General 1, and Space General 2. Asset Accounting now displays
documents from associated assets per Consortium Member request. All of these updates are
now reflected in the Document Navigators.
Any available "Space" Documents will appear by list in the left-side window pane. Any available
"Facility" and "Floor" documents will appear in the right-side window pane. You can click on the
link to view the document.
To upload files to the server, either enter a complete path and filename into the File Name box
and click on the Upload File button, or click on the Browse button – this will open a Windows'
Choose File dialog box from which you select a file for upload.
Saving Changes
Saving changes after performing an edit requires you to click the Update Record button. Saving
a new record requires you to click the Add Record button. All edits, additions, and deletions are
performed against the INSITE database immediately.
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Reports, Printing
The Net-FM Standard Reports

A host of Standard Reports are supplied with Net-FM, and new ones are being added with each
release. These reports can be easily generated and the results displayed in a separate browser
window.
To access the reports, click on “Reports” in the Net-FM navigator, then click on the appropriate
folder that groups reports by Application – either Space or Asset.
Follow these steps to produce a report.
1. Click on the report you wish to produce.

2. A new window opens where you can determine the scope of the report, generate it, and
display the results.
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3. The Report is displayed in a new browser window. Use your browser controls and
commands to view and print.

The two lines in the leftmost position of the report header can be customized through
Net-FM’s Administration Client.
Reports produced in Net-FM have some limitations:
•

There is no pagination – the entire report is displayed on one “virtual” page

•
•

Thus, there are no footers or page numbers
The report header is not repeated, nor can it be “frozen” at the top of the screen while
scrolling through the report body of data

Reports can be produced in a more powerful and comprehensive third-party Report Writer
program. OFMS provides the library of INSITE Standard Reports in Crystal Reports format and
they are fully and freely distributed to Consortium Members. Each organization can fully
customize the Standard Reports as well as create new ones for specific issues.
If you wish to edit/customize the reports, perform one of the following operations:
• print to PDF
• save as HTML and open in MS Word to edit
If you have access to Adobe Acrobat or another PDF creator, create the PDF, and edit
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Data Extraction / Export
Export to Excel

The Export to Excel feature is a simple, straight-forward way to extract data from Net-FM. The
resulting file may be used for data analysis, manipulation, and integration into other
applications. With multiple export file formats available, it is now easier than ever to integrate
with third-party or cloud-based applications such as Google Sheets.
In addition to the aforementioned uses, Export to Excel proves useful in the process of updating
information in the INSITE database. The exported file may be edited, information deleted or
inserted. The updated file may then be loaded into Net-FM via Load Data, thus affecting
changes to the database via inserts/updates/deletes where appropriate. We will discuss in
more detail in the section on Load Data.
Export File Format Offering Expanded
INSITE is happy to provide the following expanded offering of available export file formats:
• Binary Excel – This format will automatically open in Excel (if it is local to your device/PC).
Binary format is non-human readable, but it can be opened with other spreadsheet
programs such as Google Sheets.
• Excel/XML – Open XML format may be opened with Excel or any other editor/XML viewer.
• CSV – A comma separated value file may be opened with a number of programs, including
but not limited to, simple text editors.
• HTML – In this format the data is exported as a web page.

Enhancement to Space List Export
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In comparison to other modules in Net-FM, the Space List has some unique challenges with
respect to Load Data and the format/order of column level information. With the latest
release, it is now possible to export data from the Space List in one of the following two
formats:
1. Grid Format
2. Load Data Format
Grid Format – The columns and their respective order reflect what is found in the Data Grid.
This format represents the pre-existing functionality.
Load Data Format – Using this export format, you will ensure that the Excel sheet contains
the fields required for the Data Load. The major benefit to using this format is that your
export file will contain the required fields for import. Prior to clicking the “Load Data
Format” option from the Export to Excel button dropdown, check “Hide Percentages” on
the top right of the Data Grid. You may then add new records, edit existing ones (with the
exception of Org/Org Percentage and Use/Use Percentage fields).
Note: For records that already exist in the database, neither the
Organization/Organization Percentage nor the Use/Use Percentage are
validated/updated using Load Data for the Space List. The Load Data section of this
document will explain the various intricacies and proper methods to accomplish the
task at hand.

In the section that follows, we will use a sample list of spaces and follow the Export process
step-by-step.
Preparing for Data Extraction
All exports occur from the Results Data Grid. The following tips will help ensure the exported
file contains the appropriate data in the desired order:
1. Visibility – Ensure that the Results Data Grid contains the desired columns. Utilize
Custom Settings to Display/Hide the appropriate columns.
2. Order – The column order in the Export file will reflect the column order in the Results
Data Grid. Utilize Custom Settings to reorder columns as desired.
3. Scope – The Export file will contain the record set determined by your query scope.
Regardless of your pagination settings or how many records are displaying in the Grid,
the entire result set returned from your query will be included in the Export file. The
selection boxes to the left of each record have no bearing on Export to Excel.
The following is a list of spaces that has been customized as desired.
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Exporting and Saving the File
THE SEQUENCE AND APPEARANCE OF DIALOGS IS BROWSER DEPENDANT
The next step is to export the data to Excel. The following screenshots are from Google Chrome.
1. Click the Export to Excel button.
2. Next, select the export format by clicking/tapping the appropriate radio button. In this
exercise we will select Binary Excel.

3. Click or tap the Export button.
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4. The download will begin and progress will display on the Download Bar at the bottom of
the browser.

5. Once the download symbol has disappeared and the download has completed, you will
have two options:
a. One-click/tap launch in Excel – simply click the file name on the download
bar to launch the file in Excel. Once the file is open, you can perform a “File |
Save As” operation to save the file in the desired location.

b. Alternate options – By clicking/tapping on the downward arrow, you will
have the following three options:
i. Open – will open the file
ii. Always open files of this type – the default action will be to open
files of this type
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iii.

Show in folder – the downloads folder will open in a Windows File
Explorer with the file highlighted

6. The spreadsheet now displays all exported data and column headings that match those
in Net-FM.

7. IMPORTANT: The next step is to save this Excel file on your local hard disk or to cloud
storage. Steps will vary according to your version of Excel and operating system:
a. Excel 2007: https://support.office.com/en-us/article/Save-a-workbook-inanother-file-format-7f68edfd-d1f1-4bca-a836-95112b4f443b#bm2
b. Excel 2010: https://support.office.com/en-us/article/Save-a-workbook-inanother-file-format-eb019937-6842-4412-8046-112cc6948d08
c. Excel 2013: https://support.office.com/en-us/article/Save-your-workbook92e4aae0-452d-497f-a470-570610ff720a
d. Excel 2016: https://support.office.com/en-us/article/Use-Save-As-on-theFile-menu-cf7536a3-6842-4056-b9cc-443a7f44b104
e. One Drive: https://support.office.com/en-us/article/Save-documentsonline-8ba1f596-6bc9-4e35-99d4-e27a40037789
Note: For more information on Excel and functionality on iOS or Android, please visit:
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https://support.office.com/en-US/Excel
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Using Excel Export in Load Data: If you are planning on modifying the Excel worksheet and
subsequently using it with the Net-FM Load Data component, there are some additional
considerations you should make before exporting the file. Please refer to the following:
• Space List Export – By default, the Organization and Use columns in the Space List Grid
contain the associated percentages. Click the Hide Percentages checkbox prior to exporting
the results to Excel.
A word on columns containing alpha-numeric data: Although we will cover recommended data
transformation methods in our discussion of Load Data, it is important to mention a special
case. Fields / columns such as Floor or Code tend to contain alpha-numeric data and values
containing leading zeroes. This can pose a problem when using Load Data, since the Excel
translation engine can corrupt data by dropping leading zeroes or guessing the data type of a
column. The solution is to prepend a single apostrophe to columns where there are leading
zeroes or that contain alpha-numeric data. This will ensure that these columns are treated as
text in the Load Data. Keep this in mind when exporting data to Excel, making changes, and
ultimately using Load Data in Net-FM to load updated values.
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Loading Data into Net-FM
In the previous section, we have extensively detailed the operation of exporting data to Excel
and the various associated nuances. The inverse of exporting data is importing data, and this is
accomplished with the Load Data module in Net-FM. Load Data makes it possible to perform a
number of useful, time-saving activities:
•

Bulk Operations – the central theme with Load Data is that it allows you to perform bulk
operations with respect to the data in the INSITE database. Mass inserts, updates, and
deletions may be performed.

•

Add New Records – Instead of using the Add tab for the respective module in Net-FM,
you can use Load Data to quickly and easily add records using a carefully constructed
Excel file.

•

Update Existing Records – Whether creating an Excel file from scratch or editing the
contents of an export file, Load Data makes it possible to quickly and efficiently update
records in bulk.

•

Validation – Built-in with Load Data are several ways to validate data in the Excel file
prior to attempting the load operation. We will discuss this in detail, but some of the
checks performed include validating column order, data types, Lookup values (enforcing
referential integrity) and more.

A number of significant enhancements have been made to the Load Data module. Before
proceeding we will introduce each, and will cover in full detail later in this section:
•

The following four Load Data modules have been re-architected and now rely upon the
latest database utilities:
o Space List
o Organization Assignment
o Use Assignment
o Function Assignment

•

Support for Open XML (.xlsx) files has been added to the four aforementioned modules

•

It is now possible to load split Org, Use, and Function Assignments from the
Organization Assignment, Use Assignment, and Function Assignment Load Data modules

Preview Validation for Space List, Organization Assignment, Use Assignment, and
Function Assignment has been reworked to include the following:
o An option to validate a designated number of records (simple validation for
column order, data type, etc.)
o An option to validate ALL records. This performs a comprehensive validation
and includes various business rule checks.
In the next section, we will cover the most important considerations when preparing for and
eventually completing a data import using Load Data.
•
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Considerations in Preparing Data for Loading

Checklist for Load Data
Required Fields: If inserting new records, are all of the required columns present in
the Excel file?
Unique Columns: If performing an update, are ALL unique columns present in the
Excel file in order to properly identify the record(s) for update?
Column Order: Does the column order in your spreadsheet match that of Load Data?
(If not, either reorder the Excel file or use the Custom Settings for Load Data.)
Percentages: Are the appropriate percentages specified? (where appropriate) In the
proper format?
Lookup Values: Have you specified valid Lookup values for columns containing Lookup
fields?
Formatting: Are the fields formatted appropriately? For example, percentages are
positive numbers less than or equal to 100, do not contain a percentage sign, and only
contain decimal values where acceptable (based upon system setting).
NULL Checkbox: Have you fully contemplated the ramifications of replacing existing
column values with NULL values?
Excel File Format: Is the Excel file in the proper format? (i.e. .xls or .xlsx for Space
List, Org Assignment, Use Assignment, and Function Assignment. .xls for all other Load
Data modules)
Ignore the top/bottom nn line(s): Have you appropriately set “Ignore the top nn
line(s)” or “Ignore the bottom nn line(s)”?
For a more in depth explanation of each item on the Load Data checklist, see below:
•

Required Fields – When adding new records to the INSITE database, there are one or more
required fields that must contain values. On the Load Data tab, the required fields appear
in Blue text.

•

Unique Columns – In order to perform an update to an existing record, it is necessary to
provide values for the “Unique Columns” so that Load Data can select the appropriate
record or records for update. For those familiar with database terminology, think of the
Unique Column or Columns as forming a primary or composite primary key.

•

Column Order – Although Load Data is intelligent in many respects, it does not validate
columns based upon the column heading. Instead, Load Data looks for a particular column
based upon the column order specified in the Load Data Custom Settings. With this in
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mind, if the second column in Load Data is “Floor”, regardless of the column’s heading in
the Excel file, Load Data will attempt to validate this against existing Floor information in
the database.
•

Percentages – You may have noticed a Data Type legend in Load Data. Next to percentage
fields there is a description of Number (4,1). This means that a percentage may consist of 4
digits total, up to one decimal place.

•

Lookup Values – If you are familiar with the Add or Edit tabs in Net-FM, then you are also
likely familiar that some fields are editable only by selecting a value from the dropdown. In
many cases, these dropdowns reflect the pre-specified “Lookup Values” in the INSITE
database. Lookup Values are designed to ensure data integrity.

•

Formatting / Data Types – There may be cases when you use the Preview Validation feature,
where the system informs you of a data type mismatch or indicates that a field is not in the
expected format. For example, if a field only accepts a number, the system will not accept
text in the Preview Validation or Load. Additionally, you may have a date field that includes
a time stamp (i.e. 9/21/2016 22:10:52). The Preview Validation or Load will fail if you do
not remove the time stamp portion (in this case “22:10:52”).

Before we delve into several detailed examples using Load Data, we will first take a look at new
functionality, pre-existing functionality, considerations when adding new records vs. updating
existing records, as well as additional considerations.
Considerations: Inserting New Records
Before attempting to insert new records into the database using Load Data, it is necessary to be
aware of several items and also familiarize yourself with the specific Load Data module you are
using. In order to insert new records with Load Data, consider the following:
• Have you verified that ALL of the required fields are included in your Excel file?
• Are there records in your file that rely upon pre-existing values in the Space hierarchy or
Lookup tables?
• Where applicable, have you specified the appropriate percentages?
• If using one of the updated Load Data Modules (Space List, Org Assignment, Use
Assignment, Function Assignment) are you aware of how the new features work?
o What are the special cases with respect to the Space List?
o How are the Org, Use, and Function Assignment Load Data modules used now
that split assignments can be accommodated?
Note: The answers to these questions will become clear when you proceed to the
following sections that deal specifically with the Space List, Organization
Assignment, Use Assignment, Function Assignment, and other Load Data modules
(with pre-existing functionality).

Considerations: Updating Existing Records
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The operation of “updating existing records” has considerations similar to those mentioned in
the previous section. Here is a look at each:
• Have you verified that ALL of the unique fields (the fields required to uniquely identify a
record for update) are present?
• Are you using the appropriate module to perform the updates? (For example, you
would not use the Space List to update split Org Assignments, instead you would use the
Org Assignment Load Data module.)
• Where applicable, have you verified that percentage information is correct?
• Have you specified valid values for any Lookup fields (if applicable)?
Considerations: Guarding Against Data Loss
With this release there have been a number of enhancements to guard against data loss (in
both the Export operation and the Load Data Operation). Subsequent releases will continue to
incorporate changes in support of this goal. At present there are several scenarios to keep in
mind when exporting, updating, and eventually importing (via Load Data) data in relation to the
INSITE database.
Replete with many Net-FM modules are additional text or code fields that may be customized
by your institution. There are several important considerations with respect to these fields in
particular depending upon the types of data they contain. See below:
•

•

Do records in the respective text or code fields contain leading zeros?
o If so, these zeros may be lost during export/import due to data type
translation errors. At present there is a method to guard against this loss
upon data import (Load Data). Precede the field with a single apostrophe (‘)
in the Excel file and it will automatically be treated as text in the load
operation.
o The INSITE development team is presently working to address the issue as it
pertains to the data export (Export to Excel).
Are there records that contain alpha-numeric data?
o If you are exporting data or using one of the Load Data modules that has not
received enhancements, there is potential for loss of data.
o INSITE has created a detailed FAQ on the Support Site to provide more
information on this issue and potential remedies. Paste the following link in
your browser after you have logged into the Support Site (support.insite.org):
http://support.insite.org/support/faqview.asp?QID=102

Load Data: Layout and Functionality

Each Load Data screen consists of four sections – each section having its own functionality
(match the section letter with the corresponding letter on the diagram to see where each
resides on the page).
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A. Column List – The columns that appear here should also appear in your Excel sheet, and
the order should match. You may choose to reorder your Excel sheet or utilize the Load
Data Custom Settings (in section B) to make the necessary changes.
B. Custom Settings, Instructions, NULL, etc. – A number of unrelated items are found
here:
a. The Custom Settings used to specify the columns and their respective order for
Load Data are in this section.
b. A link to a basic Load Data instruction page is also located here.
c. NULL checkbox – Allows you to replace database column values with NULL.
Exercise caution when using this feature. If the corresponding column
or columns on your Excel worksheet does/do not contain values, you
will be wiping out any existing database values when performing the
data load. This operation cannot be rolled back.

d. In addition, there are two dropdowns at the bottom of the section on the left
and right. These dropdowns control how many lines at the top/bottom of the
Excel file will be ignored in the load.
C. Number / Code Checkboxes – These checkboxes allow you to use numbers/codes for
the indicated fields in your Excel file. For example, you may want to use the “Person
Number” in lieu of the Person Name. The checkboxes may not appear on all Load Data
modules. Additionally, there may be warning text that provides helpful considerations.
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D. File Selection / Display – The Choose File button opens a Windows File Explorer so that
you may locate and select the desired Excel file. The checkboxes and dropdowns
described in the previous sections should be selected (if the corresponding option is
desired) prior to clicking the Choose File button. The Display Excel File Contents button
will open the Preview Validation screen.

Load Data: Preview Validation
The Preview Validation screen has been updated with this release for the following modules:
Space List, Org Assignment, Use Assignment, and Function Assignment. The Preview Validation
screen serves the following purposes:
•

Worksheet Selection – In the event that your Excel file contains multiple worksheets, a
Select Sheet dropdown appears so that you may select the appropriate worksheet.

•

Validate All Records – By selecting this radio button, comprehensive validation will
occur on ALL records when you click the Preview Validation button. Aside from the
basic validation checks, additional checks will run based upon the module you are using
(please refer to the respective Load Data module in the following sections for a full
detail of these checks).

•

Validate First nn Records – Regardless of module, when this radio button is selected
and a positive integer value specified (representing the number of records you wish to
validate), basic validation checks will be performed. These checks include:
o Lengths and data types of all values are validated
o Any required Lookup fields are validated against existing values in the database
o If any Number or Code checkboxes (in section B) are checked, the corresponding
values will also go through validation

Illustration of a successful Preview Validation:

Illustration of a Preview Validation with errors:
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Accessing the Excel Error Log (1) and accessing individual record error (2):
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Load Data: Space List
When to use it:
•

Perform Initial Load – If you are performing the “initial load” of spaces for your
institution or you are bringing a new facility online, Load Data is an efficient, effective
way to add space information to the INSITE database.

•

Add New Spaces* – Use Load Data to add new space records to the INSITE database.
There are some caveats surrounding Use/Org percentages, and we will discuss in detail.

•

Update Existing Spaces* – Quickly and easily update existing space information using
Load Data on the Space List. There are some exceptions to using this and they will be
noted under “When NOT to use it”.
* Load Data is intelligent enough that you may have new space records and records
needing update in the same Excel worksheet.

When NOT to use it:
• To update the following information for existing spaces the Organization Assignment or
Use Assignment modules should be used instead:
o Use / Use Percent
o Subuse / Subuse Percent
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o Organization / Organization Percent
o Responsible Person (use the Organization Assignment module)
Note: When performing the initial load of space data or simply adding new spaces,
Use (Use/subuse) Percentages and Organization Percentages must be 100% (single
assignments). As indicated above, both Use/Subuse and Organization information
may be updated using the Use Assignment and Organization Assignment Load Data
modules. Your Net-FM Administrator may decide that it is a good idea to set up a
“dummy” Use, Subuse, and Organization of “Initial Load”. This will make it easy to
identify the records needing update for multiple Use, Org assignments later.

Space List Preview Validation
Validate First nn Records – When selected the following validations occur on the Space List:
•

Lengths and data types of all values are validated

•

For required Lookup fields (i.e. Facility, Floor, Use, Subuse, Organization) a validation
error will appear for any value not found in the database.

•

If the Person Number, Organization Number, or Use Code checkbox is checked, a
validation error will appear if the expected value is not found in the database.

Validate All Records – When selected, validation is comprehensive and includes additional
checks:
•

Duplicate Test – If the combination of Facility, Floor, and Room appears more than once
in the Excel file, only the first occurrence will pass validation. A “Duplicate Test failed”
error message will appear for the remaining occurrences.

•

100% Use Validation for New Spaces Test – If the combination of Facility, Floor, and
Room for a given Excel row does not exist in the database, the Use Percentage for the
record will only pass validation if it equals 100%. Otherwise, a “100 Pct Use Validation
for new spaces failed” error message will appear.

•

100% Org Validation for New Spaces Test – If the combination of Facility, Floor, and
Room for a given Excel row does not exist in the database, the Org Percentage for the
record will only pass validation if it equals 100%. Otherwise, a “100 Pct Org Validation
for new spaces failed” error message will appear.

•

Assignability Mismatch for Spaces Test – If the assignability of the Use (based upon the
assignability of the Major Use) and the Assignability of the Organization for any row in
the Excel file do not match, an “Assignability Mismatch for Spaces failed” error message
will appear for the respective row. Please note that this test will only be performed if
the Net-FM Administrator has set the following setting to “YES”: Assignability Settings
for Orgs and Uses assigned to a Space must match.
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Productivity Tip: For large lists, the recommended validation method
is “Validate First nn Records”. If you use “Validate All Records” on a
large list (500 or more records), the comprehensive validation will
take time to complete.

Space List Load Data
The following cases are handled by the Space List Load Data module:
1. Insert New Spaces – For all rows in the Excel file with valid Facility/Floor combinations
having Room Numbers which do not yet exist in the database, new Space records will be
inserted into the database.
a. Insert Org Assignments for New Spaces – For all new spaces inserted in Step (1),
an Organization with a corresponding Org Pct of 100 will be inserted into the
Organization Assignment table. Additionally, if a Responsible Person is specified,
it too will be added with the record.
b. Insert Use Assignments for New Spaces (non Subuse DB) – For all new spaces
inserted in Step (1), a Use with a corresponding Use Pct of 100 will be inserted
into the Use Assignment table.
c. Insert Use/Subuse Assignments for New Spaces (Subuse DB) – For all new spaces
inserted in Step (1), a new Use/Subuse pair with a corresponding Subuse Pct of
100 will be inserted into the Use and Subuse Assignment tables (Use is stored in
Use Assignment table, Subuse and corresponding Use ID are stored in the
Subuse Assignment table).
2. Update Existing Spaces – For all rows in the Excel file with a Facility, Floor, and Room
combination that exists in the database, the respective fields in the Excel file will be
updated with the exception of the following: Use, Use Pct, Subuse, Organization, Org
Pct, and Responsible Person.

Load Data: Organization Assignment
When to use it:
•

Update Org Assignments for Existing Spaces – Quickly and easily update Organization
Assignments for existing spaces. The following cases can be accommodated by this
module:
o Single Org Assignment Change
o Single Org Assignment  Multiple Org Assignment
o Multiple Org Assignment  Single Org Assignment

•

Update Responsible Person – Responsible Person assignments may be updated using
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this module.
When NOT to use it:
•

Initial Org Assignments for New Spaces – These assignments are made using the Space
List (as mentioned in the previous section).

Organization Assignment Preview Validation
Validate First nn Records – When selected the following validations occur for the Org
Assignment Load Data module:
•

Lengths and data types of all values are validated

•

For required Lookup fields (i.e. Facility, Floor, Room, Organization) a validation error will
appear for any value not found in the database.

Validate All Records – When selected, validation is comprehensive and includes additional
checks:
•

Duplicate Test – If the combination of Facility, Floor, Room, and Organization appears
more than once in the Excel file, only the first occurrence will pass validation. A
“Duplicate Test failed” error message will appear for the remaining occurrences.

•

100% Validation Test – If the sum of Org Pct values for a given Facility/Floor/Room
combination does not equal 100%, a “100% Test failed” error message will display.

•

Assignability Mismatch Test – If the assignability of the Org Assignment in the Excel file
does not match the assignability of the space’s Use assignment (based upon the Major
Use category) a validation error message appears for ALL Org Assignments for the given
space. Please note that this test will only be performed if the Net-FM Administrator has
set the following setting to “YES”: Assignability Settings for Orgs and Uses assigned to
a Space must match.
Productivity Tip: For large lists, the recommended validation method
is “Validate First nn Records”. If you use “Validate All Records” on a
large list (500 or more records), the comprehensive validation will
take time to complete.

Organization Assignment Load Data
The following cases are handled by the Organization Assignment Load Data module:
1. Delete/Insert Org Assignments (Update) – Load Data for the Organization Assignment
module works by deleting existing Org Assignments and inserting new ones.
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Responsible Person Information – Given that the Org Assignment
“update” takes place as a deletion and then an insert, you MUST have
Responsible Person Information in your Excel File. If you do not include
the information for existing Responsible Persons, the current
information will be wiped out for the respective records.
2. Update Org Information for Occupancy and Function Assignments – If the Delete
Dependent Records checkbox is unchecked, the Occupancy and Function Assignments
for the respective record will be updated with the first available Org Assignment for the
space in the Excel file.
3. Delete Dependent Records – If the Delete Dependent Records checkbox is checked, any
existing Occupancy, Occupancy Extension, and Function Assignments for the
corresponding spaces in the Excel file will be deleted.

Load Data: Use Assignment (non-Subuse enabled DB)
When to use it:
•

Update Use Assignments for Existing Spaces – Quickly and easily update Use
Assignments for existing spaces. The following cases can be accommodated by this
module:
o Single Use Assignment Change
o Single Use Assignment  Multiple Use Assignment
o Multiple Use Assignment  Single Use Assignment

When NOT to use it:
•

Initial Use Assignments for New Spaces – These assignments are made using the Space
List (as mentioned in the Space List Load Data section).

Use Assignment Preview Validation
Validate First nn Records – When selected the following validations occur for the Use
Assignment Load Data module:
•

Lengths and data types of all values are validated

•

For required Lookup fields (i.e. Facility, Floor, Room, Use) a validation error will appear
for any value not found in the database.

Validate All Records – When selected, validation is comprehensive and includes additional
checks:
•

Duplicate Test – If the combination of Facility, Floor, Room, and Use appears more than
once in the Excel file, only the first occurrence will pass validation. A “Duplicate Test
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failed” error message will appear for the remaining occurrences.
•

100% Validation Test – If the sum of Use Pct values for a given Facility/Floor/Room
combination does not equal 100%, a “100% Test failed” error message will display.

•

Assignability Mismatch Test – If the assignability of the Use Assignment (based upon the
corresponding Major Use) in the Excel file does not match the assignability of the
space’s Org assignment a validation error message appears for ALL Use Assignments for
the given space. Please note that this test will only be performed if the Net-FM
Administrator has set the following setting to “YES”: Assignability Settings for Orgs and
Uses assigned to a Space must match.
Productivity Tip: For large lists, the recommended validation method
is “Validate First nn Records”. If you use “Validate All Records” on a
large list (500 or more records), the comprehensive validation will
take time to complete.

Use Assignment Load Data
The following cases are handled by the Use Assignment Load Data module:
1. Delete/Insert Use Assignments (Update) – Load Data for the Use Assignment module
works by deleting existing Use Assignments and inserting new ones.
a. Single Use Assignment change – The existing Use Assignment will be deleted and
replaced with the new one from the Excel file. The Use Pct will equal 100%.
b. Single Use Assignment to Multiple Use Assignment – In this case a single Use
Assignment will be deleted and replaced with Multiple Use Assignments
specified in the Excel file. The total Use Pct for the records belonging to the
same Facility/Floor/Room combination MUST add to 100%, otherwise the
update will fail.
c. Multiple Use Assignment to Single Use Assignment – In this case the Multiple
Use Assignments will be deleted and replaced with the Single Use Assignment
found in the Excel file for the corresponding Space.

Load Data: Use Assignment (Subuse enabled DB)
When to use it:
•

Update Use/Subuse Assignments for Existing Spaces – Quickly and easily update
Use/Subuse Assignments for existing spaces. The following cases can be accommodated
by this module:
o Single Use/Subuse Assignment Change
o Single Use/Subuse Assignment  Multiple Use/Subuse Assignments
o Multiple Use/Subuse Assignments  Single Use/Subuse Assignment
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When NOT to use it:
•

Initial Use/Subuse Assignments for New Spaces – These assignments are made using
the Space List (as mentioned in the Space List Load Data section).

Use/Subuse Assignment Preview Validation
Validate First nn Records – When selected the following validations occur for the Use
Assignment Load Data module:
•

Lengths and data types of all values are validated

•

For required Lookup fields (i.e. Facility, Floor, Room, Use, Subuse) a validation error will
appear for any value not found in the database.

Validate All Records – When selected, validation is comprehensive and includes additional
checks:
•

Duplicate Test – If the combination of Facility, Floor, Room, and Use/Subuse pair
appears more than once in the Excel file, only the first occurrence will pass validation. A
“Duplicate Test failed” error message will appear for the remaining occurrences.

•

100% Validation Test – If the sum of Subuse Pct values for a given Facility/Floor/Room
combination does not equal 100%, a “100% Test failed” error message will display.

•

Assignability Mismatch Test – If the assignability of the Use Assignment (based upon the
corresponding Major Use) in the Excel file does not match the assignability of the
space’s Org assignment a validation error message appears for ALL Use Assignments for
the given space. Please note that this test will only be performed if the Net-FM
Administrator has set the following setting to “YES”: Assignability Settings for Orgs and
Uses assigned to a Space must match.
Productivity Tip: For large lists, the recommended validation method
is “Validate First nn Records”. If you use “Validate All Records” on a
large list (500 or more records), the comprehensive validation will
take time to complete.

Use Assignment Load Data
The following cases are handled by the Use Assignment Load Data module:
1. Delete/Insert Use/Subuse Assignments (Update) – Load Data for the Use Assignment
module works by deleting existing Use/Subuse Assignments and inserting new ones.
a. Single Use/Subuse Assignment change – The existing Use/Subuse Assignment
will be deleted and replaced with the new one from the Excel file. The Subuse
Pct will equal 100%.
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b. Single Use/Subuse Assignment to Multiple Use Assignments – In this case a
single Use/Subuse Assignment will be deleted and replaced with Multiple
Use/Subuse Assignments specified in the Excel file. The total Subuse Pct for the
records belonging to the same Facility/Floor/Room combination MUST add to
100%, otherwise the update will fail.
c. Multiple Use/Subuse Assignments to Single Use/Subuse Assignment – In this
case the Multiple Use/Subuse Assignments will be deleted and replaced with the
Single Use/Subuse Assignment found in the Excel file for the corresponding
Space.

Load Data: Function Assignment
When to use it:
•

Initial/New Function Assignments – Quickly and easily assign one or more Functions to
a space with corresponding Function Assignment percentages.

•

Update Existing Function Assignments – Update the Function Assignments for existing
spaces.

When NOT to use it:
•

New Spaces not yet in the database – In order to create Function Assignments using the
Function Assignment Load Data module, spaces must already exist in the database. Add
the spaces first with Space List Load Data, then you will be able to use this module.

•

Existing Spaces without corresponding Org Assignment – Any and all Org Assignments
specified in your Excel file, must first exist in the database before you may load the
Function Assignments. If it is necessary to add/modify Org Assignments use either the
Space List or Org Assignment Load Data modules as appropriate.

Function Assignment Preview Validation
Validate First nn Records – When selected the following validations occur for the Function
Assignment Load Data module:
•

Lengths and data types of all values are validated

•

For required Lookup fields (i.e. Facility, Floor, Room, Use, Subuse) a validation error will
appear for any value not found in the database.

Validate All Records – When selected, validation is comprehensive and includes additional
checks:
•

Duplicate Test – If the combination of Facility, Floor, Room, Organization, and Function
appears more than once in the Excel file, only the first occurrence will pass validation. A
“Duplicate Test failed” error message will appear for the remaining occurrences.
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•

100% Validation Test – If the sum of Function Pct values for a given
Facility/Floor/Room/Organization combination does not equal 100%, a “100% Test
failed” error message will display.

•

Dependent Org Assignment Test – If the combination of
Facility/Floor/Room/Organization does not yet exist in the Org Assignment table, a
“Dependent Org Assignment Test” validation error will appear for the corresponding
record in the Excel file.
Productivity Tip: For large lists, the recommended validation method
is “Validate First nn Records”. If you use “Validate All Records” on a
large list (500 or more records), the comprehensive validation will
take time to complete.

Function Assignment Load Data
The following cases are handled by the Function Assignment Load Data module:
1. Delete/Insert Function Assignments (Update) – For the Organizations specified in the
Excel file, the any Functions not present in the Excel file will be deleted and new ones (if
any) inserted.
2. Initial/New Function Assignments – Provided that the Organization specified in the Excel
file serves as an existing Org Assignment for the Space, new Function Assignments will
be added.

Load Data: All Other Modules
Outside of the Load Data modules mentioned above, the rest of the Load Data modules and
their functionality remain unchanged. These Load Data modules share the following
characteristics:
•

Supported Excel file format: .xls – For each of these modules, only the .xls format is
supported. Attempts to use .xlsx or any other format will result in an error.

•

Preview Validation – Preview validation is basic and only analyzes the first 5 records.

Load Data: Example 1 – Insert New Spaces
In the following example we will use the Space List Load Data module to perform the initial load
of spaces for Facility “OFMS”, Floor “3”. The Excel File purposely contains several errors to
illustrate situation you may encounter when using Load Data. The error messaging helps us to
identify and remedy those errors, and eventually perform a successful data load.
The following screenshot shows a portion of data that will be used in the load. You may notice
that both the Organization and Use columns contain the value “INITIAL LOAD”. This is a dummy
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value that has been created to represent multiple Org or Use assignments. As we discussed
previously in the Space List Load Data section, this module can only accept 100% assignments
for Org and Use. By using the dummy value / place holder, we can easily go back, identify the
records, and use the Org or Use Assignment module to update.
Placeholders for multiple Org or Use Assignments:

Different methods to validate data in the Excel file:
Using Validate First 5 Records did not reveal any errors. The blue text outlined in red shows
the message “Validation Complete (Database not updated)”.

Conversely, using Validate All Records performed validation on ALL of the records in the Excel
worksheet, and several errors were discovered. One record contained an invalid Use
Percentage and another contained an invalid Org Percentage.
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A glimpse at the individual errors or the Error Log (pictured below) reveals the invalid Org and
Use percentages:

Performing the load:
In this case, we did not correct the erroneous records and proceeded with the load.
The following system alert displays before attempting the Data Load: “This will Insert/Update
records into the database. This action cannot be undone. Are you sure you want to do this?”
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After clicking OK, the load is attempted and the results returned. In this case 37 New Records
were inserted and 2 Records failed to load:

Load Data: Example 2 – Update Org Assignments
As a follow-up to the previous example, we will now update the Org Assignments for the
records where we used the INITIAL LOAD placeholder. Instead of creating an Excel file from
scratch, we performed an Advanced Query to obtain the desired data set. In this case, we
queried for the spaces in Facility “OFMS”, Floor “3”, with an Org Assignment of “INITIAL LOAD”.
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Edit the Export file – In this case additional Org Assignments were added by inserting rows. The
color shading (for illustration purposes) shows the groupings of Org Assignments by room.

From the Org Assignment Load Data module, the updated Org Assignment file is selected:
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We can see that the load was successful:

If we wish to verify our results, we can run an Advanced Query where:
•

Facility = OFMS Corporate HQ – OFMS

•

Floor = 3

•

Org Pct. < 100
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As you can see from the Query results below, our update was successful:
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Module Detail
The following sections present each of the Net-FM Modules in detail. After reviewing the
respective Modules, you will have a better understanding of how each functions and supports
your facilities management efforts.
The subsequent modules will be presented:
•

Space Management

•

Asset Management

•

Asset Reconciler

•

Asset Depreciation

•

Space Survey Management

•

Indirect Cost Recovery (ICR)

•

Grant / Project Tracking

•

Documents

•

Reports

•

Drawings
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Space Management
About Space Management
At the heart of Net-FM is the Space Management module, which stores, organizes, tracks and
reports on all space and facilities-related information. This diagram is a schematic of the Space
Management module that shows each module, table, supporting table, and the relationships
between the Space Management elements.

Page
164

Space Management Menu
The Space Management Menu or navigation tree is divided into
several modules:
Land – At the top-most level, space data is grouped into Regions.
Regions are further segmented into one or more Sites. The Land
module makes it possible to view space data from a
geographical/hierarchical standpoint.
Facility/Floor – Buildings and other structures and their related data
are maintained in the Facility/Floor module. Each building/structure
is further segmented according to its respective floors. Gross area is
tracked at both the facility and floor level.
Space - The Space module tracks all the detailed information about individual rooms in your
entire organization. It is the lowest level of facilities data and the core of the FM database.
Organization - The Organization module stores the information about organizational entities:
schools, divisions, departments, groups. These entities are arranged in hierarchical order to
accurately reflect lines of responsibility.
Use - The Use module stores the information about architectural room uses. Individual room
uses are grouped into major use categories, and further accumulated by Assignability. This
scheme reflects the most common method for classifying building space.
Space Sign – The Sign module allows you to track and manage the types of signs and content of
the signs for spaces.
Common - lookup codes, names, and addresses.
Individual users may or may not have access to the Space Management menus depending upon
their Users privileges.
Most often, when using different parts of the Space module, you will see the following tabs:
Query, Advanced Query, Results, Add, and Load Data.

Note: “Load Data” only appears if you have been granted access by the Administrator.
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Once you have a Results grid, if you choose a row to edit

, the Edit tab will appear.

In instances where there are Floor Plans available for viewing, you will notice the “Floor Plans”
tab.

Land
Region
Atop the geographical hierarchy of space data sits the Region. Although the
full implementation of Region is optional, systematically you must create at least one default
Region before you are able to create Facilities.
The INSITE database affords the flexibility for you to define a “Region” from a global or local
perspective. For example, if your institution has a presence in the United States and Asia, you
may decide that it is necessary to create two regions: North America and Asia. If your
institutional footprint spans one particular country and you do not anticipate international
growth, you may elect to implement Region by adopting various regional categorizations of the
U.S.  West, Southwest, Midwest, Southeast, Mid-Atlantic, Northeast.

The following map shows an additional example. You can see that Australia is divided into the
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following regions or territories: Western Australia, Northern Territory, South Australia,
Queensland, New South Wales, Australian Capital Territory, Victoria, and Tasmania.

For information on documents in Region, consult the Documents section or click here.
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Site
Akin to the concept of Regions in the INSITE database,
Sites are a more granular way to segment space data in a
geographical hierarchy. The flexible design of the Site
module accommodates varied implementations.
Regardless of whether or not you decide to fully implement
the use of Sites, at a minimum you are required to
create at least one Site before you
are able to create Facilities. A Site
must be associated with a Region.
West
Campus

To best illustrate the use of Sites,
let us take a look at the following.
You may decide that it makes the most
sense to equate Sites with Campuses. In which case,
your institution has the following “Sites”: Main/Central
Campus, North Campus, East Campus, South Campus, and
West Campus.

North
Campus

Main Campus

East
Campus

South
Campus

For information on documents in Site, consult the Documents section or click here.
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Facility/Floor
The Facility/Floor module tracks information about facilities
(buildings or other structures). A wealth of information for each
facility may be maintained in the respective tables for this module.
This module makes it easy to track and report on information about
an entire building.
Facility List
The Facility List by its very nature plays an integral role in Space and Facilities management and
planning. The Facility table contains a number of important fields that help further
classify/categorize/analyze each facility; here is a selected list with examples in parentheses:
• Name
• ID
• Type (Athletic Facility, Building, Parking Lot, etc.)
• Category
• Ownership (Leased/Rented, Owned – Fee Simple, Title – Institutional) 5
• Primary Use (Administration, Mixed, Residential, Storage, Instruction)
• Condition
• Construction Date
• Acquisition Date
• Custom fields (as with most modules in Net-FM, there are a number of custom text, code,
and date fields that you may use to capture additional information about each facility).
Initially, the following tabs are available on the Facility List: Query, Advanced Query, Results,
Floor Plans, Add, and Load Data.

Once you have run a Query and obtained results, select a row to edit
and the following
additional tabs will appear: Edit, Floor, Feature, Cost, Address, Contact and Documents.

*The Facility table tracks information about entire structures. A Facility may be a building
(enclosed structure) or a surface lot (unenclosed structure), stadium, etc.

For more information on Building Ownership Status and the related categories refer to p. 107 of the
“Postsecondary Education Facilities Inventory and Classification Manual (FICM): 2006 Edition”
5
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A word on the “Active Field” in Facility List and Floor List
•

There is a field called ACTIVE (Yes/No field) in both Facility and Floor tables. By default,
all facility and floor active fields will have a value of YES. Using this field, one can set any
facility/floor to be “inactive” (Active = No) if such records need to be retained in the
system for any reason, without having to delete them.

•

Using a system setting (Administration | Settings | Space | Active Facility Floor) this
feature can be turned on or off. If it is turned ON, "Show Only Active Facilities and
Floors", then by default only active facilities and floors are retrieved in any part of Net-

FM. Otherwise if OFF "Show All Facilities and Floors" will ignore the Active field. (Net-FM
reports do not use this feature yet).

A word on the “Include in Statistics” Field in Facility List and Floor List
•
•

•
•

In response to a Consortium Member need, the INSITE team introduced the “Include in
Statistics” flag for the Facility and Floor lists.
If the flag is set to “NO” for a given Facility or Floor, the respective gross area will not be
included in the calculation for your organization’s portfolio. The floor plans for the respective
Facility or Floor are still available from Net-FM, however.
If the flag is set to “YES”, the Facility or Floor’s gross area is included in the total calculation.
When adding new records the default is ‘Y’ (YES).
Why use this setting? – There may exist cases where a given Facility or Floor is not part of the
institution’s space portfolio but it is necessary for floor plans to be available from Net-FM (i.e.
for Public Safety access, etc.). With previous releases of Net-FM you could set the “Active” flag
to “NO”, but then the Facility or Floor would no longer be available from a Net-FM floor plan
perspective. This setting helps accommodate for these special cases.

Latitude & Longitude fields in the SA_FACILITY table:
By Consortium Member request and a need to integrate with third-party reporting, Google
Maps, and GIS applications, we have added two new fields to the SA_FACILITY table:
1. Latitude
2. Longitude
Each field has a precision (total number of digits) of 20 and a scale (number of digits to the right
of the decimal point) of 15:

SA_FACILITY Table structure (new/updated fields highlighted in Green):
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SA_FACILITY

COLUMN_NAME
FACILITY_ID
ENTERED_DATE
ENTERED_BY
UPDATED_DATE
UPDATED_BY
FACILITY
FACILITY_NAME
SITE_ID
FACILITY_TYPE
FACILITY_CATEGORY
FACILITY_AREA
FACILITY_STATUS
COMPONENT_OF_FACILITY_ID
FACILITY_OCCUPANCY_CLASS
FACILITY_OWNERSHIP
FACILITY_PRIMARY_USE
FACILITY_CONDITION
FACILITY_CONSTRUCTION_DATE
FACILITY_ACQUISITION_DATE
FACILITY_OCCUPANCY_DATE
FACILITY_ARCHITECT
FACILITY_CONTRACTOR
FACILITY_CONSTRUCTION_TYPE
FACILITY_CONSTRUCTION_COST
FACILITY_REPLACEMENT_COST
FACILITY_CAPACITY
FACILITY_HEIGHT
FACILITY_ROOF_AREA
FACILITY_NAMED_FOR
FACILITY_DRAWING
FACILITY_CODE1
FACILITY_CODE2
FACILITY_CODE3
FACILITY_CODE4
FACILITY_CODE5
FACILITY_TEXT1
FACILITY_TEXT2
FACILITY_TEXT3
FACILITY_TEXT4
FACILITY_TEXT5

DATA_TYPE
NUMBER(10,0)
DATE
VARCHAR2(24 BYTE)
DATE
VARCHAR2(24 BYTE)
VARCHAR2(12 BYTE)
VARCHAR2(128 BYTE)
NUMBER(10,0)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
NUMBER(16,6)
VARCHAR2(32 BYTE)
NUMBER(10,0)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
DATE
DATE
DATE
VARCHAR2(64 BYTE)
VARCHAR2(64 BYTE)
VARCHAR2(64 BYTE)
NUMBER(12,3)
NUMBER(12,3)
NUMBER(8,2)
NUMBER(8,2)
NUMBER(16,6)
VARCHAR2(64 BYTE)
VARCHAR2(255 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
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NULLABLE
No
No
No
No
No
No
No
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

DATA_DEFAULT

FACILITY_NUMBER1
FACILITY_NUMBER2
FACILITY_NUMBER3
FACILITY_NUMBER4
FACILITY_NUMBER5
FACILITY_DATE1
FACILITY_DATE2
FACILITY_DATE3
FACILITY_DATE4
FACILITY_DATE5
FACILITY_MEMO
FACILITY_REMARKS
FACILITY_URL
DOMAIN
NETFM_DRAWING
ACTIVE
FACILITY_TEXT6
FACILITY_TEXT7
FACILITY_TEXT8
FACILITY_TEXT9
FACILITY_TEXT10
FACILITY_TEXT11
FACILITY_TEXT12
FACILITY_TEXT13
FACILITY_TEXT14
FACILITY_TEXT15
FACILITY_NUMBER6
FACILITY_NUMBER7
FACILITY_NUMBER8
FACILITY_NUMBER9
FACILITY_NUMBER10
FACILITY_NUMBER11
FACILITY_NUMBER12
FACILITY_NUMBER13
FACILITY_NUMBER14
FACILITY_NUMBER15
FACILITY_YESNO1
FACILITY_YESNO2
INCLUDE_IN_STATISTICS
LATITUDE
LONGITUDE

NUMBER(8,2)
NUMBER(8,2)
NUMBER(8,2)
NUMBER(12,3)
NUMBER(12,3)
DATE
DATE
DATE
DATE
DATE
VARCHAR2(255 BYTE)
VARCHAR2(2000 BYTE)
VARCHAR2(255 BYTE)
VARCHAR2(8 BYTE)
VARCHAR2(255 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
NUMBER(12,3)
NUMBER(12,3)
NUMBER(12,3)
NUMBER(12,3)
NUMBER(12,3)
NUMBER(18,6)
NUMBER(18,6)
NUMBER(18,6)
NUMBER(18,6)
NUMBER(18,6)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
NUMBER(20,15)
NUMBER(20,15)
Page
172

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

'Y'

‘Y’

For information on documents in the Facility List, consult the Documents section or
click here.

Floor List
The Floor List contains basic, but nonetheless important information about the floors within each
facility. The following list highlights some of the key fields (with additional information in parentheses):
• Facility
• Floor (i.e. B1, 01, 02, etc.)
• Gross Area
• Floor Sort Sequence (i.e. 1, 2, 3, 4, etc. This controls the order in which floors appear on
dropdowns. The lower the number is the higher the floor’s position in the dropdown.
• Audit Date
• Auditor
• Active (concept mentioned in previous section)
• Include in Statistics (concept mentioned in previous section)
• Drawing Needs Reconciliation (Flag set to 'Y' when use assignment, org assignment, doortag,
or room number is changed. This enhancement helps better identify which drawings need
reconciliation in the Drawing module.)

After using Query or Advanced Query, from the Space | Facility (Floor) data grid, you have the
option to use the:
• checkbox to select one or more rows of data
• Edit icon to update a floor record; the Edit tab will open allowing you to change the
Floor and other related data.
• Duplicate icon to copy a floor record, this is a handy way of "adding" multiple new floor
records – just change the floor number and other relevant data and then click the 'Add
Record' button.
• Drill Up icon to navigate up one level to the Facility List.
• Floor Plan icon, if available, to open a new window and view a floor plan. (If a floor plan
is not available, the icon will not be displayed.)
• "Q" (Query) icon, if available, to open the Query Floor Plan tab.
• Document icon, if available, to open a new tab and view associated documents.
Once the Floor data is entered and you Update Record, you can then click back on the Results
tab and select another data grid row, i.e., another Floor to edit.
Floor List - Floor Plans
One of the most frequently accessed components of the Floor List is Floor Plans. There are a number of
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ways to access floor plans from the Floor List – see below for further details:

Space Management | Facility/Floor | Floor List | Space - Floor (Results) may have a
floor plan icon.
Space Management | Facility/Floor | Floor List | Space - Floor (Results) | Q (Query)
may have the Query Floor Plan tab.
(Requires valid subscription.)
If a floor plan is available:
• The "Floor Plan" link will be displayed. This link, if clicked, will open a new window and
display the floor plan.
• The "Q" (Query icon) for the "Query Floor Plan" tab will be available (requires valid
subscription). This tab allows you to perform a Query for Room, Organization, Use, Door
Tag, Blocks, Text, Area, and one other 'Additional Field'. To use this query, first click the
particular checkbox for the topic of interest. Then, click to select the listed items as
desired. When finished selecting, click the Get Results button to generate and display
the highlighted drawing.
Note: If a floor plan is available for a particular floor, the Floor Plan icon and the "Q" (Query
icon) will appear in the data grid. If a floor plan is not available, the icons will not appear.
Clicking on the icon or link will open a new PDF control window to display the floor plan.
All Floor List floor plans displayed from the Results tab will display the floor plan without the
legend and Gross Area Summary query, by default (per CM request). In order to view the
legend and Gross Area Summary highlight, uncheck the “Hide Legend” checkbox and click the
“Redraw Floor Plan” button.
Floor plans are also available from Space Management | Space | Space List | Query. If a floor
plan is available, a Floor Plan icon will appear next to the respective records in the Data Grid.
Click on the icon to generate and open the PDF drawing. When drawings are displayed in this
manner, the corresponding Space will be highlighted.
Note: The PC you are using must have a PDF reader installed to display the PDF floor plan file.

SA_FLOOR Table structure (new/updated fields highlighted in Green):

SA_FLOOR
COLUMN_NAME
FLOOR_ID
ENTERED_DATE
ENTERED_BY

DATA_TYPE
NUMBER(10,0)
DATE
VARCHAR2(24 BYTE)
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NULLABLE DATA_DEFAULT
No
No
No

UPDATED_DATE
UPDATED_BY
FACILITY_ID
FLOOR
FLOOR_GROSS_AREA
FLOOR_AUDIT_DATE
FLOOR_AUDITOR
FLOOR_SORT_SEQUENCE
FLOOR_DRAWING
FLOOR_CODE1
FLOOR_CODE2
FLOOR_TEXT1
FLOOR_TEXT2
FLOOR_NUMBER1
FLOOR_NUMBER2
FLOOR_DATE1
FLOOR_DATE2
FLOOR_MEMO
FLOOR_URL
NETFM_DRAWING
ACTIVE
FLOOR_YESNO1
FLOOR_YESNO2
INCLUDE_IN_STATISTICS
DRAWING_NEEDS_RECONCILIATION

DATE
VARCHAR2(24 BYTE)
NUMBER(10,0)
VARCHAR2(4 BYTE)
NUMBER(16,6)
DATE
VARCHAR2(4 BYTE)
NUMBER(4,0)
VARCHAR2(255 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
NUMBER(8,2)
NUMBER(8,2)
DATE
DATE
VARCHAR2(255 BYTE)
VARCHAR2(255 BYTE)
VARCHAR2(255 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)

No
No
No
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
No
Yes
Yes
Yes
Yes

'Y'

‘Y’

For information on documents in the Floor List, consult the Documents section or
click here.

Facility - Contact
Facility Contact allows you to assign and maintain information for one or more “contacts” for
each facility. The Facility Contact module consists of the following fields:
• Facility
• Contact
• Contact Type
How and if you choose to implement the concept of a Facility Contact is up to you or your NetPage
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FM Administrator. One example could be if you wanted to designate a specific person or
person(s) as “security” contact(s). You would first have to create “security” as a “contact type”
lookup (if it did not already exist). You would then be able to add one or more people as
Facility Contacts, and specify “security” as the type.
SA_FACILITY_CONTACT Table structure (new/updated fields highlighted in Green):

SA_FACILITY_CONTACT
COLUMN_NAME
FACILITY_ID
PERSON_ID
CONTACT_TYPE
ENTERED_DATE
ENTERED_BY
UPDATED_DATE
UPDATED_BY

DATA_TYPE
NUMBER(10,0)
NUMBER(10,0)
VARCHAR2(32 BYTE)
DATE
VARCHAR2(24 BYTE)
DATE
VARCHAR2(24 BYTE)

NULLABLE
No
No
No
No
No
No
No

DATA_DEFAULT

Facility - Cost
Facility Cost allows you to capture and query various sets of data surrounding facility costs for
given cost types. Prior to adding a facility cost, you want to ensure the appropriate “Cost Type”
lookup exists first. Navigate to Space Management | Common | Cost Type and click on the
Add tab to add a new cost type.
Examples of cost types include the following:
• Buildings & Grounds
• Building Repairs
• Building Depreciation
• Capital Improvements
• Insurance
• Mechanical Systems
• etc.
Note regarding Cost Categories: Although not required, it may make sense to group various Cost Types
according to a Cost Category. Some examples of categories include: Depreciation and Use Allowance,
Operations & Maintenance, Utilities, etc.

SA_FACILITY_COST Table structure (new/updated fields highlighted in Green):
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SA_FACILITY_COST
COLUMN_NAME
FACILITY_COST_ID
ENTERED_DATE
ENTERED_BY
UPDATED_DATE
UPDATED_BY
FACILITY_ID
COST_TYPE_ID
FACILITY_COST_DATE
FACILITY_COST_AMOUNT
FACILITY_COST_CODE1
FACILITY_COST_CODE2
FACILITY_COST_TEXT1
FACILITY_COST_TEXT2
FACILITY_COST_NUMBER1
FACILITY_COST_NUMBER2
FACILITY_COST_DATE1
FACILITY_COST_DATE2
FACILITY_COST_MEMO

DATA_TYPE
NUMBER(10,0)
DATE
VARCHAR2(24 BYTE)
DATE
VARCHAR2(24 BYTE)
NUMBER(10,0)
NUMBER(10,0)
DATE
NUMBER(12,3)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(16 BYTE)
VARCHAR2(16 BYTE)
NUMBER(8,2)
NUMBER(8,2)
DATE
DATE
VARCHAR2(255 BYTE)

NULLABLE
No
No
No
No
No
No
No
No
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

DATA_DEFAULT

Note: The Indirect Cost Recovery | Costs | Facility Cost feature is the same as the Space Management
| Facility | Facility Cost feature.

Facility - Feature
Facility Feature provides the ability to capture and query information regarding specific facility
features. A Facility Feature may be thought of as a characteristic that pertains to the entire
facility. For example, a residence hall may have a floor covering (FEATURE CATEGORY) of “wallto-wall” carpeting (FEATURE TYPE).
Before you are able to add a Facility Feature, you will want to ensure the appropriate “Feature
Category” and “Feature Type” exist. “Feature Type” may be specified by navigating to Space
Management | Common | Feature Type. “Feature Category”, on the other hand, may be
specified by navigating to Space Management | Common | Lookup where the Lookup Type
equals “FEATURE CATEGORY”. Query for the desired Feature Category; if it does not exist, use
the Add tab to add it.
SA_FACILITY_FEATURE Table structure (new/updated fields highlighted in Green):

SA_FACILITY_FEATURE
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COLUMN_NAME
FACILITY_FEATURE_ID
ENTERED_DATE
ENTERED_BY
UPDATED_DATE
UPDATED_BY
FACILITY_ID
FEATURE_TYPE_ID
FACILITY_FEATURE_NUMBER
FACILITY_FEATURE_DATE
FACILITY_FEATURE_COUNT
FACILITY_FEATURE_CODE1
FACILITY_FEATURE_CODE2
FACILITY_FEATURE_TEXT1
FACILITY_FEATURE_TEXT2
FACILITY_FEATURE_NUMBER1
FACILITY_FEATURE_NUMBER2
FACILITY_FEATURE_DATE1
FACILITY_FEATURE_DATE2
FACILITY_FEATURE_MEMO
FACILITY_FEATURE_URL
FACILITY_FEATURE_CODE3
FACILITY_FEATURE_CODE4
FACILITY_FEATURE_CODE5
FACILITY_FEATURE_CODE6
FACILITY_FEATURE_CODE7
FACILITY_FEATURE_CODE8
FACILITY_FEATURE_CODE9
FACILITY_FEATURE_CODE10
FACILITY_FEATURE_TEXT3
FACILITY_FEATURE_TEXT4
FACILITY_FEATURE_TEXT5
FACILITY_FEATURE_TEXT6
FACILITY_FEATURE_TEXT7
FACILITY_FEATURE_TEXT8
FACILITY_FEATURE_TEXT9
FACILITY_FEATURE_TEXT10
FACILITY_FEATURE_NUMBER3
FACILITY_FEATURE_NUMBER4
FACILITY_FEATURE_NUMBER5
FACILITY_FEATURE_NUMBER6
FACILITY_FEATURE_NUMBER7

DATA_TYPE
NUMBER(10,0)
DATE
VARCHAR2(24 BYTE)
DATE
VARCHAR2(24 BYTE)
NUMBER(10,0)
NUMBER(10,0)
VARCHAR2(16 BYTE)
DATE
NUMBER(4,0)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
NUMBER(8,2)
NUMBER(8,2)
DATE
DATE
VARCHAR2(255 BYTE)
VARCHAR2(255 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
NUMBER(12,2)
NUMBER(12,2)
NUMBER(12,2)
NUMBER(12,2)
NUMBER(12,2)
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NULLABLE
No
No
No
No
No
No
No
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

DATA_DEFAULT

FACILITY_FEATURE_NUMBER8
FACILITY_FEATURE_NUMBER9
FACILITY_FEATURE_NUMBER10

NUMBER(12,2)
NUMBER(12,2)
NUMBER(12,2)

Yes
Yes
Yes

When using Custom Settings with the Facility Feature, ensure that the Feature
Category field precedes the Feature Type field in the display sequence. The
Feature Type field is dependent upon the Feature Category field.
Facility - Type
Facility Type information is used to classify facilities by their “type” or purpose. The values
specified for Facility Type have a one-to-one relationship with the Facility table. This means
that per facility, there is ONE facility type that may be assigned.
Examples of Facility Types include the following:
• Buildings (enclosed structures)
• Surface parking lots
• Stadiums
• Outdoor athletic facilities
• etc.
If you wish to add a Facility Type, first use Query or Advanced Query to see if it exists. If the
value does not exist, use the Add tab to create the new Facility Type.
SA_FACILITY_TYPE Table structure (new/updated fields highlighted in Green):

SA_FACILITY_TYPE
COLUMN_NAME
FACILITY_TYPE
ENTERED_DATE
ENTERED_BY
UPDATED_DATE
UPDATED_BY
FACILITY_TYPE_NAME
FACILITY_AREA_UNIT
FACILITY_CAPACITY_UNIT
FACILITY_TYPE_MEMO

DATA_TYPE
VARCHAR2(8 BYTE)
DATE
VARCHAR2(24 BYTE)
DATE
VARCHAR2(24 BYTE)
VARCHAR2(24 BYTE)
VARCHAR2(16 BYTE)
VARCHAR2(16 BYTE)
VARCHAR2(255 BYTE)

Facility - Address
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NULLABLE
No
No
No
No
No
No
Yes
Yes
Yes

DATA_DEFAULT

Facility Address allows you to specify the Address and address Purpose for a facility.
SA_FACILITY_ADDRESS Table structure (new/updated fields highlighted in Green):

SA_FACILITY_ADDRESS
COLUMN_NAME
FACILITY_ID
ADDRESS_PURPOSE
ADDRESS_ID
ENTERED_DATE
ENTERED_BY
UPDATED_DATE
UPDATED_BY

DATA_TYPE
NUMBER(10,0)
VARCHAR2(8 BYTE)
NUMBER(10,0)
DATE
VARCHAR2(24 BYTE)
DATE
VARCHAR2(24 BYTE)
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NULLABLE
No
No
No
No
No
No
No

DATA_DEFAULT

Space
Space List
The Space module tracks all the detailed information about
individual rooms in your entire organization. It is the lowest level
of facilities data and the core of the FM database.
When using the Space List feature, you will see the following
tabs:
Query, Advanced Query, Results, Floor Plans, and Add.

Note: If the administrator has granted you access to "Load
Data", you will see the Load Data tab after the Add tab.

Once you have a Results grid, if you choose a row to edit
, the following additional tabs
will appear: Edit, Org Assignment, Use Assignment, Occupancy, Function Assignment, Contact,
PI*, Documents*, General*, General2*.

*The fields marked with an asterisk will only be available if enabled by the Administrator. The PI
tab will be available if the Administrator enables the capability of tracking multiple Principal
Investigators in a single space (see Administration | Settings | Space | Space PI). The General
and General2 tabs must also be enabled for viewing (see Administration | Settings | Space |
Space General / Space General2).
Note: If a Space has a single Organization or single Use assigned to it, you can
update that assignment in the Space/Edit tab itself, or in the respective Org
Assignment and Use Assignment tabs. If a space has multiple Organizations or
multiple Uses assigned to it, you must use the respective Org Assignment or Use
Assignment tabs.
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The Space List fields are captured in the V_NETFM_SPACE table.
The Space Code1 table defines the lookup in the Space table. Space Code2 through Space
Code5 tables are also available.
The Space Category table defines the lookup in the Space table.
The Occupant_Count field automatically calculates the number of Occupants in a space. This
field can be manually overridden.
A set of user preferences, My Preferences, affects the way tabs appear in the Space Edit tab.
Your preferences can be set up for all the items that appear as Tabs in Space Edit mode to
appear on the same page (within frames underneath the Space record). Any of the following
tabs can be hidden or displayed – Org Assignment, Use Assignment, Occupancy, Function
Assignment, Contact, Documents, General1, General2, PI, and Grant.
Space & Asset List Tabs: Within the My Preferences tab, there is a section named "Space &
Asset List Tabs". Under “Space List Results” you can elect to display the Space Record OR the
Space Record and Dependants. Another section labeled "Hide Tabs in Space List Edit" allows
you to check individual Space List tabs that will be hidden.
When you have Space Record and Dependents set, you will notice a new icon in the Space Grid
resembling a stack of documents:
. By clicking on this icon, a new window will open with
additional space-related information pertaining to the record that is not found on the Space
Edit tab (i.e. full listing of Organizations and percentages, Occupants, etc.).
If you Edit a Space record, from the Space | Space (Edit) tab you have the option to use the
Floor Plan link, if available, to open a new window and view a floor plan. That floor plan will
automatically highlight the space that is being edited. (If a floor plan is not available, the link
will not be displayed.)
Percentages: In the Space Results tab, you can optionally view the Organization and Use field
values without percentages in parenthesis by checking the "Hide Percentages" checkbox.
Multiple Organizations and multiple Uses will have the values separated by commas as before
but without displaying the percentages for each. The Hide Percentage checkbox toggles the
display of the percentages which also carries through to the 'Print/Export' output. The toggle
setting lasts for the duration of the current session.
Alternatively, you may elect to control the Org and Use Percentage display through “My
Preferences”. Under General Preferences | Display Org and Use Percentages in Space List
Results Tab, simply click Yes or No.
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For information on documents in the Space List, consult the Documents section or
click here.

SA_SPACE Table structure (new/updated fields highlighted in Green):

SA_SPACE

COLUMN_NAME
SPACE_ID
ENTERED_DATE
ENTERED_BY
UPDATED_DATE
UPDATED_BY
FLOOR_ID
ROOM
USE_ID
SPACE_AREA
OWNER_ORGANIZATION_ID
SPACE_STATION_COUNT
SPACE_OCCUPANT_COUNT
SPACE_PRINCIPAL_INVESTIGATOR
DOMAIN
SPACE_CATEGORY
SPACE_AUDIT_DATE
SPACE_AUDITOR
SPACE_DRAWING
SPACE_ROOM_NAME
SPACE_CODE1
SPACE_CODE2
SPACE_CODE3
SPACE_CODE4
SPACE_CODE5
SPACE_TEXT1
SPACE_TEXT2
SPACE_TEXT3
SPACE_TEXT4
SPACE_TEXT5
SPACE_NUMBER1
SPACE_NUMBER2
SPACE_NUMBER3

DATA_TYPE
NUMBER(10,0)
DATE
VARCHAR2(24 BYTE)
DATE
VARCHAR2(24 BYTE)
NUMBER(10,0)
VARCHAR2(12 BYTE)
NUMBER(10,0)
NUMBER(16,6)
NUMBER(10,0)
NUMBER(4,0)
NUMBER(4,0)
NUMBER(10,0)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
DATE
VARCHAR2(4 BYTE)
VARCHAR2(64 BYTE)
VARCHAR2(64 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
NUMBER(8,2)
NUMBER(8,2)
NUMBER(8,2)
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NULLABLE
NO
NO
NO
NO
NO
NO
NO
YES
NO
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES

DATA_DEFAULT

SPACE_NUMBER4
SPACE_NUMBER5
SPACE_DATE1
SPACE_DATE2
SPACE_DATE3
SPACE_DATE4
SPACE_DATE5
SPACE_MEMO
SPACE_AREA2
SPACE_URL
NETFM_DRAWING
SPACE_REMARKS
SPACE_YESNO1
SPACE_YESNO2
SPACE_YESNO3
SPACE_YESNO4
SPACE_YESNO5
SURVEY_ROOM_COMMENTS
SURVEY_FUNCTION_COMMENTS
SURVEY_OCCUPANT_COMMENTS
SURVEY_GRANT_COMMENTS
SURVEY_PI_COMMENTS
SURVEY_SPACE_CONTACT_COMMENTS
SURVEY_SUPP_RM_COMMENTS
SPACE_CODE6
SPACE_CODE7
SPACE_CODE8
SPACE_CODE9
SPACE_CODE10
SPACE_TEXT6
SPACE_TEXT7
SPACE_TEXT8
SPACE_TEXT9
SPACE_TEXT10
SPACE_NUMBER6
SPACE_NUMBER7
SPACE_NUMBER8
SPACE_NUMBER9
SPACE_NUMBER10
SPACE_DATE6
SPACE_DATE7
SPACE_DATE8

NUMBER(12,3)
NUMBER(12,3)
DATE
DATE
DATE
DATE
DATE
VARCHAR2(255 BYTE)
NUMBER(16,6)
VARCHAR2(255 BYTE)
VARCHAR2(255 BYTE)
VARCHAR2(255 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1024 BYTE)
VARCHAR2(1024 BYTE)
VARCHAR2(1024 BYTE)
VARCHAR2(1024 BYTE)
VARCHAR2(1024 BYTE)
VARCHAR2(1024 BYTE)
VARCHAR2(1024 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(32 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
VARCHAR2(128 BYTE)
NUMBER(12,2)
NUMBER(12,2)
NUMBER(12,2)
NUMBER(12,2)
NUMBER(12,2)
DATE
DATE
DATE
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YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES

SPACE_DATE9
SPACE_DATE10
SPACE_YESNO6
SPACE_YESNO7
SPACE_YESNO8
SPACE_YESNO9
SPACE_YESNO10

DATE
DATE
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)
VARCHAR2(1 BYTE)

YES
YES
YES
YES
YES
YES
YES

Space List Features
Space - Org Assignment
The Org Assignment tab allows you to specify the Organization, Percentage, and Responsible
Person to a space from within the Space List feature. This is handy when querying spaces with
the intent on making changes or additions to the Organization Assignment field for each space.
First, run a Query; from the Results tab, select a row for edit. This action makes the Org
Assignment tab appear. Notice that the Results data grid row that you select is for a particular
facility, floor and room. When you click on the Org Assignment tab, a data grid for that
particular facility, floor, and room will appear with every Organization listed for that particular
space. If you then select one of the Org Assignment tab data rows for edit, the Edit Org
Assignment tab will open allowing you to change the Organization, the Percent, and the
Responsible Person. You cannot delete Org Assignment via a data grid row, you must edit the
record. You can have multiple Organizations per space.
An Organization is associated with Occupants, Functions Assignments, and possibly Grants
(depending on Admin | Settings | Grant Options). These associations are "dependent" records
with respect to the Organization. Traditionally, if you delete an Organization, you will
automatically delete ALL associations or dependent records - including: Occupants, Functions
Assignments, [and Responsible Person]. Now, by default, if you change an Organization, NetFM will retain all the associations (Occupants, Functions Assignments, [Responsible Person],
and possibly Grants). To delete the associations when changing an Organization, you must click
the checkbox “Delete dependent records”.

Once the Organization data is entered and you click Update Record, you can then click back on
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the Results tab and select another data grid row, i.e., another space to edit.
Note: You can change Organization assignments from the Results tab globally for a group of
records using the Replace Column function. This can be done for the selected records as long as
the Assignment percentage is 100 (multiple assigned Organizations will be skipped). Also, you
can change Organization assignments from the Edit tab for individual records using the dropdown list as long as the Assignment percentage is 100 (multiple assigned Organizations will be
inaccessible in this manner).
Space - Use Assignment
The Use Assignment tab allows you to specify Use assignments and Percentages for a space
from within the Space List feature. This is handy when querying spaces with the intent on
making changes or additions to the Use Assignment field for each space. First, run a Query;
from the Results tab, select a row for edit. This action makes the Use Assignment tab appear.
Notice that the Results data grid row that you select is for a particular facility, floor and room.
When you click on the Use Assignment tab, a data grid for that particular facility, floor, and
room will appear with every Use listed for that particular space. If you then select one of the
Use Assignment tab data rows for edit, the Edit Use Assignment tab will open allowing you to
change the Use(s) and Percentage(s). You cannot delete Use Assignment via a data grid row,
you must edit the record. You can have multiple Organizations per space.
Once you enter the Use data and click Update Record, you can then click back on the Results
tab and select another data grid row (i.e., another space) to edit.
Note: You can change Use assignments from the Results tab globally for a group of records
using the Replace Column function. This can be done for the selected records as long as the
Assignment percentage is 100% (multiple assigned Uses will be skipped). Also, you can change
Use assignments from the Edit tab for individual records using the drop-down list as long as the
Assignment percentage is 100% (multiple assigned Uses will be inaccessible in this manner).
Space - Occupancy
The Occupancy tab allows you to specify Occupants for a space from within the Space List
feature. This is handy when querying spaces with the intent on making changes or additions to
the Occupant field for each space. First, run a Query; from the Results tab, select a row for edit.
This action makes the Occupancy tab appear. Notice that the Results data grid row that you
select is for a particular facility, floor and room. When you click on the Occupancy tab, a data
grid for that particular facility, floor, and room will appear with every Occupant for each
different Organization listed for that particular space. If you then select one of the Occupancy
tab data rows for edit, the Edit Occupancy tab will open allowing you to change the Occupant
information and other related data. You cannot delete Occupants via a data grid row, you must
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edit the record. You can have multiple Occupants per space. The Edit Occupancy tab also
indicates the Use or Uses of the space.
Once you enter the Occupancy data and click Update Record, you can then click back on the
Results tab and select another data grid row, i.e., another space to edit.
If the space does not have an Occupant, you can click on the Add Record button on the bottom
of the Occupancy tab which will open the Edit Occupancy tab.
You can also add, change, delete Occupant information with the Occupancy feature (contained
within the Space module, but not within the Space List feature).
Space Occupancy: Apply Equal Percentages: A button “Apply Equal Percentages” in the
Add/Edit tabs enables the user to distribute the total percentage of Occupancy equally among
all Occupants present on the screen.
Space - Function Assignment
The Function Assignment tab allows you to specify Functions and Percentages for a space from
within the Space List feature. This is handy when querying spaces with the intent on making
changes or additions to the Function Assignment field for each space. First, run a Query; from
the Results tab, select a row for edit. This action makes the Function Assignment tab appear.
Notice that the Results data grid row that you select is for a particular facility, floor and room.
When you click on the Function Assignment tab, a data grid for that particular facility, floor, and
room will appear with every Function listed for that particular space. If you then select one of
the Function Assignment tab data rows for edit, the Edit Function Assignment tab will open
allowing you to change the Function(s) and Percentage(s). You cannot delete Function
Assignments via a data grid row, you must edit the record. You can have multiple Functions per
space.
Once you enter the Function data and click Update Record, you can then click back on the
Results tab and select another data grid row (i.e., another space) to edit.
You can also add, change, or delete the Function Assignment information with the Function
Assignment feature (contained within the Space module, but not within the Space List feature).
Space - Contact
The Contact tab allows you to specify Contacts for a space from within the Space List feature.
This is handy when querying spaces with the intent on making changes or additions to the
Contact field for each space. First, run a Query; from the Results tab, select a row for edit. This
action makes the Contact tab appear. Notice that the Results data grid row that you select is for
a particular facility, floor and room. When you click on the Contact tab, a data grid for that
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particular facility, floor, and room will appear with every Contact for each different space. If
you then select one of the Contact tab data rows for edit, the Edit Contact tab will open
allowing you to change the Contact.
You cannot delete Contacts via a data grid row, you must edit the record. You can have
multiple Contacts per space.
Once you enter the Contact data and click Update Record, you can then click back on the
Results tab and select another data grid row, i.e., another space to edit.
If the space does not have a Contact, you can click on the Add Record button on the bottom of
the Contact tab which will open the Edit Contact tab.
You can also add, change, or delete Contact information with the Space Contact feature
(contained within the Space module, but not within the Space List feature).
A Contact, unlike an Occupant, is not related to an Organization occupying the space. If you
change the Organization of a space - you will not change the Contact.
Space - PI
The Space PI or Principal Investigator feature enables the ability to record multiple PIs in a
single space. This feature is only available if the administrator set "Ability to specify Multiple
PIs" in Admin | Settings | Space | Space PI. Otherwise, the single Principal Investigator field on
the Space List is used.
In providing for multiple PIs, the single field within the Space List tab is turned off, and a Space
PI tab is enabled to record multiple PIs. The Space PI tab appears in Space (Edit). Space PI is
also available directly from Space Management | Space. Note: It is not advised that you keep
switching between the two settings; rather pick a setting that’s appropriate for your needs and
stay with it.
If using the Space PI tab, (V_SPACE_PI) the column name of the field is person_name (which is a
lookup from the person table). Only the following fields are required and unique: Facility, Floor,
Room, and Principal Investigator. The Space PI tab also has these additional fields: Percentage,
Grant Name, Organization, Text, Number, Code, Date, YesNo, and Memo.
The Space PI feature within Space is hidden by default; check the settings for User Visibility and
My Preferences for the Space PI feature.
Space - General
The Space General tab allows you to store data related to a Room with 6 different data types:
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Code, Date, Memo, Number, Text, YesNo (each with 10 fields, except Code which has 30 fields).
Settings are available to:
• make the Space General table available
• make the table appear as a Tab in Space/Edit
• make the table appear as a separate node under Space Management | Space
• establish a "name" for the Space General module (this is the name that will appear on
the Space List tab and in the navigation tree)
Two (2) Space General tabs are available: Space General 1 and Space General 2. Refer to
Administration | Settings | Space | Space General 1 (or Space General 2) tab.
The Space General tables are versatile and highly customizable, making them perfect for a
variety of needs. For example, some Consortium Members use these tables to store Asbestos
information as it relates to space, while others maintain Locks, Keys, and Combination
information related to space. Contact the INSITE Support Team at support@insite.org for more
information on how Space – General can be utilized by your organization.
For information on documents in Space General & Space General 2, consult the
Documents section or click here.

Space Contact
The Space Contact table stores information about the primary contacts or individuals
responsible for or associated with a space and is related to the person table. Details about the
people are stored in the related Person Table.
A Contact, unlike an Occupant, is not related to an Organization occupying the space. If you
change the Organization of a space - you will not change the Contact.
Space PI
The INSITE database has traditionally provided one field within the space table (Space List) to
record the PI or Principal Investigator of a space. In recognition of the need for Consortium
Members to record multiple PIs for a given space, INSITE expanded the system’s capabilities to
accommodate such a need.
By navigating to Admin | Settings | Space | Space PI, the administrator can set the Space
Principal Investigators value to "Ability to specify Multiple PIs" or "Only one PI allowed per
space", the default value. In providing for multiple PIs, the single field within the Space List tab
Page
189

is turned off, and a Space PI tab is enabled to record multiple PIs. The Space PI tab appears
when in Space (Edit). Space PI is also available directly from Space Management | Space as a
node on the navigation tree.
If using the Space List, (V_NETFM_SPACE) the column name of the field is
principal_investigator_name which is a lookup from the person table.
If using the Space PI tab, (V_SPACE_PI) the column name of the field is person_name which is a
lookup from the person table. The Space PI tab also has these additional fields: Percentage,
Grant Name, Organization, Text, Number, Code, Date, YesNo, and Memo. The total percentage
must equal 100%.
In Space Principal Investigator Query and Advanced Query tabs, selecting Facility and/or Floor
values narrows down the list of the Principal Investigator field values to only those PIs assigned
to the corresponding facility / floor.
In Space PI floor plans, the highlighting of rooms in floor plans is done using the Percentage
field in each record.
The Space PI dropdown (for databases where multiple PIs in use) has been optimized to
accommodate large record sets. The optimization and type-ahead search capability have been
implemented on the following browsers: Chrome, Firefox, Edge, and Safari.
Space Cost
The Space Cost table tracks history and information about user-defined costs that apply to
individual spaces. This table is related through the Space Management | Common | Cost Type
table to costs that can also be applied to facilities. Costs can be grouped into categories for
reporting and analysis purposes.
The Space Cost Code tables define the lookup in the Space Cost table.
Note: The Indirect Cost Recovery | Costs | Space Cost function is the same as the Space
Management | Space | Space Cost function.
Space Feature
The Space Feature table tracks information about user-defined features that apply to individual
spaces. This table is related through the Space Management | Common | Feature Type table
to features that can also be applied to facilities. Features can be grouped into categories for
reporting and analysis purposes.
The Space Feature Code tables define the lookups in the Space Feature table.
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For information on documents in the Space Feature, consult the Documents section
or click here.

When using Custom Settings with the Space Feature, ensure that the Feature
Category field precedes the Feature Type field in the display sequence. The Feature
Type field is dependent upon the Feature Category field.

Space Grant
A Grant (Project) can be associated with a space by using the Grant module or by using the
Space Grant feature from within the Space module.
When you start using the Space Grant feature, you will see the following tabs: Query, Advanced
Query, Results, Floor Plans, Add, and Load Data.

The Query and Advanced Query tabs can be used to look up existing Grants by Grant Name, and
Facility / Floor / Room. The results will be displayed in a data grid on the Results tab.
The Add tab is used to assign an existing Grant to a space (facility, floor, and room).
After making the appropriate entries on the Add tab, click the Add Record button. The Edit tab
will appear with the newly added information.
Space General
The Space General table is available to store data related to a Room. The Space General table
has 6 different data types: Code, Date, Memo, Number, Text, YesNo (each with 10 fields, except
Code which has 30 fields). This data is related to a specific Facility, Floor, and Room.
In Administration | Settings | Space | Space General 1 & 2, settings are available to:
• make the Space General table available,
• make the table appear as a Tab in Space/Edit,
• make the table appear as a separate node under Space Management | Space,
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•

specify a custom "name" for the Space General module (this is the name that will
appear on the Space List tab and in the navigation tree).

The Space General table may be used to store two or more identical records. To preclude the
creation of identical records, you can select the "Unique Constraint used with each Space"
option. By placing a checkmark in the checkbox for "Change Unique Constraint", you will be
required to select one of the Space General table fields as the unique constraint. In this special
table only, the unique constraint may be a "null" value. You may check the option for "Make
Selected Field Required" to make the identified unique constraint field a Required Field (null
values are not allowed in Required Fields).
The Space General Code1...30 fields are defined by a Code and a Name. The Space General
settings allow you to define a "Custom Rule for Populating a (Space General) Text field with the
'Name' value from one (Space General) Code field". This feature is useful when you want to be
able to Query by a Space General Code's name, instead of the Code's code. The Code's name is
placed in a chosen Text field; you can then Query the Text field and look at the Result in the
data grid.
Two (2) Space General tables are available: Space General 1 and Space General 2.
Occupancy
The Occupancy feature helps simplify the complexities involved in relating organizations and
people to the space they occupy or for which they have responsibility.
The Occupancy Code tables define the lookups in the Occupancy table.
The Facility Occupancy Class table stores information about codified classifications for
occupancy (i.e. commercial, residential, etc.). One value in this table can be entered into the
Occupancy Class field of each Facility record.
Occupant percentage values can be stored, if desired, for each Occupant – they are not
required. However, if used, all Occupant percent values combined for one space cannot exceed
100%.
Space Occupancy: Apply Equal Percentages: A button “Apply Equal Percentages” in the
Add/Edit tabs enables the user to distribute the total percentage of Occupancy equally among
all Occupants present on the screen.
To quickly add many new occupancy assignments to many new spaces, first add one occupancy
assignment. Then, use the Duplicate button and change the necessary fields before clicking the
Add Record button. You may also consider using the Replace Column feature from the data
grid.
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In Occupancy floor plans, the highlighting of rooms in floor plans is achieved using the
Percentage field in each record. In cases where Occupancy percentage does not equal 100%,
the occupant count is used to split the room highlighting. The drawing pane provides the
option of turning off this type of highlighting.
The Occupancy dropdown has been optimized to accommodate large record sets. The
optimization and type-ahead search capability have been implemented on the following
browsers: Chrome, Firefox, Edge, and Safari.
IMPORTANT! Changes to a Space that affect the Organization may also affect the
Occupant, Responsible Person, and Function Assignments.

Productivity Tip: If you want to assign Occupants to spaces without
any current occupants, perform an Advanced Query where the
Occupant Name is Null. You can then work your way down the
Results data grid by editing the rows one at a time and adding the
Occupants. Then, click back on the Results tab to continue with the
next row in the data grid.
If you want to assign an Occupant placeholder, such as "Open" or
"Vacant" or a person to a large number of spaces at once, perform
the Query necessary to get the appropriate Results data grid. Then,
from the Results tab, click on the appropriate check boxes to select
the spaces of interest. Next, click on the Replace Column button. In
the replace dialog window, select the Column Name: "Occupant" and
then select the New Value and click on the Replace button.

Occupancy Extension
Under Admin Settings, there is now a tab called “Occupancy Extension”. This feature allows you
to associate additional Organization and Person data with spaces. By selecting “Yes” in the Use
Additional Organization & Person data dropdown, you are now able to capture Occupying
Org/Person data in addition to Owning Org/Person data. This is especially helpful in instances
where Leased Spaces are present, and the Owning Org(s) differ from the Occupying Org(s).
The Occupancy Extension dropdown has been optimized to accommodate large record sets.
The optimization and type-ahead search capability have been implemented on the following
browsers: Chrome, Firefox, Edge, and Safari.
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Function Assignment
The Function Assignment function is used to assign functions and percentages to space.
Function Assignment information is available on the Results tab in data grid format. Clicking on
the Edit button for a particular row in the data grid will display the data on an Edit tab in form
view. This is where function assignments are made.
All available function names will appear on the Edit tab. The only action for a user to take is to
input appropriate percentage numbers in the corresponding percent box next to each Function.
Zero values need not be entered. The summation total of all other percent values entered must
add up to 100 percent.
The Function Assignment and Organization Assignment tables track the assignment of Spaces to
one or more Organizations that occupy the space. This important common table relates spaces,
organizations, people, occupancy and functions (ICR) through a common element –
organization assignment.
The Organization Assignment table is a key table commonly used in Net-FM. It tracks the
assignment of a valid organization to Space, Person, Occupancy, and Function records.
To quickly add many new function assignments to many new spaces, first add one function
assignment and click the Add Record button. Then, use the Duplicate Record button and
change the necessary fields before clicking the Add Record button. You may also consider using
the Replace Column feature from the data grid.
In Function Assignment floor plans, the highlighting of rooms in floor plans is done using the
Percentage field in each record.
IMPORTANT! Changes to a Space that affect the Organization may also affect the
Occupant, Responsible Person, and Function Assignments.

Productivity Tip:
If you want to assign Functions Assignments to spaces without any
current function assignments, perform an Advanced Query where
Function is Null. You can then work your way down the Results data
grid by editing the rows one at a time and add the Function Percent.
Then, click back on the Results tab to continue with the next row in
the data grid.
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If you want to assign a Function (Function Percent will be 100%) to a
large number of spaces at once, perform the Query necessary to get
the appropriate Results data grid. Then, from the Results tab, click
on the appropriate check boxes to select the spaces of interest. Next,
click on the Replace Column button. In the replace dialog window,
select the Column Name: "Function:" and then select the New Value:
and click on the Replace button.
If you want to assign a Function (Function Percent will be 100%) to a
large number of spaces that have the same Use assignment at once,
perform the Query on Use to get the appropriate Results data grid.
Then, from the Results tab, click on the appropriate check boxes to
select the spaces of interest. Next, click on the Replace Column
button. In the replace dialog window, select the Column Name:
"Function:" and then select the New Value: and click on the Replace
button.
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Organization
Organization List
The Organization module stores the information about
organizational entities: schools, divisions, departments, groups.
These entities are arranged in hierarchical order to accurately
reflect lines of responsibility.
The Organization Code tables define the lookups in the Organization table.
Consider the Assignability of the Organization.
•

Assignable means facility area assigned to or available for assignment to an occupant or
specific use. Examples include offices, labs, general or specific use.

•

Non-assignable means facility area not available for assignment to an occupant or for
specific use, but necessary for the general operation of a facility. Examples include
building services, circulation and mechanical.

Organization Contact
The Organization Contact table stores information about the primary contacts for an
organization and is related to the Person table.
The Organization Contact feature in Net-FM also provides for contact type.
The Organization Contact dropdown has been optimized to accommodate large record sets.
The optimization and type-ahead search capability have been implemented on the following
browsers: Chrome, Firefox, Edge, and Safari.
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Use
Assignability
The Assignability table groups Major Room Uses into Assignable vs. NonAssignable categories, a commonly used method of classifying all space
in a Facility. It also links to the Organization table, determining that
organizations may only have certain room uses assigned to spaces the
organization occupies.
Major Use
The Major Use table groups individual Uses into a higher level classification. This is a commonly
used method for accumulation, analysis and regulatory responses.
Consider the Assignability of the Major Use.
•

Assignable means facility area assigned to, or available for assignment to an occupant or
specific use. Examples include offices, labs, general or specific use.

•

Non-assignable means facility area not available for assignment to an occupant or for
specific use, but necessary for the general operation of a facility. Examples include
building services, circulation and mechanical.

Use
Use tracks the architectural room use of each space and manages the classification of space in
each facility.
INSITE supports the Building Classification Standard as specified in the Facilities Inventory and
Classification Manual (FICM). This Standard both categorizes spaces in clear and useful
delineations and ensures that responses to government agencies meet requirements for space
reporting in terms of architectural room use. These definitions are used in FICM to classify
building space:
Gross Area: Total area within the building’s footprint (exterior edges of the perimeter
wall).
Structural Area: Total area of all walls and columns within walls, but excluding all
freestanding columns within rooms.
Usable Area: Total space within the building that can be used for any program or
purpose. It is equal to Gross Area minus Structural Area.
Assignable Area: The portion of Usable Area that is assigned to a building occupant for
his/her exclusive use and under his/her control (i.e. offices, labs, instructional space,
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support space).
Non-Assignable Area: The portion of Usable area that generally supports all building
users and building operations and is not assigned specifically to any occupant. (i.e.
circulation, custodial and mechanical space)
The Use Code tables define the lookups in the Use table.
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Sign
Space Sign
The Sign module allows you to track and manage the type of signs and
content of the signs for spaces.
Facility, floor, and room fields identify the sign location. The template
name, which is optional, describes the attributes of the sign: height, width, font type, font style,
font size, font color, and background color. If using a template, these fields are automatically
filled-in by the chosen template. Otherwise, these fields can be entered line by line as desired.
Also, the use of a “template” will automatically populate Line 1: through Line 12: as required
based on the template settings. To enter lines manually, simply un-check the “Use Template”
checkbox in the bottom portion of the Add tab window.
The Updated Date and Updated By fields are automatically entered when the "Add Record"
button is clicked.
Line1 through Line12 represent information that is to be placed on the sign.
To add a Sign to a Space, click the Add tab. By default, the Use Template checkbox will be
checked. After entering the appropriate Facility, Floor, and Room, only the appropriate
available values for Select Organization and Select Person will appear in the drop-down lists.
You can click the checkbox for "Skip Person Information" to exclude all person related
information from the sign.
You can click the checkbox for "Include All Persons" to select all person categories: Occupants,
Responsible Persons, Space Principal Investigators, and Space Contacts. Or, you can select the
person categories individually.
The checkbox for "Single Sign for Multiple Persons" will create only one sign which will include
all persons. Otherwise, a different sign will be created for each person. For example, you would
use this checkbox to create one sign with 2 or more people's names.
A convenient method to add new signs for spaces without signs is to perform an Advanced
Query where "Sign" "Is Null". This will give you a list of spaces without a sign.
Viewing and Printing
Space signs that have been added are available for updating, viewing and printing via the Space
Signs Results tab and the Space Signs Edit tab. The tabs have the respective links and they open
the "Sign Options" dialog window:
• Space Sign - Results > View Signs (PDF).
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•

Space Sign - Edit > View Sign (PDF),

From the Sign Options window, simply click on the “View Signs” button to generate a PDF that
will open in your web browser's PDF control window. From the PDF control window, you can
view, save, and print. When finished, close the PDF control window and the Sign Options dialog
window.
The "Sign Options" dialog window also allows you to:
• place an image (picture) at the beginning of any specified line, 1-12
• specify the number of signs per page to print
• specify the page size to print
• specify the sign margin (margin above each sign)
• specify the first line height: Relative, based on Sign Height; or, Fixed, based on Font Size
• override the font type, font size, font color, and background color for each line (1-12)
Sign Updates
The Sign Updates for Occupants feature will assist you to create new signs for each space
where any change to the Occupants assigned to a space has occurred.
As you manage the Occupants for each space over time, the need to create a new signs, and
delete old signs, will occur. The Sign Updates feature compares the date time stamp on the
Occupant records against the Updated Date field in Space Sign. The Sign Updates feature will
flag all signs that were created before the Occupants changes took place.
To use this feature, click on the checkbox for "Recreate Signs for all Spaces where Occupants
have changed since the previous Sign update". Then, in the Template Used drop-down list,
select the Sign Template name for which you would like to create new signs, and delete the old
ones. If no signs need updating, you will see the message "No Sign update needed at this time". If a
sign update is needed, you will be able to click the "Recreate Signs" button to complete the
process.
Note: You need to select the Sign Templates by name individually to check for possible sign
updates required. There may be some sign templates for which you do not wish an update.
After you have performed the “recreate signs” function, you can get a list of the signs that were
just created/updated from within the Space Sign feature – simply perform a Query on the
“Updated Date” field.
Sign Template
A Sign Template can be used to expedite the creation of multiple like signs with Space Sign.
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The template name uniquely identifies the template. The template attributes that would apply
to a sign include: height (inches), width (inches), font type, font style, font size (points), font
color, and background color. The content type of the sign is also captured by the sign template.
When using a template, these fields are automatically filled-in by the chosen template.
To create a Sign Template, click on the Add tab. Then fill-in the following fields as desired:
Template Name, height, width, font type, font style, and font size.
Select the color type, either by name (HTML color names) or by RGB value by clicking the
appropriate radio button. The corresponding color specification section is enabled for color
input. Once a color is specified, you will also be provided with the hexadecimal value for the
respective color in the box to the right.

Next, in the Select Sign Contents Below section, use the drop-down lists to build the sign
content.
For example, the following choices,

will yield sign data for a space that might look like this:
LA-201
[facility = LA, hyphen = -, floor = 2, room = 01]
Facilities [organization name = Facilities]
John Doe [person first name = John, space = , person last name = Doe]
Note: When creating one sign for multiple person names, you do not have to create multiple
duplicate entries in the template, i.e., in the case above, you do not have to add
person_first_name field, etc. to line 4. The Space Sign feature will create multiple line entries
automatically.
Note: The Template Name field is a required field, by default, in the Space Sign - Add tab. If you
do not want this to be a required field, go to Administration - Column Attributes. Select the
Space Sign feature and click the Get Results button. Then, find the Template Name field and
change the Required Field status from Yes to No.
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Common
About Common
A number of INSITE database tables store information that is
commonly used throughout the database. The Common function,
containing Address, Cost Type, Feature Type, and Person information,
ensures an efficient and consistent way to maintain "common" data
throughout the database. The Address and Person information is the
same in both the Asset Management and Space Management
modules of Net-FM. The Common function is made available in both
modules for user convenience.
In addition, the Lookup function is employed to maintain the values
for dropdown lists associated with many fields throughout the Net-FM system. The Lookup
information stored in the Space Management module is different from the Lookup information
stored in the Asset Management module.
Address
The Net-FM system allows you to store complete address information. The Field Name fields
store the identifier used in the Facility Address and Person Address tables to point to a record
here in the Address table.
This address is used for facilities. (The Person Address is used for people's addresses.) The
State, County, and Country must be pre-existing in the Lookup tables.
Several Address code field lookup sub-tables are available. Code fields store data from a list of
legal values for a particular field. These fields provide consistent information for querying,
sorting, and grouping records by some common element. The list of legal values is defined and
maintained by your INSITE system administrator.
Cost Type
The Cost Type table stores the types of costs available to any Cost field in Net-FM. One value in
this table can be entered into the Cost field of each Facility record or each Space record. Note:
The Indirect Cost Recovery | Costs | Cost Type function is the same as the Space
Management | Common | Cost Type function.
Feature Type
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Use the Feature Type function to input all valid types of features. This list is used in the
feature_type field for both facility features and space features. The Feature Type table stores
the types of features available to any feature field in Net-FM. One value in this table can be
entered into the Feature field of each Facility record or each Space record. The Category field
enables you to establish a hierarchical structure of category and feature types.
Lookup
The Lookup function is employed to maintain the values for dropdown lists associated with
many fields throughout the Net-FM system. This unique table stores records used as lists of
legal field values for other database tables. The Lookup Type determines the table field for
which the record will be referenced (called sub-table). There is no limit to the number of
records in each sub-table list. Space Lookup Types listing (updated fields highlighted in green):
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Address Purpose
Contact Type
Cost Category
Country
County
Domain
Facility Category
Facility Code 1 - 5
Facility Condition
Facility Cost Code 1 - 2
Facility Feature Code 1 - 10
Facility Occupancy Class
Facility Ownership
Facility Primary Use
Facility Status
Facility Type
Feature Category
Floor Code 1 - 2
Function Code 1 - 2

Space Management
• Grant Code 1 - 5
• Occupancy Code 1 - 2
• Organization Code 1 - 5
• Person Code 1 - 5
• Person Rank
• Region Code 1 - 2
• Sign Code 1 – 2
• Site Code 1 – 2
• Space Category
• Space Code 1 - 10
• Space Cost Code 1 - 2
• Space Feature Code1 - 10
• Space General Code 1 -30
• Space General2 Code 1 - 30
• Space PI Code 1 - 2
• Space Sign Code 1 - 2
• State
• Sub Use Code 1 - 2
• Use Code 1 - 10

Person
The Net-FM system allows you to store complete information about people and occupants.
When adding a new person, you will enter a unique person number field, last name, and first
name as required fields.
Page
203

Several Person code field lookup sub-tables and Person Rank table are available. Code fields
store data from a list of legal values for a particular field. These fields provide consistent
information for querying, sorting, and grouping records by some common element. The list of
legal values is defined and maintained by your Net-FM system administrator.
Note on Active field: Some Consortium Members have expressed a need to maintain person
data for individuals who are no longer with their respective organizations. When proper
cleanup/maintenance is neglected on the person table, the number of records can grow
considerably. This can make any person table dependant dropdowns (i.e. Occupant, PI, etc.)
rather unwieldy. Thankfully, INSITE has introduced the concept of the Active field in the person
table. By setting the active flag to “NO” for a given person, his/her name will no longer appear
in person table dependent dropdowns. By default, when new persons are added, the flag is set
to “YES” unless you change it.
Person Address
The Net-FM system allows you to store information about people's addresses. This typically
relates to occupancy. The person (from the Person table), address (from the Address table), and
purpose (from the Lookup table) must be pre-existing.
Person Skills
This module enables you to associate Skills with Persons in the Person Table. After associations
are created, they are easily queried or updated.
Skills
This module is where you enter Skills and a corresponding Skill Memo. Skills must first be
created prior to assignment to Persons.
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Asset Management
About Asset Management
The INSITE Asset Management (AM) module inventories, tracks,
analyzes, and reports information about fixed and movable
equipment. The application allows assets to be classified and located
in space.
The Asset Management Tables are Asset, Account, Asset Accounting,
Asset Classification (Category, Class and Nomenclature), and Vendor
and Common Tables.
Net-FM Asset Management data may also be linked to your drawings and floor plans with
INSITE Visual-FM™ and INSITE View-FM™.
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Asset Management Menu
About the Asset Management Menu
The Asset Management Menu or navigation tree is divided into several modules:
Account - The Account module provides an easy interface to create and maintain financial
accounts. Use this area of Net-FM to define and classify account numbers and the segments
which comprise them.
Asset - manage asset details and locations. The Asset module provides a detailed inventory of
all fixed and moveable equipment and tracks the account activity connected with the
acquisition and depreciation of that equipment.
Classification - The Classification module includes Category, Class, and Nomenclature to
identify, classify, and define assets into a three level hierarchy.
Vendor - vendor names and codes used to identify the vendors from whom equipment may be
purchased.
Transaction – This module is only available when logged in as the Net-FM super-user. Please
refer to the Net-FM Administration Guide for more information.
Common - lookup codes, names, and addresses
Individual users may or may not have access to the Asset Management menus depending upon
their User privileges.

Account
Major Account
Major Account is the top level of the Account module hierarchy. Use this function to define
each Major Account and its corresponding name, assign a responsible person and responsible
organization. Additionally, this function allows you to use several text, code, number, and date
fields to tailor your organization’s tracking requirements.
The Major Account table provides the highest account-level categorization. Major Account
Code Tables:
Major accounts can be delineated through the Major Account Code1 and Major Account Code 2
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tables, and may optionally be associated with a person and/or organization.
Account
The Account function allows you to create and maintain individual account numbers. An
account number consists of one to eight segments. Net-FM assembles the account number in a
display only Account Number field at the top of the window as you enter each segment on the
Account tab. The displayed account number segments are separated by a character, typically a
dash or dot, which has been selected during database installation. Further, the Account
function allows you to specify an Account Name, Person Number, Fund Source*, Fund Type*,
Grant Number*, Start and End Dates. Additionally, this function allows you to use several text,
code, number, and date fields to tailor your organization’s tracking requirements.
Account Segments are defined in the Account Segment function. Person Numbers are defined
in the Person function. Fund Sources are defined in the Fund Source function.
*Please note that these fields are only available for edit if the following setting is set
appropriately (otherwise the Grant Tracking Module should be used): Administration | Settings
| Other | Grant Options | Grant Account Option = “USE COLUMNS IN ASSET ACCOUNT”
The Account table contains account numbers. Each account number can contain up to eight
distinct segments.
Accounts may be further delineated through the Account Code 1 and Account Code 2 tables,
and may optionally be associated with a Person, Fund Source, and/or Fund Type.
Fund Source
The Fund Source function lists the available funding sources for your organization. Some
examples of Fund sources are: Private, State, University, Department of Defense, or National
Institute of Health. Use this function to define the Fund Source and name. Additionally, this
function allows you to use several text, code, number, and date fields to tailor your
organization’s tracking requirements.
The Fund Source table contains a list of organizations and agencies that may provide funding
for accounts. This table provides the lookup list for the Account record’s Fund Source field.
Fund Source Code Tables
The Fund Source may be further delineated through the Fund Source Code 1 and Fund Source
Code 2 tables
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Fund Type Table
The Fund Type table categorizes the funding types that may be associated with an account.
Fund Types may include Federal, State, Regional, etc. This table provides the lookup list for the
Account record’s Funding Type field.
By Consortium Member request, “Funding Type” is now available from the Asset Management
| Asset | Asset Excel Export and the Accounting Combo form.
Subcode
Use the Subcode in conjunction with the Account number when you require further financial
categorization. Minimally each Subcode record contains a Subcode and name entry.
Additionally, this function allows you to use several text, code, number, and date fields to tailor
your organization’s tracking requirements.
The Subcode Code tables allow you to further delineate the Subcode records.
Segment
About Segments
Segment 1 – Segment 8
The number of required account segments and corresponding customized segment field labels
can be specified with Administration Column Attributes. Account numbers consist of Account
Segments. Each segment is defined in the corresponding Segment window. Minimally, each
segment contains an Account segment and name entry. Additionally, this window allows you to
use several text, code, number, and date fields to tailor your organization’s tracking
requirements.
The Account Segment tables store valid account segment values. Segment1 is 32 characters
long. All other segments, 2 through 8 are 16 characters long. The segments are used to create
valid Account Numbers which consist of one to eight segments. The eight Account segment
tables provide the lookup list for the Account record’s Account Segment Field. Only Account
Segment1 is required.
Account Segments can be delineated through the Account Segment Code1 and Account
Segment Code 2 tables.
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Asset
Accounting
Use the Asset Accounting function to track the account activities related to the asset’s
acquisition. In addition to this function's editable fields, there are sixteen display-only fields
from the asset record: Asset Name, Acquisition Date, Useful life, Asset Ownership, Disposition
Status, Audit Group, Object Code, Asset Vendor, Facility, Floor, Room, Organization1,
Organization2, Person1, Person2, Funding Type.
The Asset Accounting Tab allows you to maintain one or more accounting records for an asset.
The Asset Accounting table stores one or more account records associated with the purchase of
a particular asset. The asset’s cost may be divided among several different accounts and the
total acquisition cost is the sum of the individual accounting amounts. Asset Accounting can be
delineated through the Asset Accounting Code1 and Asset Accounting Code 2 tables.
Note: You cannot duplicate an account to the same asset unless one of the following 3 fields is
unique: PO Number, Subcode, Voucher Number. If PO Number is the same in the duplicate
account, then either Subcode or Voucher Number needs to be unique. If both PO Number and
Voucher Number are the same, then the Subcode needs to be unique.
Asset
Each Asset record must contain an Asset Tag Number, Asset Name, Acquisition Date and Useful
Life (Useful Life field is automatically updated with associated value from nomenclature table).
Fields are provided to record a number of asset features so that asset records can be as
detailed or general as necessitated by organizational requirements. Additionally, this function
allows you to use several text, code, number, and date fields to tailor your organization’s
tracking requirements. Each organization can tailor which of these fields require data input by
using the Administration module Column Attributes.
In addition to the editable fields, several read-only fields display: Acquisition Cost, Acc.
Depreciation, Entered Date, Net Book Value, Entered By, Match Status, Updated Date, and
Updated By. Acquisition Cost, Accumulated Depreciation, and Net Book value are calculated
by accumulating the cost and depreciation values in the asset accounting and asset
depreciation records associated with the asset.
Note about using the Results tab Replace Column feature:
In the Asset module, the Replace Column function allows a Floor and Room to be replaced.
Since these are “dependent” values (i.e. Floor can be replaced only with a valid Floor in that
Facility; Room can be replaced only with a valid Room in that Facility/Floor) if the situation does
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not allow you to maintain logical integrity of data, the Replace Column function is disabled. For
example, on a Results tab if you select asset records that belong to different facilities, and you
try to choose Replace to change the value of Floor, you will get a message indicating this is not
allowed:
If a Floor value is changed, the Room value for that record is retained only if a valid Room by
that same name exists in the target Floor; otherwise the Room is reset to NULL. Similarly if a
Facility value is changed using the Replace function in the Results tab and the Floor/Room in
the target Facility are present it will be retained, otherwise the values for Floor/Room are reset
to NULL.
Note: If you enter a value for either one of these fields: Asset Disposition Date or Asset
Disposition Status, then both fields will require valid values. This check is made before updating
the database.
Note: If a space is deleted from Space Management, and an asset is assigned to that space, the
asset is not deleted. The deleted facility/floor/space values are concatenated and stored in the
Old Space Name field.
Note: If an Asset Tag Number is changed (in Asset/Asset Edit) and the database is updated, the
previous value of the Asset Tag Number gets automatically saved in the field Asset Old Tag
Number (value of Asset Old Tag Number will get over-written in such case).
Asset List – Advanced Query: Two additional fields have been introduced to assist with queries;
they are as follows:
a) Account Number
b) Asset Accounting PO Number
In the screen shot that follows, there is a checkbox on the bottom right, labeled “Show
Additional Fields”. When checked, Account Number and Asset Accounting PO Number will
appear as the last two selections on the Select Column dropdown. (The checkbox makes it
possible for this feature to be optional. This can be of significant importance as the two fields
are often of such great size that they impact performance and can delay query results.)
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The comparison can be made only using a textbox – a dropdown would be impractical as there
are potentially hundreds (or thousands) of records that would populate the list.
Note: Please use the “Contains” operator (rather than “Equal To”) if you expect values coming
from multiple asset accounting records for the same asset.
Asset Table
The Asset table is the equipment inventory and includes fields that specify and track the asset
throughout its life cycle.
Asset Acquisition Method Table
The Asset Acquisition Method table describes the means by which the asset was acquired:
purchase, gift, etc. This table creates a lookup list of valid values for the Asset record’s
Acquisition Method field.
Asset Condition Table
The Asset Condition Table describes the physical condition of the asset.
Asset Disposition Table
The Asset Disposition Table describes the disposition status of the asset.
Asset Ownership Table
The Asset Ownership table describes the ownership of the asset.
Asset Tag Type Table
The Asset Tag Type table stores a list of valid tag types, including NPT (Not Physically Tagged).
This table provides the lookup list for the Asset record’s Tag Type field.
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Asset Code Tables
The Asset Code tables 1 through 5 are available for you to create new code fields to track
additional information on your assets.
Estimation Method Table
The Estimation Method table describes the various methods used to arrive at the estimated value
of an asset: appraisal, depreciation, book value, etc. This table creates a lookup list of valid values
for the Asset record’s Estimation Method field.
Object Code Table
The Object Code Table is a lookup table that can be used to provide further description of an
asset.
If you Edit an Asset record, from the Asset | Asset (Edit) tab you have the option to use the
Floor Plan link, if available, to open a new window and view a floor plan. That floor plan will
automatically highlight the space for the asset that is being edited. (If a floor plan is not
available, the link will not be displayed.)
Asset - Documents
The Documents tab allows you to:
• specify documents to be uploaded to your Net-FM system's web server
• view documents that are on your Net-FM system's web server
In Net-FM Asset Management, documents can be linked to an asset, account, facility, floor,
and/or space.
Any available Documents will appear by list in the left-side window pane. You can click on the
icon to view the document. You can click on the check box in front of the listed names and then
click on the Delete File(s) button to delete the files from the web server.
To upload files to the server, either enter a complete path and filename into the File Name box
and click on the Upload File button, or click on the Browse button – this will open a Windows
Choose File dialog box from which you select a file for upload.
Several enhancements have been included with the latest Net-FM release pertaining to
documents when the Asset/Accounting Combo form is in use. Please refer to the following:
• On the Asset Management | Asset | Accounting and the Asset Management | Asset |
Asset | Accounting results grids, the Documents icon displays if a document was
uploaded to either the Accounting record or the parent Asset (a popup indicates “Asset
Documents” if the document belongs to the Asset).
• After navigating to Asset Management | Asset | Asset | Accounting and selecting an
Accounting record for edit, a new “Accounting Documents” tab appears in addition to
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the original “Asset Documents” tab. This makes it possible for you to add a document to
either the selected accounting record or the selected asset.
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Classification
The Classification function includes Category, Class, and Nomenclature. Use this module to
identify, classify, and define assets into a three-level hierarchy.
Category
Categories generally define broad areas of Assets such as Furniture, Data Processing, and
Fixtures. Category is the top level of the Classification module. Use this function to define a
Category code and name. Additionally, this function allows you to use several text, code,
number, and date fields to tailor your organization’s tracking requirements.
The Asset Category Table tracks the top level of categorization of Assets. The Used for
Depreciation field allows you to specify if these assets will automatically be included for
depreciation. A NULL value or NO value will exclude these assets from depreciation.
Asset Category can be delineated through the Asset Category Code1 and Asset Category Code
2 tables.
Class
The Class function allows you to further describe Categories. For example, a Category of
Mobile Computing may include Class records for laptops, tablets, and smart phones.
The Asset Classification Table provides a second level of equipment classification. An asset’s
useful life is assigned at this level.
Asset Class can be delineated through the Asset Class Code1 and Asset Class Code 2 tables.
Nomenclature
You use the Nomenclature function to create a list of names that can be assigned to an asset.
The Asset Nomenclature Table ensures consistent asset naming by creating a lookup list of valid
values for the Name Field on the Asset record. A useful life and an alternative life can
optionally be assigned here.
Nomenclature can be delineated through the Nomenclature Code1 and Nomenclature Code 2
tables.
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Vendor
Vendor List
Use the Vendor function to identify the vendors from whom equipment may be purchased.
The Vendor table creates a lookup list of valid values for the Asset record’s Vendor field. The
Vendor Code tables create a lookup list of valid values for the Vendor table fields.
With this release, the field sizes for the VENDOR_NUMBER1 and VENDOR_NUMBER2 in the
AM_VENDOR table have been increased. The new field size is 12 digits with a precision of 2
(i.e. max value = 9,999,999,999.99).

Common
About Common
A number of INSITE database tables store information that is commonly used throughout the
application. The Common function, containing Address and Person information, ensures an
efficient and consistent way to maintain "common" data throughout the database. This
information is the same in both the Asset Management and Space Management modules of
Net-FM. The Common function is made available in both modules for user convenience.
In addition, the Lookup function is employed to maintain the values for dropdown lists
associated with many fields throughout the Net-FM system. You will notice that the Asset
Management Lookup Types differ from those under Space Management Lookup Types.
Address
The Net-FM system allows you to store complete address information. The Field Name fields
stores the identifier used in the Facility Address and Person Address tables to point to a record
here in the Address table.
This address is used for facilities. (The Person Address is used for people's addresses.) The
State, County, and Country must be pre-existing in the Space Management | Common |
Lookup tables.
Several Address code field lookup sub-tables are available. Code fields store data from a list of
legal values for a particular field. These fields provide consistent information for querying,
sorting, and grouping records by some common element. The list of legal values is defined and
maintained by your Net-FM system administrator.
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Lookup
The Lookup function is employed to maintain the values for dropdown lists associated with
many fields throughout the Net-FM system. This unique table stores records used as lists of
legal field values for other database tables. The Lookup Type determines the table field for
which the record will be referenced (called sub-table). There is no limit to the number of
records in each sub-table list.
The Asset Management Lookups include:

•
•
•
•
•
•
•
•
•
•
•
•
•
•

Account Code 1 - 2
Account Segment1 Code 1 - 2
Account Segmnt2 Code 1 - 2
Account Segment3 Code 1 - 2
Account Segment4 Code 1 - 2
Account Segment5 Code 1 - 2
Account Segment6 Code 1 - 2
Account Segment7 Code 1 - 2
Account Segment8 Code1 - 2
Asset Accounting Code 1 - 2
Asset Acquisition Method
Asset Category Code 1 - 2
Asset Class Code 1 - 2
Asset Code 1 - 5

Asset Management
• Asset Condition
• Asset Disposition Status
• Asset Ownership
• Asset Tag Type
• Depreciation Method
• Depreciation Status
• Estimation Method
• Fund Source Code 1 - 2
• Funding Type
• Major Account Code 1 - 2
• Nomenclature Code 1 - 2
• Object Code
• Subcode Code 1 - 2
• Vendor Code 1 - 2

Note: The assignment of Domain Authority, and State, County, Country, and Address Purpose
is accomplished through the Space Management | Common | Lookup function.
Person
The Net-FM system allows you to store complete information about people and occupants.
When adding a new person, you will enter a unique person number field, last name, and first
name as required fields.
Active field – The active field is a lookup field in the Person table with possible values of
Yes/Y and No/N. By default, any new person added via the Add tab or Person Load Data
has his/her active flag set to Yes/Y by default.
What is the significance of the Active field? In many cases, Consortium Members have
expressed a strong desire to preserve/maintain person information for individuals who
have left the organization. Rather than delete this information, the active field provides
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a mechanism to present only the most current/relevant information in Net-FM.
Essentially, anyone whose active flag is set to “No” or “N”, will not appear in the Simple
Query/Add/Edit tabs under the respective fields of Occupant, PI, Space Contact, and
Move Contact. This filtering helps eliminate the need for potentially tens of thousands
of records to populate the dropdowns. Speed and efficiency in Net-FM are markedly
improved.
Several Person code field lookup sub-tables and a Person Rank table are available. Code fields
store data from a list of legal values for a particular field. These fields provide consistent
information for querying, sorting, and grouping records by some common element. The list of
legal values is defined and maintained by your Net-FM system administrator.
Person Address
The Net-FM system allows you to store information about people's addresses. This typically
relates to occupancy. The person (from the Person table), address (from the Address table), and
purpose (from the Space Management | Common | Lookup table) must be pre-existing.
Person Skills
This module enables you to associate Skills with Persons in the Person Table. After associations
are created, they are easily queried or updated.
Skills
This module is where you enter Skills and a corresponding Skill Memo. Skills must first be
created prior to assignment to Persons.
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Asset Reconciler
About Asset Reconciler
After performing an asset physical inventory, the
reconciliation process is performed. Reconciliation is defined
as the process of identifying, explaining, and correcting the
differences occurring between the physical inventory
(inventory scanner files) and the inventory records (asset
database). When all differences have been identified and
explained the inventory is considered reconciled.
INSITE’s Net-FM Asset Reconciler defines inventory cycles and batches, and then compares
inventory scanner files to the batch and reconciles the differences.
Click here for a summary of how to prepare and perform an inventory and reconciliation.

Asset Reconciler Menu
Inventory Cycle
Inventory Cycle is used to define an inventory event. The inventory cycle could be annual,
cyclical, ad-hoc, etc. The inventory cycle is a name that you will use to identify one inventory
event from another, for example, INVENTORY 2017, INVENTORY 2018, etc.
Each Inventory Cycle will have an associated status of either: Complete, In Progress, or Not
Started. Only one Inventory Cycle can have the status of In Progress. All other cycles must
either be Complete or Not Started.
The Add tab allows you to create a new Inventory Cycle name and status. Once a new
Inventory Cycle has been added, or if you click on the Edit
button for an existing
inventory cycle in the Results tab, the Edit tab will appear. The Edit tab allows you to change
the Status of an Inventory Cycle.
Users that have Domain restrictions will only see the Inventory Cycles for their Domain.
IMPORTANT! Only users with Reconciler Admin privileges can create and edit the
Inventory Cycle.
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Batch
The Batch function allows you to create batches and add asset records to batches, i.e., Add
Records (existing asset records that will be used to compare against the newly captured
inventory scanner files) to the batch.
From the Add tab, you can:
• Select an existing Inventory Cycle (name of inventory cycle)
• Create a new Batch (name or description of batch)
• Select a Batch Leader (user name from Users table)
• Scheduled Inventory Date (a date field)
When complete, click on the Add Record button. The Batch Edit tab will appear with the
information you just entered as well as some additional fields and function buttons.
Note: A Batch is a sub-set of the assets in the asset database. The idea of a Batch is to help
make managing the amount of data that needs to be reviewed and possibly edited by a user
more manageable. A specified set of scanner inventory files will be compared (Preview) to a
specified batch. However, please note that if an asset tag number in the scanner file does not
match an asset tag number in the batch, then the entire asset database is searched for a match.
A batch will not prevent you from finding a match in the database!
Users that have Domain restrictions will only see the Inventory Cycles and Batches for their
Domain.
IMPORTANT! The default for the Inventory Cycle is always “In Progress.” Users
without Reconciler Admin privileges cannot change anything related to cycles that
are not in progress.

Batch Edit Tab
The Batch Edit tab allows you to make changes to a batch and to create a batch entry. The
Batch Edit tab displays the:
• Inventory Cycle
• Batch
• Batch Leader (username)
• Scheduled Inventory Date
• Last Reconciled (date)
• Create Date
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The Batch information can be edited and updated with the Update Record button.
The Create Batch Entry button allows you to query the assets in your database to obtain a list of
assets to include in the batch. Remember, the batch is used for comparison against the
inventory scanner files during the reconciliation process. The query operation is similar to an
Advanced Query in that it allows you to have Query1 (its respective statements connected with
a logical AND) OR Query2 (its statements connected with a logical AND). In plain English, the
result set must meet all of the criteria specified in Query1 OR all of the criteria specified in
Query2. Once the query criteria have been entered, press the Get Results button. The system
will return a message indicating your query and the number of records that fit your selection
criteria.
If the selection is not correct, press the Clear button. If the selection is acceptable, click the
Add Assets to Batch button. Once complete, the message "Updated Database" will appear, you
can now close that query window.
The Batch Edit tab should now indicate "There are n entries in this Batch". A detail list of all the
batch entries is available on the Batch Entries tab.
IMPORTANT! Creating Batch Entries changes the Asset database. If the Asset
Disposition Status field is NULL, the field is set to “NFD” and the Asset Disposition
Date is set to “today’s date.”

Batch Entries Tab
The Batch Entries tab displays the assets that have been included in a particular batch. This tab
is similar in functionality to a Results tab. You can select individual rows for delete, sort by
column, and export/print records.
Scanner File Upload/Details
The Scanner File Upload function allows you to load the inventory scanner files against a
particular Inventory Cycle and Batch on the Load New File tab.
The appropriate scanner model that you used to capture the inventory must first be entered in
your My Preferences setting for Scanner Model to ensure proper file format compatibility.
Note: Administration | Settings | Asset has a tab for Scanner Options. It currently allows you
to pick the number of characters to be skipped while reading the Asset Tag Number field from
the Scanner file. For example, the bar code tag may read ABC-1234, yet the database uses only
1234 for the asset tag number. In such a case, you would skip the first 4 characters.
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Load New File Tab
The Load New File tab allows you to load the inventory scanner files. First, you select an
Inventory Cycle and Batch that were previously created. Then, you can enter a free text
description of the scanner file to be loaded. Finally, specify the full directory path and filename
of the scanner file location. This is easily accomplished with the aid of the Browse button.
When these parameters have been input, click the Load Inventory Data button.
A message “File uploaded, Database updated with Inventory details.” indicates successful
loading of the scanner file. This will appear on the Edit tab. The Scanner Details tab in now also
available.
Scanner Details Tab
The Scanner Details tab contains the details of each inventoried asset item. This tab is similar in
function to a Results tab in that you can select rows for delete, edit, and sort the data grid.
If you click on the edit button
on a particular row, the Scanner Details Edit screen will open
in a new window to show the details in the form view. From here individual data fields can be
edited. You can page from one record to the next utilizing the following buttons:
First, Previous, Next, and Last 
You can also click on the Scanner Details tab to go back to the data grid view. Once you have
completed your edits, use the Close Window button to close the Edit form.
Reconcile
The Reconcile function allows you to perform three main tasks:
• Preview or compare scanned inventory against assets in a batch
• Reconcile the scanned inventory with the asset database
• Add Assets (scanned inventory items) to the asset database.
Preview
The Preview function provides you with a visual report of the comparison of scanned inventory
items to the assets assigned to a particular batch.
Enter an Inventory Cycle, Batch and Scanner File. You can elect to have the Preview report
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display on your computer screen or export the report to a spreadsheet. Once the appropriate
values have been entered, click on the Preview button.
Scanned inventory items that match assets in the database within the criteria you specify in the
Net-FM Administration | Settings | Reconciler Options tab are indicated with the Result
heading "Asset Matched" and the data grid row is highlighted in the color green.
If a scanned inventory item is found in the asset database and not in agreement with the
criteria established within the Reconciler Options tab, the Result heading describes the problem
– for example "Different Facility" and the data grid row are highlighted in the color yellow.
If a scanned inventory item is not found in the asset database the Result heading is "Asset not
found in Asset Table!" and the data grid row is highlighted in the color red.
In the Preview window, you can click on the Edit button
to open a form view of the
scanner file detail. Changes to the scanner file records can be made from this window.
Note: The following enhancements are included in this release:
1. When editing a scanner file record using Reconcile | Preview | Edit, the Edit
dialog indicates which fields are required.
2. When editing a scanner file record using Reconcile | Preview | Edit, the Edit
dialog does NOT allow the user to update the record if an invalid Custom Code
value has been entered (The Asset lookup field is set in Admin Settings |
Reconciler Options).
The Preview can be done many times without changing the asset data in the asset database. It
is recommended that whenever you edit an inventory scanner file item you run a new Preview
to see how the changes have affected the comparison. You may want to make changes for
Preview items that appear in Yellow and Red. In time, with experience, you will better
understand how particular edits affect the Preview status of scanned items.
Reconciler - Add Assets
The Add Assets function provides you with the ability of directly adding scanned inventory
items to the asset database.
Enter an Inventory Cycle, Batch and Scanner File. You must also enter two more "required
fields" that are necessary whenever you add an asset to the database: Acquisition Date and
Useful Life. Since the true acquisition date and useful life of these items will be most likely
unknown to you at this time, a temporary field is used to enter data. If there are any additional
user-defined required fields, those fields (up to two) can be specified. [Note: You can then go
back later and make edits to the Acquisition Date, Useful Life, and any required fields and enter
the correct information.] Once the appropriate values have been entered, click on the Update
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Database with New Assets button.
The Update Database with New Assets button will also cause any fields specified in
Administration | Settings | Asset | Reconciler Options (as specified in items 1, 2, and 3) to be
used when adding the assets.
The screenshot below provides an example of how fields are mapped from the scanner to fields
in the database:

Scanned inventory items that match assets in the database within the criteria you specify in the
Net-FM Administration | Settings | Reconciler Options tab are reconciled with the asset
database.
As you can see from the screenshot below, you can require the scanner and database values for
any of the following six fields to match by setting “Ignore” to “No”. If “Ignore” is set to “Yes”,
discrepancies in the respective fields will not prevent Reconciliation.

If the Preview indicates that items are RED, they cannot be reconciled with the asset database.
You can add assets that have a status of RED(NEW) and RED(FOREIGN) to the asset database.
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Once these assets are added to the database, (their Preview status should change to GREEN)
they can be reconciled.
In this example, the asset tag number is not found in the asset database and other required
fields seem valid, the status is RED(NEW). This asset may be added to the asset database.

In this example, the asset tag number is not found in the asset database and other required
fields (Facility) are NOT valid, the status is RED(FACILITY). This asset may NOT be added to the
asset database.

Reconciler - Reconcile
The Reconcile function provides you with a visual report of the reconciliation of scanned
inventory items to the assets assigned to a particular batch.
Enter an Inventory Cycle, Batch and Scanner File. You can elect to have the Reconcile report
display on your computer screen or export the report to a spreadsheet. Once the appropriate
values have been entered, click on the Reconcile button*.
* IMPORTANT! Performing a Reconciliation changes data in the Asset database.
Only Reconcile when you are ready to do so. See “Reconciler Database Updates” for
more information.

Scanned inventory items that match assets in the database with the criteria you specify in the
Net-FM Administration | Settings | Reconciler Options tab are reconciled with the asset
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database.
If a scanned inventory item is found in the asset database and not in agreement with the
criteria established within the Reconciler Options tab, it is not reconciled.
Reconciler Reports
The Reconciler Reports function provides you with reports pertaining to specific inventory
scanner files that were used to reconcile with a particular Inventory Cycle and Batch. The report
types include:
•
•
•

Scanned Inventory Summary
Scanned Inventory Detail
Batch Summary

These reports will open a new window giving you an option to Open or Save the file. The
default file name is print.xls.

IMPORTANT! Make sure that your web browser does not block pop-up windows for
Net-FM. If a pop-up blocker is in place, try holding down the <Ctrl> key while
performing this operation.

Generate Scanner Init Files
The Scanner Init files are used to prepare your Symbol MC-55A0 inventory scanner with a list of
legal values to be used when performing the physical inventory. The values in these files will
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appear as drop-down choices in the inventory scanner. This will ensure fast and consistent data
entry.
The following text files can be prepared for the scanner:
• FacilityFloor.txt - list of all facilities and floors within those facilities from Facility and
Floor tables.
• Domain.txt - list of all Domains from Domain table, optional.
• Nomenclature.txt - list of all asset names from Nomenclature table.
• Manufacturer.txt - list of all manufacturers in the database.
• Condition.txt - list of all conditions from Condition table.
• CustomCode.txt - list of "custom" data from
The method to generate these files is to first click on the desired radio button for the List you
want. Then, click the Generate Text File button. This will create a hyperlink that you can rightmouse click to open or save.
Repeat the above procedure for all of the Lists. (If you do not use Domains, you will not need
that List. If you do not have CustomCode fields, you will not need that list.)
After saving the files on your computer, you will need to use ActiveSync or another method to
move the text files to the MC-55A0 inventory scanner.
IMPORTANT! Do not change the names of the text files. The INSITE Pocket-FM
Equipment Inventory program was written to look for these files by name.

Reconciler Help Resources
How to Prepare and Perform an Inventory and Reconciliation
Net-FM System Preparation
1. My Preferences | Scanner Model | SYMBOL MC50/MC55
This setting only needs to be applied once. It sets the format to read scanner files. This
setting is per-user and can be modified if more than one scanner type is in use.
2. Administration | Settings | Reconciler Reset | RESET
This will change the asset_inventoried_date in the database and affect asset_date1
through asset_date5. The RESET should only be performed if a complete (100%) asset
inventory is being performed. The RESET can be applied at any time before the
Reconcile is performed.
3. Administration | Settings | Reconciler Options | {multiple options}
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The Reconciler Options can be changed any time before the Reconcile Preview
operation is performed. These settings can be set once for an entire inventory cycle. The
settings can also be changed from one batch to the next if so desired.
Symbol MC55A0 Scanner Preparation
1. The scanner uses certain data from the INSITE database to capture the appropriate
information in a quick and consistent manner. That data, in the INSITE database, should
be reviewed for accuracy and consistency before beginning the physical inventory.
Check the following data items for accuracy and eliminate confusing or duplicate terms:
A. List of Facilities & Floors
B. List of Domains
C. List of Nomenclature
D. List of Manufacturers
E. List of Conditions
F. List of Custom Codes
2. Navigate to: Asset Reconciler | Generate Scanner Init Files | {multiple options}|
Generate Text File
This creates a series of text files that need to be loaded onto the Pocket-FM Equipment
Inventory Scanner, the Symbol MC55A0. After this procedure is initially performed, it
need only be repeated if there are changes or additions to the lists (see item 1 above).
3. Copy the "Scanner Init" files to the scanner:
•
•
•
•
•
•

FacilityFloor.txt
Domain.txt
Nomenclature.txt
Manufacturer.txt
Condition.txt
CustomCode.txt

These files must be located in the directory:
My Device / Application / INSITE, Inc. Pocket-FM Equipment Inventory / Init Files
Perform Physical Inventory
1. Using the Symbol MC55A0 with INSITE's Pocket-FM Equipment Inventory software,
perform the inventory.
a. Use appropriate scanner file names to help you identify what work was
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performed. This will be helpful when reconciling the scanner files against asset
batches that you will create.
b. Pre-determine how much work will be recorded within a particular scanner
session. Dozens, even hundreds of scanned items, is manageable - thousands
may not be so manageable. The appropriate work load will be determined by
your own experience.
2. When a scanner session is complete, or when the amount of assets you want to scan in
one scanner file is accomplished, stop the current session. A new file may be created
and the completed file, which is saved on the scanner, may be copied over to a personal
computer. (The assets that are captured in the scanner files are stored in memory on
the Symbol MC55A0. If the battery goes dead or is even removed from the scanner, you
will not lose the information in the files.)
3. Copy or move the completed scanner files to a personal computer that can access the
Net-FM system. This can be accomplished with Microsoft ActiveSync.
Net-FM Asset Reconciler
1. If not already performed, review the steps above in Net-FM System Preparation.
2. If not already done, create an Inventory Cycle and set the Status to "In Progress". Asset
Reconciler | Inventory Cycle | Add.
3. If not already done, create a Batch and create Batch Entries. Asset Reconciler | Batch |
Add. It is usually helpful to create a batch that will somewhat match the assets that are

expected for the area that was scanned. When assets are added to a batch, the following two
fields are updated if the current field values are null; Disposition Status is set to NFD - Not Found
and Disposition Date is set to the date the batch entries are made. (Note, all assets in the
database are checked for a match regardless of the batch.)

4. Load the data from the scanner files into the database. Asset Reconciler | Scanner File
Upload/Details | Load New File.
5. Preview (Compare Scanned Inventory against Assets). Asset Reconciler | Reconcile |
Preview. A Preview should always be performed first, before trying to perform a reconciliation.
A Preview can be performed as many times as you like without making changes to the database.
(A reconcile does change the database.)

6. From the results of the Preview, you may have to perform a few different operations
before the reconciliation.
If the Preview status is RED:
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You may have to edit some of the data in the data grid before it can be
reconciled. All NEW and FOREIGN assets need to be added to the database
before the reconciliation.  Asset Reconciler | Add Assets
If the Preview status is YELLOW:
The assets can be reconciled with the database, some of the data fields (facility,
floor, room, domain, condition) will be changed as indicated.
If the Preview status is GREEN:
The assets can be reconciled - there is a match.
7. Reconcile. Asset Reconciler | Reconcile | Reconcile.
The scanner file is reconciled with the database. The Update Status is set to Y - yes. The
Disposition Status is set to NULL only if it was previously set to NFD. The Disposition Date
is set to NULL.
Asset Database Cleanup
The asset database will require some clean up to make asset entries more complete in the
following cases:
1. If new assets are entered during the scanning process, the Useful Life is set to 999 and
the Acquisition Date is set to 11/11/1111. The appropriate values should be determined
and entered for those assets.
2. If the Nomenclature was set to "Unknown" during the scanned entry of new assets, the
appropriate asset name should be determined and entered for those assets.
Reconciler Database Updates
Performing a Reconciliation updates the asset database in the following manner:
• The Asset Table is updated with values from the scanner file.
• Update Status is set to “Y” (Yes).
• Asset Inventory Date is updated with the date from the scanner file.
• Asset Inventoried By is updated with name from the scanner file.
• Asset Disposition Status is set to null, only if the field was previously set to "NFD" (not
found).
• Asset Disposition Date is set to null, only if the Asset Disposition Status was previously
set to "NFD" (not found).
• Reconciler Status is set to “FOUND” if the asset was found, or set to “RED” if the asset
was not found.
Reconciler Glossary
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•

GREEN – matches all criteria, will reconcile. The inventory scanner file data and the
asset database match.

•

YELLOW – matches some criteria, all required fields are valid, some fields differ from asset
database - the data in the inventory scanner files will overwrite the data in the asset
database, if you reconcile.

•

RED – indicates invalid required fields, cannot reconcile. The invalid field may appear in
parentheses (i.e. RED(Facility) – this would indicate that the Facility is invalid).

•

RED(NEW) Status - asset tag number not found in database, the person doing the
inventory indicated in the scanner file that a new asset tag was applied to this asset, if
required fields are valid, can be added to database.

•

RED(FOREIGN) Status - asset tag number not found in database, if required fields are
valid, can be added to database.

•

FOUND - asset has been previously reconciled
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Asset Depreciation
About Depreciation
The Asset Depreciation module has three distinct features: Asset
Selection, Trial Run and Commit, and Details.
The Asset Selection feature provides you with a variety of methods
to select assets to include in the depreciation calculations. You can
differentiate by asset name, account number, asset condition, and domain. You can also select
all assets not yet included for depreciation. The available convention for depreciation is straight
line with options for full-month, half-year, and full-year.
The Details feature allows you to query and view specific depreciated assets in the database.
The details include information for many depreciation fields and additional information such as
last depreciation date and book value. The details may be printed out and saved to a file for
further analysis and use with other applications such as report writers.
The Trial Run feature allows you to input an effective depreciation date. This date can be in the
past, present or future. The trial run displays pertinent information for each asset including
depreciation method, status, start date, end date, current accumulated depreciation, total
accumulated depreciation, period-to-date depreciation and YTD depreciation. Once this
information is reviewed, you can decide if you want to commit the depreciation calculations to
the database.
The Depreciation Method table stores the script names available to perform different kinds of
depreciation.

Depreciation - Full-Month
Under a full-month convention, property placed in service at any time during a given month is
treated as if it had been placed in service on the first of that month. This allows you to take
depreciation for the entire month in which you place the asset in service. If you dispose of the
property before the end of the recovery period, no depreciation is allowed for the month in
which you dispose of the property.

Depreciation - Half-Year
Under the half-year convention, you treat an asset as though you placed it in service or
disposed of it on July 1 (or on the first day of the 7th month of a fiscal year). One-half of a full
year's depreciation is allowed for the asset in its first year placed in service, regardless of when
you actually placed it in service during that year.
In the last year of depreciation, depreciation is spread evenly from the month when the fiscal
year starts through and including the last month of the useful life.
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As an example,
• Depreciation Start Date = 8/1/2012
• Fiscal Year Ending 6/30
• Useful Life = 5 years
• Acquisition Cost = $5,000
1st year depreciation (6/30/2013, 1/2 year) = $5,000/(5 years / 1/2 year) = $500
2nd year depreciation (6/30/2014, full year) = $5,000/5 years = $1,000
3rd year depreciation (6/30/2015, full year) = $5,000/5 years = $1,000
4th year depreciation (6/30/2016, full year) = $5,000/5 years = $1,000
5th year depreciation (6/30/2017, full year) = $5,000/5 years = $1,000
Last year depreciation (8/1/2017, 1/2 year) = $5,000/(5 years / 1/2 year) = $500
Disposal:
If disposal occurs during the last year depreciation, the 1/2 year amount gets adjusted based on
how many months before the depreciation end date is the actual disposal date.
As an example, continuing from the example above,
•
•

Depreciation End Date 8/1/2017
Disposal Date 7/05/2017, 1 month before end date

The last year depreciation amount is for one-half year. In this example, from the start of the last
year (7/1/2017) to the end of the depreciation end date (8/1/2017) is only two months, July
and August. Still, the Last year depreciation (8/1/2017, 1/2 year) = $5,000 / (5 years / 1/2 year)
= $500. However, if the asset is disposed of in July, one month before the depreciation end
date, then only one of the two months or 1/2 of the depreciation is taken for the last year
depreciation, or $250.

Asset Depreciation Menu
Depreciation - Selection
The asset Depreciation | Selection feature provides you with a variety of methods to select
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assets to include in the depreciation calculations. You can differentiate by Asset name, Account
number, Asset condition, and Domain.
If you use these filters and then click the Get Selection button, the system will return a message
indicating how many entries it found that match the criteria you select and can be added to the
Depreciation table.

First, you must select one of the three available Depreciation Methods from the drop-down list
that will be applied to all the entries found. The available conventions for depreciation are
Straight Line with options for full-month, half-year, and full-year.
To continue and actually add the found items to the Depreciation table, click the Yes button.
Otherwise, click the No button to cancel the selection.
Upon completion, the following message will display:
• Currently there are n entries in the Depreciation Table.
Instead of using filters, you can also use a checkbox feature to select: All records not yet
included for Depreciation.
To view the entries in the Depreciation table, see Depreciation | Details.
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Note: Only Assets with Account Numbers are valid entries for the Depreciation
table. These Assets must contain an Account in Asset Accounting (which is
displayed as Acquisition Cost in the Asset Record). For an Asset to be included for
depreciation, the Asset Category field “Used for Depreciation” must contain a value
of “YES”. Otherwise, a NULL value or NO value will cause these Assets to be
excluded from depreciation.

Depreciation - Details
The Details feature allows you to Query and view specific depreciated assets in the database. If
you click the Get Results button without specifying any criteria or click the Show All button, the
result set will contain all items in the Depreciation table.
The Details screen / data grid includes information for many depreciation fields and additional
information such as Last Depreciation Date and Book Value. The details may be printed out and
saved to a file for further analysis and use with other applications such as report writers.
Once you have run a Query and Results are displayed, you can click on the Edit icon for a
particular data row to get the Edit tab view of the asset's Depreciation - Details. In the Edit Tab,
the Suspended field value can be toggled between Yes and No. If the Deactivate button is
present, click it to set the Suspended field to Yes. Or, if the Activate button is present, click it to
toggle the Suspended field to No.
The Suspended field allows you to discontinue or suspend the depreciation calculation for an
asset without removing that asset from the Depreciation Table.
The ability to over-ride certain values after Depreciation for any Asset Accounting record is
provided. You can edit the Depreciated record (Asset Depreciation | Details | Results | Edit)
and specifically over-ride values for: Accumulated Depreciation, Period-To-Date Depreciation
amount, Year-To-Date Depreciation amount, Last Depreciation Date, along with
Activate/Deactivate a record.
The Advanced Query tab can be used to refine your search of the asset accounts in the
Depreciation Table.
Notes:
•

If an Asset has multiple Account Numbers, each account should indicate the relative
portion of the asset's Acquisition Cost or account's Amount. Otherwise, the
Depreciation calculation may not be as expected.

•

If the Acquisition Cost of an existing Asset already in depreciation is changed, the
existing accumulated depreciation remains. The depreciation expense going forward is
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adjusted.
•

If an asset is entered for a prior period the accumulated depreciation will automatically
be calculated.

•

Depreciation can be projected two years into the future, from the current year.

Depreciation - Trial Run/Commit
The Trial Run feature allows you to input an Effective Depreciation Date. This date can be in
the past, present or future. If you only enter an Effective Depreciation Date and then click the
Start Depreciation Trial Run button, all of the entries in the Depreciation Table will be included
in the trial run.
The trial run is initiated by clicking on the

button.

If you also select a Depreciation Method and/or a Domain before clicking the Start Depreciation
Trial Run button, those values will be used as filters on the entries in the Depreciation Table.
Once the trial run has been calculated, you will notice that the information (on the left-side of
the window) regarding the trial run will be updated. You can view the results by clicking on the
View Trial Run tab.
The View Trial Run Tab displays pertinent information for each asset including depreciation
method, status, start date, end date, current accumulated depreciation, total accumulated
depreciation, Period-To-Date depreciation and Year-To-Date depreciation. You can use the
Print/Export button to view or export the data to a spreadsheet. This may also be helpful for
running projections into the future.
If you decide to commit the depreciation calculations to the database, click on the Commit tab.
The Commit tab provides information about the trial run.
The tab's
button is used to commit the trial run data to the
database. Clicking this button will open a dialog box, asking you to confirm that you want to
commit the trial run.
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If you click OK, the Trial Run is committed to the database and you'll see a message: “Successful
Commit. Use Depreciation Details to check results.”
You will also note the View Trial Run tab is now empty.
You can perform as many Trial Runs as desired without changing the depreciation data in the
database. The data is updated only after you Commit Data From Trial Run.
If depreciation has been run for a specified date and committed, any trial runs for a date less
than (before) or equal to that specified date will skip all records that have already been
depreciated.
Note: The Acquisition Date establishes the Depreciation Start Date. The Useful Life
is then used to calculate the Depreciation End Date.
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Indirect Cost Recovery
About Indirect Cost Recovery
The Indirect Cost Recovery (ICR) module, which deals with Facilities & Administrative (F&A)
costs, is used to assign the activities that occur in space and prorate or apportion costs to those
functions. ICR can track the recoverable costs incurred in the performance of research, the
amounts reimbursable from third parties in medical facilities, and the costs attributable to
occupying organizations in space for purposes of budgetary charge backs.
The ICR data is fully integrated into the Space Management database. The ICR module is
designed to prohibit users from performing certain operations: insert, update, delete of space,
facility, organization, use, or occupancy information. Users may only maintain the ICR specific
tables and assign functions to existing spaces and organizations.

Indirect Cost Recovery Menu
About Indirect Cost Recovery Menu
The Indirect Cost Recovery (ICR) Menu or navigation tree is
divided into several parts:
Functions - ICR allows the assignment of multiple functions to a space in user-defined
categories (major function and function). More than one function can be assigned to a space; a
percentage is associated with each assignment.
Costs - ICR allows the assignment of costs in user-defined categories (cost type) to facilities, as a
whole, or to individual spaces. All costs are dated allowing them to be chronologically tracked
for an unlimited span of time.

Functions
Major Function
Major Functions categorize and summarize the functions directly assigned to them. Major
Functions provide a way to distinguish between a group of functions to be used for regulatory
responses and those that serve other purposes. You must create Major Functions before
creating Functions.
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Function
Functions, or activities that occur in a space, are assigned to organizations occupying the space.
Examples of functions include, but are not limited to: Departmental Instruction, Departmental
Research, Departmental Administration, Federally Sponsored Research, Non-federally
Sponsored Research, etc.
If a space has only one organization assigned, the functions prorate the area of the space to
that single organization. If a space has multiple organizations, each assigned to the space for a
certain percentage, separate function assignments are made for each organization in the same
space. This last statement may seem slightly confusing, so let’s take a simple example. Let’s
assume that Room 101 (a wet lab) has two occupying organizations: Biology (50%) and
Chemistry (50%). The ONLY function for room 101 is “Sponsored Federal Research”. In order to
create function assignments for this space, you must go to the Function Assignment Add tab,
specify the Facility/Floor/Room/Organization combination, and indicate 100% next to “RSH-FDSPONS RSCH – FED”. This assignment must be done separately for each Organization.
Function Assignment
The Function Assignment feature is used to assign functions and percentages to space.
Function Assignment information is available on the Results tab in data grid format. Clicking on
the Edit button for a particular row in the data grid will display the data on an Edit tab in form
view. This is where function assignments are made.
All available function names are listed on the Edit tab and are followed by a “Pct:” field. In order
to edit the function assignment, simply specify the appropriate percentages next to the
respective functions. Zero values need not be entered. The summation total of all other percent
values entered must add up to 100 percent.
The Function Assignment and Organization Assignment tables track the assignment of Spaces to
one or more Organizations that occupy the space. This important, common table relates
spaces, organizations, people, occupancy and functions (ICR) through a common element:
organization assignment.
The Organization Assignment table is a key table commonly used in Net-FM. It tracks the
assignment of a valid organization to Space, Person, Occupancy, and Function records.
To quickly add new function assignments to new spaces, first add one function assignment and
click the Add Record button. Then, use the Duplicate Record button and change the necessary
fields before clicking the Add Record button. You may also consider using the “Replace
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Column” feature from the data grid.
Time-saving Tip: If you have multiple function assignments for a space and they all fall under
the same Organization, simply specify the appropriate percentages next to each function.
In Function Assignment floor plans, the highlighting of rooms in floor plans is done using the
Percentage field in each record.
IMPORTANT! Changes to a Space that affect the Organization may also affect the
Occupancy and Function Assignments.

Productivity Tip:
If you want to assign Functions Assignments to spaces without any current function
assignments, perform an Advanced Query where Function is Null. You can then work your way
down the Results data grid by editing the rows one at a time and add the Function Percent.
Then, click back on the Results tab to continue with the next row in the data grid.
If you want to assign a Function (Function Percent will be 100%) to a large number of spaces at
once, perform the Query necessary to get the appropriate Results data grid. Then, from the
Results tab, click on the appropriate check boxes to select the spaces of interest. Next, click on
the Replace Column button. In the replace dialog window, select the Column Name: "Function:"
and then select the New Value: and click on the Replace button.
If you want to assign a Function (Function Percent will be 100%) to a large number of spaces
that have the same Use assignment at once, perform the Query on Use to get the appropriate
Results data grid. Then, from the Results tab, click on the appropriate check boxes to select the
spaces of interest. Next, click on the Replace Column button. In the replace dialog window,
select the Column Name: "Function:" and then select the New Value: and click on the Replace
button.

Costs
Cost Type
The Cost Type table stores the types of costs available to any Cost field in Net-FM. One value in
this table can be entered into the Cost field of each Facility record or each Space record.
Facility Cost
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The Facility Cost table tracks history and information about user-defined costs that apply to the
facility as a whole. This table is related through the Space Management | Common | Cost
Type table to costs that can also be applied to individual spaces. Costs can be grouped into
categories for reporting and analysis purposes. The Facility Cost Code table defines the
facility_cost_code lookups for the facility cost table. The costs can be categorized in the related
Cost Type table.
Space Cost
The Space Cost table tracks history and information about user-defined costs that apply to
individual spaces. This table is related through the Space Management | Common | Cost Type
table to costs that can also be applied to facilities. Costs can be grouped into categories for
reporting and analysis purposes.

Administration Settings: In Relation to ICR
Administration Settings – Space Cost Amount
Cost Type table has a Number field to allow an initial default Space Cost Amount to be assigned
when the associated cost type is added as a new record. A new system setting, Administration
| Settings | Space | Space Cost Amount is available with the following options:
• Do not use value from Cost Type
• Populate from Cost Type but no automatic update
• Populate and always Update from Cost Type
This setting makes it possible for Space Cost Amount to be populated with the Number field
from the Cost Type table and also to automatically capture any updates to this field in Cost
Type.
The Space Cost Code table defines the lookup in the Space Cost table.
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Grant Tracking
About Grant Tracking
The Net-FM Grant Tracking Module allows you to track Grants or
Projects. For those Institutions that track Grants, this is a useful tool to
associate Grant information to an unlimited number of spaces and
accounts.
For some institutions that track Projects, the words "grant" and "project" are used
interchangeably. This may or may not be the case at your institution, so please check with the
appropriate authority. This is a useful tool for tracking Projects to an unlimited number of
spaces and accounts.

Grant Tracking Menu
Grant
The Grant Tracking | Grant module is used to track information about grants and projects. The
required fields include: Name, Number, and Status. Additional fields include: Grant Source,
Requested Amount, Funded Amount, Proposal Due Date, Start Date, End Date, Renewal Start
Date, Renewal End Date, Report Due Date, Principal Investigator, and Organization.
There are also five-year amount fields, ten text fields, five number fields, five code fields, a
memo field, five YesNo fields, and five date fields. The fields Year1 Amount through Year5
Amount are used to calculate the total for the field Funded Amount. If the Year1 Amount fields
are not used, a value can be entered directly into the Funded Amount field.
If you Edit a record on the Results tab or if you Add a new Grant (Project), you will see the
following tabs: Edit, Space, Account, and Documents.

The Space tab allows you to associate a Grant (Project) with an unlimited number of spaces.
The Account tab allows you to associate a Grant (Project) with an unlimited number of
accounts.
The Documents tab allows you to associate a Grant (Project) with an unlimited number of
documents.
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The Grant (Project) table stores associated data records.
Note: The Funded Amount field will calculate and display the total from the Year 1 Amount
through the Year 5 Amount fields. The Funded Amount field can also be directly input,
overriding the calculation.
Grant Features
Space Grant
The Space Grant feature allows you to associate an unlimited number of facilities, floors, and
rooms to a Grant Name.
If one or more spaces were previously associated with a Grant / Project, the Space Grant
(Results) tab will display a data grid containing the Facility, Floor, Room, and Grant name;
otherwise the window will display an empty data grid.
Each row of the data grid begins with a checkbox. If you click the checkbox, the Delete Selected
Records button will become active. Clicking on the Delete Selected Records button will perform
that operation.
The Export to Excel button is also available at the bottom of the window (provided that the
Net-FM Administrator has made it available).
To assign a grant to space, use the Add tab. At the top of the window, you will notice dropdown list boxes for Facility, Floor, Room, and Grant Name. The Facility drop-down will contain a
list of all the facilities that you have input into the Net-FM system. Once you select a Facility,
the Floor drop-down list will populate (this is a dependent drop-down list) with the appropriate
floors only for the Facility that was just selected. Once the Floor is selected, in a similar fashion,
the Room drop-down list will populate and you select a Room.
Grant Documents
The Grant Documents tab allows you to associate an unlimited number of documents to a
Grant. The tab allows you to:
•
•

specify documents to be uploaded to your Net-FM system's web server
view documents that are on your Net-FM system's web server

Any available Documents will appear by list in the left-side window pane. You can click on the
link to view the document. From the Documents tab you can click on the check box in front of
the respective file names and then click on the Delete File(s) button to delete the files from the
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web server.
To upload files to the server, either enter a complete path and filename into the File Name box
and click on the Upload File button, or click on the Browse button – this will open a Windows
Choose File dialog box from which you select a file for upload.
The Admin - User feature is used to assign privileges for document viewing and uploading.
Status
Status allows you to create any number of status descriptions that can be applied to any
Grant/Project. For example, Approved, Declined, In Review, etc. To see a list of all available
Statuses, simply click on the Get Results button on the Query tab. To add a Status, click on the
Add tab; enter a name in the Status field, and a description in the Status Memo field (optional).
Then, click the Add Record button.

Administration Settings: Grants
Administration Settings – Grant Options
There are two settings governing Grants within the Net-FM Administration Module. The
location for these settings is as follows: Administration | Settings | Other | Grant Options.
The first setting, Filter Grants for Assigning to Space, has two options:
•

NO FILTER – NO RELATION TO GRANT ORG AND SPACE ORG

•

FILTER – GRANT ORG MUST MATCH SPACE ORG

With NO FILTER selected, the Grant dropdown will have all available Grants for assignment. With
FILTER selected, the Grant dropdown will be limited to only those Grants wherein the Grant Org
is the same as the Org already assigned to the Space.
The next setting, Grant Account Option, has two options:
•

USE COLUMNS IN ASSET ACCOUNT

•

USE GRANT TRACKING MODULE

Essentially, this setting controls whether you utilize Grant features and capabilities through the
Asset Account screens (USE COLUMNS IN ASSET ACCOUNT) or if you use the Grant Tracking
Module to manage information concerning Grants (USE GRANT TRACKING MODULE).
If the Admin Settings for Grant Options is set to Use grant tracking module, in the Asset
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Module, Account - Account feature, the Grant Name field is available. The Grant Number, Fund
Source, and Funding Type fields are grayed-out and unavailable. Refer to the screenshot below:

If the Admin Settings for Grant Options is set to Use columns in asset account, in the Asset
Module, Account - Account feature, the Grant Number, Fund Source, and Funding Type fields
are available. The Grant Name field is grayed-out and unavailable. Refer to the screenshot
below:
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Documents
Overview
Net-FM includes a documentation management system that integrates with a number of
modules. Utilizing the file storage system on the server, Net-FM makes it possible to upload
documents and associate them with records in the database. The flexibility with which this is
accomplished lends itself to a number of practical uses and implementations. Uploaded
documents may be accessed from any of the following locations:
• Via the document link/icon in the Data Grid
• The Documents tab (which becomes available when you select a record for edit)
• One of the various Document Navigators
Before we take a detailed look at how documents are managed/accessed, it is beneficial to first
have a discussion about practical usage. For the purpose of our discussion, a document may be
many things: a picture/image, a PDF document, a spreadsheet, a Word document, a text file,
etc. As you become more familiar with the specific areas in Net-FM where document
functionality is available, thoughts about various usage scenarios will follow.
Example 1: Let’s assume that we wanted to have an aerial photo of each Facility available in
Net-FM. The Documents module provides a solution that is both simple and easy to
implement. If we use the Facility module and edit each Facility, we are then able to click on the
Documents tab and add the respective images for each facility. Once this task has been
completed, we can then easily access the image from the Facility List Results Grid as well as the
Space Document Navigator.
Example 2: In an effort to promote Fire & Safety Standards, your Facilities & Space Planning
department may have determined that along with each Floor in the database there should be a
corresponding Emergency Exit/Evacuation document or map. Utilizing the Document Feature
in Net-FM, this task is easily accomplished. Simply run a Query on the Floor List and edit each
Floor. When you click on the Edit icon, the Documents tab will become available – allowing you
to upload the respective map or file.
Example 3: The folks in charge of maintaining your institution’s Asset inventory may decide
that it makes sense to have service contracts linked to the respective records in Net-FM. The
Document Module provides an easy solution to accomplish this task. Simply utilize the Query
or Advanced Query in Asset Management | Asset, click the Edit icon for the respective Asset,
and use the Document tab to upload/manage the associated documents.
Net-FM Modules integrated with Documents:
The red outline indicates which Net-FM modules are integrated with the Documents feature.
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The Documents Tab

With the exception of Move Management (which is detailed in a separate user guide), the
Documents tab for the respective Net-FM module is where ALL of the document management
takes place. The Documents tab becomes accessible when you click on the Edit icon in the
Results Grid for the Net-FM modules referenced in the previous section. The Documents tab
allows you to:
• Select and upload files to the Net-FM Application Server
• View documents that are already on the server and associated with records
• Delete files/documents that are no longer needed
Page
246

Refer to the diagram below which illustrates the Documents tab from the Space List module:

As you can see from the Documents tab featured above, there are a number of links, buttons,
and controls on this page.
Documents List – the Documents List appears on the top left. As you upload files for a
particular module (in this case the Space List), the documents will display in this area. The
checkboxes are used in conjunction with the delete button, but more on that in a minute.
Choose File button – this will open a Windows File Explorer to enable you to select a file for
upload.
Upload File button – this will complete the upload of the chosen file.
Delete File(s) button – Using the checkboxes in the Document List (“Select All” or the individual
boxes associated with each record, you may mark the respective checkbox and click the “Delete
File(s)” button to remove the files from the Application Server if they are no longer needed.
Document Links for related modules – In this case we see two links on the top right: one for
Facility Documents and the other for Floor Documents. On various Documents tabs, you may
see links to documents that are in associated modules.
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Accessing Documents from Query Results

Now that we have taken a look at the Documents tab, let’s run through several ways you may
access documents from your Query Results.
In this case we will run a Space Query where Facility = “OFMS” AND Floor = “1”

Scenario 1:
On the Results Grid, we will select the Document icon, which opens the “Documents” modal
dialog. We will then click on the hyperlink “OFMS-FL_1-ROOM_01.JPG”.

The document (in this case a .jpg image file) will open in a separate tab.
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Scenario 2:
On the Results Grid, we will select the Edit icon, which opens the Edit record screen.
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On the Edit record screen, we will click the Documents tab.

From the Documents tab, if we were to click the link “OFMS-Fl_1-ROOM_01.JPG” on the top
left, the document/image would open in a separate tab just as in Scenario 1. For this
exercise, however, we will perform a slightly different action.
We will click on “OFMS.JPG” to open a document associated with the Facility (also an image
in this case).

As you can see, the document displays within the Documents tab screen.
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Alternatively, if we were to click on the link “OFMS_1.PDF” under Floor Documents (top
right), we would open the associated Floor document.
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The Document Navigators
In the previous section we discussed several ways in which you can
access documents that have been uploaded to the server. In this
section we will discuss the Documents Navigators that provide for
hierarchical access to documents.
Each Document Navigator arranges and displays Space, Asset, and
Grant documents in a hierarchical view. There are seven Document
Navigators in total:
•

Space Doc Navigator

•

Asset Doc Navigator

•

Accounting Doc Navigator

•

Grant Doc Navigator

•

Space General 1 Doc Navigator

•

Space General 2 Doc Navigator

•

Space Features Doc Navigator

We will cover the details of each by taking a closer look at the Space Doc Navigator and then
the Asset Doc Navigator.
The Space Doc Navigator
The Space Document Navigator is a tool that visually represents Space and related documents
in a hierarchical structure according to Region, Site, Facility, Floor, and Room.
If any documents have been uploaded to a particular region, site, facility, floor, or room, each
item is identified with a black-colored down arrow to indicate that documents are associated
with that item below the indicated level. Click on the small + sign to expand the navigator tree.
A small blue-colored right arrow indicates that documents exist at that level.
In the example above, the NORTH EAST Region has documents beneath it in the hierarchy
(black arrow). The MASSACHUSETTS Site has documents beneath it in the hierarchy. The
BUILDING 40 Facility has documents at its level (blue arrow) as well as beneath in the hierarchy
(black arrow). The 1 Floor does not contain any documents (no blue arrow), but it does have
documents lower in the hierarchy (at the room level). Space 00E1 has a document (blue arrow)
at its level.
Clicking on the blue right arrow hyperlink will display a list of associated documents.
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The existence of documents at a region, site, facility, floor, or space is indicated with a bluecolored right arrow. You can click on the link to display a list of available documents. Clicking on
the document name / hyperlink will open the respective document.
Documents may be uploaded to the web server from within the Space Management module for
the following:
• Space - Region (Documents)
• Space - Site (Documents)
• Space - Facility (Documents)
• Space - Floor (Documents)
• Space - Space (Documents)
• Space – Space Feature (Documents)
• Space – Space General (Documents)
• Space – Space General 2 (Documents)
• Space - Space Sign(Documents)
Privileges and Module Visibility for user accounts under the Administration module may be
used to control access to Documents.

Asset Document Navigator
The Asset Document Navigator is a list of assets for which one or more documents have been
uploaded to the Net-FM web server.

You can click on the blue right arrow hyperlink to display a list of associated documents.
Clicking on the document name / hyperlink will open the respective document.
Documents may be uploaded to the web server from within the Asset Management module
on the Documents tab.
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Reports
About Reports
A host of Standard Reports are supplied with Net-FM, and new ones are
being added with each release. There are two libraries 6 of OFMS-supplied
Standard Reports:
•
•

Space Management
Asset Management

From the Net-FM navigator, it is a simple process to choose a report, set the scope, and
produce the results in a browser window.
There are 3 ways to access the Reports module:
1. Drill down to the appropriate Report using the Navigation Tree on the left.
2. Click on the “Reports” link in the Main Net-FM Navigation Bar, and select the
appropriate report.
3. Access a report listed under “My Quick Links”.
Follow these steps to produce a report:
1. Click on the report you wish to produce.

2. A new window opens where you can determine the scope of the report, generate it, and
display the results. You can select multiple values from the value list (if it makes sense to
do so). Multiple filter selections from the same list can be made by holding the Ctrl key
In addition to Space and Asset reports, there are several reports available from Space Survey Management and
Move Management.

6
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while selecting your choices. You can also select multiple columns, again, only if this
makes logical sense.
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3. The Report is displayed in a new browser window. Use your browser controls and
commands to view and print.

At first glance it may appear that Reports produced in Net-FM have some limitations:
•
•
•

There is no pagination – the entire report is displayed on one “virtual” page
Thus, there are no footers or page numbers
The report header is not repeated, nor can it be “frozen” at the top of the screen
while scrolling through the report body of data

In a few easy steps, using tools that are freely available, we can further enhance these reports
for printing or distribution. Please refer to the next section for a detailed example.
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Enhancing Standard Reports
Reports can be produced in a more powerful and comprehensive third-party Report Writer
program. OFMS provides the library of INSITE Standard Reports in Crystal Reports format and
they are fully and freely distributed to Consortium Members. Each organization can fully
customize the Standard Reports as well as create new ones for specific issues.
That being said, you may have a need to take a Standard Report and simply spruce it up a bit.
You may wish to insert your logo, create headers and page numbers for each printed page, or
you simply may wish to add color / enhance the format. All of this is possible, and we will take
a look by using a simple example. In our example, we will use Google Sheets. If you are more
familiar with other programs such as Microsoft Word, Microsoft Excel, Adobe Acrobat, etc.,
then by all means feel free to try some of these techniques using your program of choice.

Google Sheets – Importing & Formatting an INSITE Standard Report
In the following example, we have already specified the desired criteria and produced the
INSITE Standard Report: Facility Area Summary. Our example assumes that we are using a
Windows PC, however the tasks that follow may also be completed on other operating systems
and/or devices.
1. After selecting all of the report contents by using the selection tool or <Ctrl> + A, you
may right click and choose Copy (or <Ctrl> + C) to copy the contents to the clipboard
(see below):

2. Launch Google Sheets and start a new spreadsheet by selecting “Blank”.
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3. Once the blank spreadsheet opens either use <Ctrl> + V or select Paste from the Edit
dropdown.

4. The spreadsheet will look like this:
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5. Now that we have successfully copied our report contents into Google Sheets, it is now
time to perform some basic formatting. We will begin by freezing the first two rows:
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6. The next step will be to select the report area on the spreadsheet so that we may
perform additional formatting. Begin by holding down the <Shift> key and selecting the
headings in each column:

7. Scroll down to the last row of the spreadsheet. While holding down the <Shift> key,
click the cell right-most cell in the last row that contains data. You may want to scroll
through the sheet to make sure all data was selected.
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8. On the Format dropdown, we will select Alternating colors…

9. An option panel will open on the right side of the screen. For our purposes, we will
choose the Formatting Style that has a sky blue header and click the Done button.
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10. At this point we are almost ready to print. From the File dropdown, select Print.

Page
262

11. Before we print, there are several options to consider. Consider the following: page
orientation, scale, headers & footers, and row & column headers.
a. Page orientation – we have selected Landscape
b. Scale – is currently set to Fit to width so that the content will fit to the width of
our paper size selection
c. Headers & footers – select the desired options (i.e. page numbers, current date,
etc.)
d. Row & column headers – select Repeat frozen rows to ensure that the header is
repeated on each printed page.
12. When you are satisfied with your selections, click the Next button to bring you to the
Print options page.
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13. In the Destination section, your default printer should appear. If you wish to print to
PDF, simply click the Change button and select your desired installed PDF program.
Review any other pertinent settings and click the Print button when you are ready to
print.

Asset Reports
Asset Reports
The following Asset Reports (with column attributes) are available:
Assets By Class Name
Asset_class_name

Site_name

Asset Count By Fac and Floor
Facility_name
Asset Summary By Organization
Asset_acquisition_cost

Asset_name
Page
264

Organization_name

Site_name

Facility Asset Inventory
Asset_tag_number
Asset_acc_depreciation
Asset_useful_life
Site_name

Asset_name
Asset_net_book_value
Floor
Facility

Asset_acquisition_date
Asset_condition
Asset_class_name

Facility Asset Reinventory
Facility_name

Site_name

Total Asset Cost By Org
Organization_name

Site_name

Note: The Report may take a long time to generate if your selection criteria result in
a very large set of records (more than 100,000 records for example).

Space Reports
Space Reports
The following Space Reports (with column attributes) are available:
All Space Summary
Site

Site_name

Facility Allocation Summary
Active Facility
Facility_type

Facility
Site

Facility_name
Site_name

Facility

Facility_name

Facility Area Summary
Active Facility
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Facility_type

Site

Site_name

Active_floor
Facility_type
Organization_number

Facility
Organization
Site

Facility Occupants Summary
Active_facility
Facility_name
Organization_name
Site_name
Facility Room List
Active_facility
Facility
Floor
Organization_number
Use

Active_floor
Facility_name
Organization
Site
Use_name

Area
Facility_type
Organization_name
Site_name
Use_code

Facility
Organization
Site_name

Facility_name
Organization_name

Facility
Major_use
Site
Use_name

Facility_name
Major_use_name
Site_name
Use_code

Facility
Floor

Facility_name
Site

Facility User Summary
Active_facility
Facility_type
Site
Facility Use Summary
Active_facility
Facility_type
Major_use_code
Use
Floor Area Summary
Active_facility
Facility_type
Site_name
Major Room Use By Major User
Major_use
Site
Major User Assign Summary
Assignability_name
Major_user_number

Major_use_code
Site_name

Major_use_name

Major_user
Site

Major_user_name
Site_name
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Major User Facility Summary
Active_facility
Facility_name
Major_user_number

Facility
Major_user
Site

Facility_type
Major_user_name
Site_name

Major_user_name
Organization_name
Site_name

Major_user_number
Organization_number

Major User Org Summary
Major_user
Organization
Site
Major User Room Use Summary
Major_user
Site

Major_user_name
Site_name

Major_user_number

Major_use_code
Site_name

Major_use_name

Alt_organization_name
Facility_name

Alt_organization_number
Floor

Assign / Avg Areas By MUses
Major_use
Site
Occupancy Extension By Facility
Alt_organization
Facility
Occupants By Facility
Active_facility
Facility_type
Organization

Active_floor
Floor

Facility
Occupant_name

Organization Hierarchy
Assignability
Organization_name

Code
Organization_number

Organization
Organization_text2

Organization Room List
Active_facility
Facility_name
Organization_name
Site_name

Active_floor
Facility_type
Organization_number
Use
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Facility
Organization
Site
Use_name

Use_code
Organization Summary
Active_facility
Facility_name
Organization_number
Site_name

Facility
Organization
Organization_text2

Facility_type
Organization_name
Site

Org & Desc Space Summary
Parent_organization

Parent_organization_name

Parent_organization_number

Principal Investigators By Facility
Active_facility (Y/N)
Facility_type
Include_core_spaces
Organization_number

Active_floor (Y/N)
Facility_name
Organization
PI_name

Facility
Floor
Organization_name

Facility
Major_use_name
Site
Use_code

Facility_name
Major_use
Site_name
Use_name

Assignability_name
Major_use_code
Site_name

Code
Major_use_name
Use

Room Uses By Facility
Active_facility
Facility_type
Major_use_code
Use
Room Use Hierarchy
Assignability
Major_use
Site
Use_name
Site Facility Summary
Site

Site_name

Note: The Report may take a long time to generate if your selection criteria result in
a very large set of records (more than 100,000 records for example).
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Administration Settings: In Relation to Reports
Administration Settings and Reports
The Net-FM Administration module affords privileged users the opportunity to control the
appearance of reports, as well as each user’s access to reports as a whole or individually. Such
options and controls ensure the right information is accessible by the appropriate parties, and
that the respective information can be tailored to meet your organization’s needs.
Report Header
The two lines in the leftmost position of the report header can be customized through Net-FM’s
Administration Client.
•

The global report headings can be changed in Administration | Settings | Other |
Report Headings.

•

The Major User Level, for Organization Hierarchy, can be changed in Administration |
Settings | Space | Organization Hierarchy.

Report Visibility
The Net-FM Administrator has the ability to control each user’s access to the Reports Module
as well as which reports may be viewed by the respective user. These tasks are achieved via the
Module Visibility tab associated with each User record.
Controlling access to the Reports Module as a whole:

Page
269

Controlling a User’s access to individual reports:
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How-to Videos

The following link opens the INSITE video webpage which contains helpful howto videos: http://www.insite.org/insite-videos/
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